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Software Licence Agreement
QUICKEN PAYROLL PREMIER Version 12, Release 1, 2003

LICENCE     
PLEASE READ THIS LICENCE CAREFULLY.  
By using the Quicken® software product identified above (the "Software") you agree to be bound by the terms 
of this Licence. (Where the context permits, "Software" will also include the user guide and related materials.)  

1 Licence
Reckon Limited (ACN 003 348 730) (the "Licensor") grants to you a non-exclusive, non-transferable, limited 
Licence to use the Software in accordance with the terms of this Licence. The Software is licensed not sold, 
despite any reference to "purchase" or "sale" in this Licence or in any invoice or purchase order for the supply of 
the Software The Licensor reserves all rights not expressly granted to you. The Licensor is the owner of copyright 
in the Software and retains ownership of the copyright and all other intellectual property rights in the Software 
and is protected by copyright law and international copyright treaty. Intuit Inc. is the owner of all intellectual 
property rights in the name "Quicken" and all relevant trademarks. The Licensor reserves all rights not expressly 
granted to you and retains ownership of the copyright and all other intellectual property rights in the Software.

2 Use
(a) The Software may be loaded on one computer only and used by one person only at any one time. If more 

than one person is to use the Software at the same time or the Software is to be loaded on more than one 
computer you must obtain an additional licence.

(b) You must not:

(1) use or rely upon the Software for any purpose or in any manner for which the Software is not 
warranted;

(2) copy, reproduce, translate, adapt, vary, merge or modify or create any derivative work based on the 
Software;

(3) reverse engineer, decompile, disassemble, reconfigure or otherwise attempt to discover the source 
code of the Software; 

(4) sell, market, network, transfer, lease, license, sub-license, rent, lend or otherwise dispose of or 
distribute the Software.

(c) You must register this Software in order to keep using it. You agree to register the Software within a 
reasonable time or within such time as the Software prompts you to do so.  

(d) In particular but without limiting the generality of clause 2, other than one version downloaded for use, you 
may not make any copies of the tax tables provided with the Software nor may you sell, market, network, 
transfer, lease, license, sub-license, rent, lend or otherwise dispose of or distribute the tax tables.

3 Maintenance of Software
(a) The Licensor will maintain the Software, during the period from the date of purchase until the earlier of

(1) the second anniversary of the date of initial supply by the Licensor of release one of this version of the 
Software; and

(2) the date of initial supply by the Licensor of the second successive version of the Software. 
After this date, the software may be "sunsetted". For a further explanation of the sunset policy please go 

to http://www.quicken.com.au.

(b) The Licensor is not required to enhance, upgrade, maintain, provide technical support or provide a re-
registration code after the initial registration free of charge. For the current list of products that can be 
registered and the applicable re-registration fee go to http://www.quicken.com.au.



4 Warranty
(a) Subject to clause 5(a), the Software is provided "as is" and without any representations by the Licensor or 

any of its authorised distributors regarding the use, performance or results of the use, of the Software.

(b) The Licensor warrants that the media on which the Software is recorded is free from defects in manufacture 
for a period of 90 days from the date of delivery. During this period the Licensor will replace any defective 
media on which the Software was supplied and any Software on that media, free of charge.

(c) While the Licensor has endeavoured to make sure that the Software works, the Licensor does not guarantee 
that the Software will work on all computer hardware platforms or configurations and makes no warranty 
that the Software will be error free or that use will be uninterrupted.

5 Liability
(a) To the full extent permitted by law, all implied conditions, warranties and rights are excluded. Where 

conditions, warranties or other rights for your benefit are implied in this Licence or otherwise conferred by 
the Trade Practices Act 1974 (Cth) and it is not lawful to exclude, restrict or modify them, then those 
conditions, warranties and other rights will (but only to the extent required by law) apply to this Licence.

(b) The Licensor's and its authorised distributors' liability for breach of implied conditions or warranties is 
limited, to the extent permitted by law and at the option of the Licensor, to replacing or supplying the goods 
or services or their equivalent again or the payment of the cost of having the goods or services or their 
equivalent replaced or supplied again. 

(c) To the full extent permitted by law:

(1) the Licensor and its authorised distributors will not be liable to you or any other person for any direct 
or indirect loss, damages, liability, costs or expenses suffered by you or any other person relating to 
the performance or non-performance of the Software or any breach of this Licence or the supply of 
the Software or use thereof or in connection with, but not limited to, the Online Services, use of tax 
tables or provision of technical support (whether by telephone or remote access or other means);

(2) The Licensor's maximum liability for damages arising in connection with this Licence or the supply of 
the Software is limited to the amount paid by you for the Software.

(d) You agree that the Licensor and its authorised distributors will not be liable, other than as expressly set out 
in this Licence, and that you will indemnify the Licensor and its authorised distributors in respect of any 
liability, loss, damage, costs or expenses which you may suffer or incur as a result of your use of the Software 
(including any claims made against you by third parties).

(e)  You agree it is your obligation to ensure that deductions and rates used for deductions for superannuation, 
taxation (of any nature) and any other deductions/contributions calculated using the software are correct 
from time to time and at the applicable time and that nothing in the software constitutes professional 
advice in relation to these matters. The help contained in this Software is not a substitute for professional 
advice. Legal and accounting advice should be obtained before taking any action in reliance on this 
Software. In addition the tax tables that may be supplied with this Software are changed from time to time 
by the relevant tax office and you should consult with your professional adviser before relying on the tax 
tables. The Licensor does not warrant that the tax tables are up to date at your date of purchase. Updated 
tax tables may be obtained from the licensor at the price set out in the price list at 
http://www.quicken.com.au.  In providing you with the tax tables, the Licensor is not engaged in rendering 
legal, accounting or other professional services. 

(f) To the full extent permitted by law, the Licensor, its employees, agents, contractors and the authors disclaim 
any and all liability and responsibility to any person, whether a user of this Software or not, in respect of 
anything (including, without limitation, any error in or omission from this Software) and of the 
consequences of any actions taken or omitted to be taken in reliance, whether wholly or partially, upon all 
or any part of the content, recommendations or help contained in this Software.



(g) The Licensor and its authorised distributors disclaim all liability for any corruption of data, inability to access 
data, loss of data, breach of privacy, or downtime as a result of or arising from the use of any online link 
between the Software and another server including without limitation in connection with any online 
services.

6 Term of Licence
(a) The term of this Licence is perpetual, provided that this Licence may be terminated by the Licensor if you are 

in breach of this Licence, or where requested by the Licensor (or if so prompted by the Software) you have 
not re-registered your use of the Software, or as otherwise set out in this Licence.

(b) Clauses 3, 4 and 5 will survive the termination of this Licence. Termination of this Licence will not prejudice 
any right which the Licensor may have, or but for the termination may have had, against you for a breach 
of this Licence.

(c)  Upon the termination of this Licence, you or your representative must destroy the Software, user's manual 
and related materials and any copies of them which you possess or return or dispose of them in the manner 
directed by the Licensor.

7 General
(a) This Licence is governed by the laws of the State of New South Wales.

(b) This Licence contains the entire agreement between the Licensor and you in relation to its subject matter 
and supersedes any prior agreements and understandings, whether written or oral.

Copyright © 2003 Reckon Limited. All rights reserved.
Software is © 2003, Zatso Pty Ltd and Reckon Limited.
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 Welcome to Quicken Payroll – the easier way 
to manage your payroll. 

You know how time consuming and difficult 
it can be to process and track payroll. 
You have to record hours, salaries and wages, 
vacation and sick time, deductions, 
allowances, superannuation and more—the 
list goes on and on. It's not surprising that many businesses let 
their bookkeeper or accountant deal with their payroll.

But with Quicken Payroll, you can handle your 
payroll quickly and easily.  When you hire an 
employee, simply enter the personal and salary 
information into an employee record. Keeping 
track of an employee's time, wages, deductions, 
and allowances is just as easy. When it's time to 
pay your employees, Quicken Payroll calculates 
wages, leave accruals, deductions, and 

superannuation and then prints the pay slips and other reports. 
You can even pay your employees, the ATO and super funds 
electronically and skip writing pay cheques altogether!
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What can Quicken Payroll do
Quicken Payroll easily handles the payroll tasks that you once had to do 
manually, such as:

 Calculating and tracking of all your employees' pays.

 Calculating PAYG and other payroll liabilities you need to pay.

 Writing out pay slips and Payment Summaries.

 Providing reports on your current payroll liabilities.

 Creating a list of employees who want their payroll payments directly 
deposited into their bank accounts.

 Calculating an employee's termination pay.

In addition, Quicken Payroll also does lots of things that you couldn't do 
manually, such as:

 Transferring payroll data to QuickBooks and Quicken.

 Creating custom export files to export payroll data to other accounting 
programs.

 Creating an EFT file so that you can pay your employees, super funds 
and the ATO through Electronic Funds Transfer (EFT). 

 Creating a file to be used to send your Payment Summary data 
electronically to the ATO.

 Creating a data file for transferring superannuation details to the funds 
that you deal with. 

Quicken Payroll provides you with reports to show you exactly where you 
stand each week with your payroll, and gives you the ability to create your 
own reports if you find that you need additional information. 

Quicken Payroll is sophisticated and packed with features, yet it’s easy 
enough for a novice to use. You can quickly set up your company and 
employee details and start paying your employees the same day that you 
purchased the program. Then, as you use Quicken Payroll and become 
more comfortable with it’s features, you will find that you can automate 
more and more of your payroll processes.
2 CHAPTER 1 - Overview of Quicken Payroll



Terms used in this user guide

Check boxes 
When we refer to “selecting” a check box, we mean that you should click 
on the check box, so that a check mark appears in the check box like this: 

. When we refer to “clearing” an option or check box, we mean that you 
should click on the check box, so that the check box is cleared, and appears 
like this: 

Option buttons
When we refer to “Clicking on this option” or “Selecting this option”, we 
mean that you should click on the Option button, if necessary, so that it 
appears like this: 

Mouse Operations
Double clicking – When we refer to double clicking, we mean that you 
place the cursor over a section of the screen and press the left mouse 
button twice.  The second click should immediately follow the first.

Right clicking – When we refer to right clicking on a something, we mean 
that you place the cursor over a section of the screen and press the right 
mouse button once. Most of Quicken Payroll’s activities can now be 
accessed by right-clicking.

Drop-down list
When we refer to selecting from a drop-down list, we 
mean that you should click on the down arrow to the 
right of the box, which displays the drop-down list 
and then you should click to choose one of the list 
options. 

Employee record
The term Employee Record is used throughout this guide to refer to the 
details in the Edit Employee window, which is accessed through the 
Employees List.
Terms used in this user guide 3



Finding your way around Quicken Payroll

The Navigator
The Quicken Payroll Navigator is your starting point for finding Quicken 
Payroll features, including activities, lists and reports. This central location 
gives you easy access to the most important parts of Quicken Payroll.

Each Navigator section represents a major payroll function, and displays a 
related group of list and activities.

To close the Navigator, click on the close button at the top of the panel on 
the left. To open the Navigator windows, choose Open Window List from 
the View menu.

In addition to this view, Quicken Payroll also provides you with two 
additional views - Multiple Windows and One Window views. For details 
see The View Menu on page 313.

Right–click menus
Most of the activities you perform can now be accessed conveniently by 
right-clicking and selecting the activity from a pop-up window.

Select a Navigator section or 
an open window from the 
panel on the left.

Click here to close the 
Navigator windows.

The most commonly used 
reports for this area are 
displayed for your 
convenience. Just click to 
create and display the report.
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The Toolbar
The Toolbar provides quick access to the most common lists and daily 
tasks.

Q-Cards appear in a small yellow window in the Toolbar and provide 
details about completing the currently displayed window. Q-Cards can be 
turned on or off through the Help menu.

Lists
Most of the employee, company and payroll data is set up through 
Quicken Payroll windows, which are available under the Lists menu.

All lists can be sorted by clicking on one of the column headings. To sort in 
the opposite direction, click a second time. Edit functions, Activities and 
Reports are available from the three buttons on the bottom of each list. If 
there are no related functions, the button will be disabled.

To view details or edit a list item, either double click on the item or select 
the function from the first button (for example, the Employee button). You 
can also access the most common functions for any list item by right-
clicking and then selecting the function from the pop-up menu.

Sort by clicking on a heading.
Resize a column by dragging 
the column marker.
Select a list item and then 
right-click, or select a function 
from the appropriate button 
below.
Click to display Edit 
functions, Activities, or 
Reports.
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Quicken Payroll's Calculator (Q-Calc) pop-up window
When you enter a number, you can either type the amount into the field, 
or you can use Quicken Payroll's Calculator Function (Q-Calc). 

To open Q-Calc

Numeric Entry Field – Position your cursor over the numeric data entry 
field and click with the right mouse button.

Numeric drop-down list – Click on the drop-down list arrow.

Quicken Payroll's Calendar (Q-Date) pop-up window
Q-Date is a quick and easy way to enter dates in a date field.  You can open 
the Q-Date window, by right-mouse clicking on any date field. You can 
then click to select the date you wish to enter. You can also open the 
calendar by clicking the up or drop-down list arrow in a date field.

To select a day, click on the day and then click Enter.  The date will be 
entered into Quicken Payroll.

 Click the << or >> buttons to go back or ahead one year.

 Click the < or > buttons to go back or ahead one month.

 Click Cancel to cancel and close Q-Date.

Click Enter to enter the result 
into Quicken Payroll.

Click Cancel to clear the result 
and close the Q-Calc window.
Click Clear to clear the result 
and start a new calculation.

Click these buttons to 
move the calendar to a 
different month or year.

Click to select a date and 
then click Enter to enter 
the date into Quicken 
Payroll.
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Quicken Payroll's Quick Zoom (Q-Zoom) pop-up window
To view how a Pay Total amount on the Pay Details window was 
calculated, move the mouse pointer over the field and click once with the 
right mouse button.  A Q-Zoom report will appear with full details of how 
the amount was calculated.
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Using Quicken Payroll—a quick overview

Getting started with Quicken Payroll

When you open Quicken Payroll for the first time, the Quicken Payroll 
Upgrade Wizard takes you through the process of upgrading your company 
file and reports from a previous version of Quicken Payroll. 

If you have a data file from a previous version of Quicken Payroll on your 
computer, click Next. Quicken Payroll will locate the previous version data 
files and give you the opportunity to convert them to the new version. 
Your old company data file will be left unchanged in the previous version 
file folder. For details see Upgrading from a previous version of Quicken Payroll 
on page 32.

If you don’t have a data file from a previous version of Quicken Payroll on 
your computer, click Exit Wizard. If you need to, you can always open the 
Upgrade Wizard later from the Wizard menu.

If you exit the wizard and don’t upgrade your previous version company 
data, a window will appear informing you that the sample file has been 
opened. Click OK to continue. Use the sample file to acquaint yourself 
with Quicken Payroll’s features. 

If this is your first time using Quicken Payroll, we strongly recommend 
that you run Quicken Payroll in parallel with your existing system for at 
least four pay periods so that you can compare results to ensure that your 
are using Quicken Payroll correctly.
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Step 1 – Set up your company
If this is your first time using Quicken Payroll, you need to create your 
company file and enter all of the company information that will be used 
throughout the payroll process—information such as your company name 
and address, phone numbers, Australian Business Number (ABN), Group 
number, and banking information.  

To make the job easy, when you create a new company file, the Company 
Wizard will take you step-by-step through the process of entering all your 
company details. Any information that you don’t have handy can be easily 
added later through Company Information (page 157) on the File menu.

Press F1 while the Company 
Wizard (or any other window) 
is open for further information 
on each step. 
This will display Quicken 
Payroll help with instructions 
for that specific step.
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Step 2 – Set up your preferences
When you have finished entering your company information through the 
Company Wizard, the Configuration Wizard starts up automatically 
allowing you to specify which features of Quicken Payroll you want to use. 
As is the case with all of Quicken Payroll’s wizards, you can always change 
the information later through the Preferences File menu command. 

For details, see Setting up a new company with the Company Wizard on page 
36, and Preferences on page 165.

Step 3 – Set up your awards
An Award is a grouping of employees that allows you to group employees 
together with common pay rates, and other pay details.  Rather than add 
the details each time you enter an employee, you can create an award.  
Then, when you add a new employee, you can select the award and all of 
those details are added to the new employee record.

The Configuration Wizard 
helps you to set up all of 
your program preferences, 
and enter some default 
calculations and amounts.

Awards save you having to 
re-enter all of the pay details 
each time you hire another 
employee under the same 
award, or with similar pay 
details. 
In addition, when you make 
changes to an award, the 
changes update all the 
employees under that award. 
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Awards are optional unless you want to pay employees using the 
Timesheet method. If you only have a few employees, or your employees 
don’t have many details in common, you may decide not to set up awards, 
but in most cases, setting up awards will save you time in the long run. 

When you apply the award to an employee, the following details are 
transferred from the award to the employee record:

 Department

 Pay period

 Superannuation calculation

 Leave accrual details

 Allowances (optional)

 Additional pay rates (optional)

 Shift pay rates (required only for timesheet awards)

Once awards have been created, adding new employees or changing pay 
details for a group of employees becomes quick and easy. 
For details, see Awards List on page 219.
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Step 4 – Set up your employees
As an employer, you must obtain and track a lot of information on each 
employee—information such as personal details, the employee’s position 
in the company, pay rates, leave details, deductions, allowances, 
superannuation and bank details. These details are used any time you pay 
employees, print pay slips and Payment Summaries, and anything else 
that relates to your employees. Quicken Payroll keeps track of all this 
information, so that you only have to enter it once. 

The easiest way to enter your employee information is to use the 
Employee Wizard, which takes you step-by-step through the process of 
entering employee details.

For details, see Setting up your employees with the Employee Wizard on page 
40. You can change any of the employee information later through the 
Employee record. See the Employees List on page 186 for details.

If you have been using QuickBooks to track your payroll, you can save 
time by importing your QuickBooks employee list into Quicken Payroll. 
This won't complete all of the required details for each employee, so you 
will need to go into the imported employee records to finish entering the 
employee details. For details, see Export Payroll Data to QuickBooks on page 
279.

Lists – As you enter employee and award details, you will be creating new 
list items such as pay rates, deductions, allowances, and sundry items.  You 
may find it easier to enter these items through the Lists menu. For details, 
see The Lists Menu on page 180.

The Employee Wizard 
simplifies the job of entering 
your employee information, 
ensuring that you enter all of 
the required information.
12 CHAPTER 1 - Overview of Quicken Payroll



Step 5 – Prepare your payroll
As soon as you have entered all of your company and employee 
information, you can start to process your payroll. Payroll preparation 
includes selecting which employees are to be included in the pay, entering 
hours worked for employees paid using the Timesheet or Spreadsheet 
method and making any modifications to the employee's hours and other 
pay details. These details are entered on the Pays Summary window. 

If all your employees receive the same wage each pay period, with no 
variations in hours, deductions, allowances, etc, all you need to do at this 
stage is click on Process Pays. However, you will probably need to make 
some adjustments for the current pay—you must edit pays and enter 
additional information whenever:

 You use the Timesheet or Spreadsheet method to enter hours that an 
employee works;

 You need to record hours worked that differ from the employee's 
standard hours;

 You make any kind of adjustments to allowances, deductions, or 
superannuation that apply to this pay only;

 You need to enter a sundry item (such as an expense reimbursement) 
or adjustment to the employee's pay;

 An employee is taking annual, sick, or any other type of leave; or

 You are paying a commission or bonus.

For details, see The Pays Summary window on page 49.

The Pays Summary window 
controls the processing of all 
pays.  
All your employees' pays are 
displayed here, allowing 
you to see exactly what each 
employee will be paid before 
you actually process the 
pays. 
Using Quicken Payroll—a quick overview 13



Step 6 – Process your payroll
Once you have prepared your payroll on the Pays Summary window, you 
are ready to process your payroll. The Process Pays window allows you to 
select which employees to pay and enter the pay dates. 

Quicken Payroll then processes pays for all of the selected employees, and 
provides you with a list of payroll reports that you can choose from. It’s 
that easy! For the full details, see Processing the pays on page 89.

Step 7 – Make your payroll payments
Now that your payroll has been calculated and processed, you need to pay 
your employees, the ATO, your Workers Compensation insurer, 
superannuation funds, and other payroll related agencies.  Quicken 
Payroll makes these payments as easy as possible, by providing you with 
three options that you can choose from when you want to make payroll 
payments:

 You can transfer your payroll data and use QuickBooks or Quicken to 
print out your payroll cheques;

 You can make your wage, superannuation and ATO payments directly 
through Electronic Funds Transfers (EFT); or 

 If you prefer to make payments manually, or you require payroll data 
to use with accounting software other than Quicken or QuickBooks, 
you can use Quicken Payroll's reports to provide you with all of the 
information that you need.

For details, see Making your payroll payments on page 93.

Step 3 (optional) – If you 
only want to pay one 
employee or one 
department, make your 
selection on the Advanced 
tab.

Step 4 – Click Process Pays.

Step 1 – Select which 
employee type you want to 
pay— for example, weekly, 
fortnightly, monthly, etc.
Step 2 – Check the pay period 
date and date paid, and 
adjust if necessary.
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End of year tasks
Quicken Payroll does not require you to do anything at the end of the 
financial year.  It automatically resets the employee year-to-date figures 
when you process the first pay in the new financial year.

If you have a large number of employees you may wish to archive the 
previous financial years pays and terminated staff to another file.  This will 
ensure that Quicken Payroll will operate as fast as possible.

When archiving information out of your file, be sure to keep multiple 
backup copies.  You will need them if the ATO decides to audit you.

For details, see Archive Data on page 162. 
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 If you are installing Quicken Payroll as a 
single user, in most cases all you will need to 
do is insert the Quicken Payroll CD and 
follow the onscreen instructions. It’s that 
easy!

If your situation is a bit more complicated, or you are installing 
Quicken Payroll on a network, just follow the step-by-step 
instructions in this chapter.
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Recommended system requirements 
To use Quicken Payroll, you will need the following equipment and 
software:

 An IBM or compatible computer with a Pentium Processor. We 
recommend an Intel Pentium 200 processor or higher. 

 Windows XP, Millennium, 2000, 98,or Windows NT4 (Service Pack 5 
and above).

 Minimum of 16 MB of memory (RAM). We recommend 64MB for 
optimum speed, especially if you are running Quicken Payroll and 
QuickBooks together.

 A hard disk with at least 35 MB of free disk space. 

 An SVGA monitor capable of displaying 256 colours in a resolution of 
at least 800x600. We recommend a resolution of 1024x768 in High 
Colour (16 bit). 

 A printer supported by your operating system, preferably a page 
orientated printer such as an ink jet, bubble jet or laser printer. 

 CD-ROM drive, sound card and speakers. We recommend a 24x CD-
ROM drive.

 Optional Microsoft Internet Explorer and an Internet connection are 
required for Internet updates and for accessing internet information 
sites such as the ATO’s web site and of course Quicken’s own highly 
informative website.
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Standard installation of Quicken Payroll 
Installation of Quicken Payroll is easy—just follow the steps below and the
on-screen instructions.

1 Shut down all running programs, including virus protection 
programs. Some virus protection programs can interfere with 
installation.

2 Place the Quicken Payroll CD into your computer’s CD-ROM drive 
and close the tray.  Windows will automatically start the installation 
and then display the Welcome to Quicken Payroll window. 

The Welcome to Quicken Payroll window should open automatically 
when you close your CD tray but if it doesn’t, you can use Windows 
Explorer to locate the file AUTORUN.exe or Setup.exe on the Quicken 
Payroll CD. Click on either of these files to start the installation.

If Autorun doesn’t work (nothing happens for a few minutes after 
you’ve put in the Quicken Payroll CD) then choose Run from the 
Windows Start menu. 
When the Run dialog box opens, type “D:\qprollv12\setup”and then 
click Open or OK. If your CD-ROM drive has a different letter than D, 
type that one instead.

3 Click Install to begin the installation process. The Installation Wizard 
Welcome window appears. To continue the installation, click Next.

To cancel the installation of Quicken Payroll, click Cancel.

4 Read the instructions for each step of the installation and then press 
Next when you have completed each step. If you need further 
information for any step, press F1 for onscreen help related to that 
step.

5 When the installation is complete, you will be informed that you need 
to re-boot your computer before you start using Quicken Payroll.
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Setting up Quicken Payroll on a network
Quicken Payroll is a single 
user program until it has been 
registered for use in a multi-
user environment. If you 
want to set up Quicken 
Payroll on a network so that  
more than one person can 
access the company's payroll 
information at the same time, 
you must obtain a multi-user 
licence and register for a 
multi-user environment. 

You can contact customer service for details by phone at 1-300-784-253 
Monday to Friday 9 am to 5 pm EST.

Step 1 – Install Quicken Payroll up on your server
1 Insert the install CD and install Quicken Payroll on your server.

Make sure to remember the directory where you installed Quicken 
Payroll.

2 Register Quicken Payroll. See Registering Quicken Payroll for a multi-user 
environment on page 26.

3 Create a new company or upgrade your company files from a previous 
version.

Step 2 – Install and register Quicken Payroll on each 
network computer

Quicken Payroll must be installed on each computer that will have access 
to the company file through the network server. Follow the standard 
installation steps on page 19 and set up each network computer as follows:

1 Insert the install CD and install Quicken Payroll.

2 Start up Quicken Payroll. If the upgrade wizard appears, click the 
Leave button.

Multi-user mode

Allows more than one 
person to access the 
company file at the same 
time.

Single-user mode

Allows only one person to 
access the company file at 
the same time. 

In single user mode, the 
company file cannot be 
accessed through a 
network.

G l o s s a r y T e r m
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3 Register each copy of Quicken Payroll installed, and register for multi-
user use if applicable See Register all copies of Quicken Payroll on page 21.

4 Using Windows Explorer, map a network drive from the Tools menu.

Select a drive letter and check the  Reconnect at logon check box. 
Note that each network computer must use the same drive letter.

5 Select the server and drive that Quicken Payroll was on and then click 
OK.

6 Return to Quicken Payroll and choose Setup Network Data Path from 
the File menu. This menu option is disabled until you have registered 
Quicken Payroll.

7 Change the path to the network 
drive and path that was set up in 
Step 4.  The drive and path must 
already exist on the network. 
For example, if Quicken Payroll 
was installed into c:\program 
files\QPRollv12, then enter 
c:\program files\QPRollv12\data 
as the data path. 
If you can't remember the data path and folder name, click Browse 
and use the window to locate the drive and folder.

8 Select  Use existing files located at the network server path.

9 Click Save.

10 Select the company file and then click Open.

Register all copies of Quicken Payroll 
You must register all copies of  Quicken Payroll—each computer must be 
registered with it's own unique registration number. However, to save 
time, you can register all of the computers with one phone call or one fax. 

You will first have to register each computer as a single user and then 
register for multi-user use.  At the time you obtain your multi-user 
registration number, you will have to purchase your multi-user licence. 
You will need to register Quicken Payroll for each computer that it is 
installed onto. See Registering Quicken Payroll for a multi-user environment on 
page 26 for multi-user registration details.
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Network troubleshooting

Quicken Payroll keeps losing the network 
data path
This can occur in the following situations:

 You manually copied the data files to the network drive, without using 
the Quicken Payroll Setup Network Data Path function to copy the 
files.

 The different copies of Quicken Payroll installed on the network all see 
the network drive and path differently.  For example, on one copy the 
network drive might be X: and on another copy it might be T:

 Not all copies of Quicken Payroll are registered as multi-user. The 
Quicken Payroll Multi-user version does not require registration as 
multi-user.

Network data corruption
Data files can become corrupted over a network if:

 The network protocol is not set up correctly;

 The hard drive on the workstation or the server is failing;

 The hard drive controller on the workstation or server is failing; or

 The network card/hub on the workstation or server is failing.

One of the easiest ways to test and isolate this sort of problem is to create 
a file that you know the exact byte size and then to copy that file to the 
suspect computer.  Once that is done, compare the file size on each 
computer to make sure it's the same—a failing network card, hub, hard 
drive or hard drive controller will cause the file to lose bytes in the transfer.  
You may need to swap out each hardware item until you locate the bad 
component.
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Uninstalling Quicken Payroll  
You do not need to uninstall your previous version of Quicken Payroll 
before you install the latest version. In fact, you shouldn’t delete your 
previous version until you have successfully transferred all of your payroll 
data to the latest version of Quicken Payroll. 

Before uninstalling Quicken Payroll, make a backup of the data files.  Not 
backing up may result in permanent loss of your payroll data.

To uninstall Quicken Payroll 
1 Click Start on the Windows taskbar and then click Programs.

2 Click Quicken Payroll.

3 Click Uninstall Quicken Payroll.

4 Select Automatic as the uninstall method. Quicken Payroll will only 
remove the files it uses. 

5 Click Next click Finish.

Note This will not delete the QPRollv12, DATA or BACKUP folders 
because these contain files created after the installation of 
Quicken Payroll, including the automatic backups, data files and 
other miscellaneous files.  If backups of these data files exist, you 
can use Windows Explorer to delete the directories.

Note also that each time you reinstall Quicken Payroll, you will have to 
obtain a new registration number.
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Why should I register?
Quicken Payroll must be registered within 21 days of installation.  After 
that time, the program will cease to operate until a registration number has 
been entered.   A registration number is obtained when you register your 
copy of Quicken Payroll.

Registering Quicken Payroll (as a single user)
A single user licence entitles you to run Quicken Payroll on one computer.  
Quicken Payroll must first be registered with a single user licence before 
you can obtain a multi-user licence.

1 Choose Register Quicken Payroll from the Activities menu to start the 
Register Quicken Payroll wizard.  Don’t forget that you can press F1 at 
any point for onscreen help. Click Next to continue.

2 Click to select the method of registration and then Click Next.  The 
next window displayed will depend on the registration method 
selected. 

For details on the three different installation methods, see:

Registration by Phone on page 25

Registration by Fax on page 25

Registration on the Internet on page 25

3 If you have already received your registration details, enter the 
Registration Number, otherwise, continue with the steps below.
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Registration by Phone 
You can register by phoning the registration line on 1300 650 061.  This is 
open 9 am to 5 pm EST, 5 days a week, Monday to Friday,

1 Indicate if Quicken Payroll will be registering the current company 
and then click Next.

2 Enter the contact details.  If you selected No in the previous step, you 
will also have to enter the company details.  Click Next.

3 Phone the number displayed on the next window.

4 When asked for the Serial Number, read it from the screen. 

5 You will be given a Registration Number, which you must enter.

6 Click Next. Quicken Payroll will display a window with the words 
Thank you for registering Quicken Payroll.

Registration by Fax 
1 Indicate if Quicken Payroll will be registering the current company 

and then click Next.

2 Enter the contact details.  If you selected No in the previous step, you 
will also have to enter the company details.  Click Next.

3 Click on the printer button to print the registration form.  Print the 
form and then fax it to the number on screen. Click Finish.

4 When you receive the registration number, choose Register Quicken 
Payroll from the Activities menu.  The Register Quicken Payroll wizard 
will appear.  Click Next to continue.

5 Click to select I have already received my registration details. Click 
Next.

6 Enter the Registration No.

7 Click Next. Quicken Payroll will display a window with the words 
Thank you for registering Quicken Payroll.

Registration on the Internet 
1 Click the web button displayed.  Quicken Payroll will open your web 

browser and take you to our Internet Registration page.

2 Select Quicken Payroll from the program list.
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3 Enter the serial number and the other details about your company.

4 Check that the company details are correct, especially your email 
address.

5 Click Register Product. Your registration details will be emailed to you.

6 When you receive the registration number, choose Register Quicken 
Payroll from the Activities menu.  The Register Quicken Payroll wizard 
will appear.  Click Next to continue.

7 Click to select I have already received my registration details. Click 
Next.

8 Enter the Registration No.

9 Click Next. Quicken Payroll will display a window with the words 
Thank you for registering Quicken Payroll.

Registering Quicken Payroll for a multi-user environment
A multi-user licence entitles you to install Quicken Payroll on several 
computers at one location.  It enables you to have several people accessing 
the payroll information at the same time. It is important that  Quicken 
Payroll is registered as multi-user on each computer using it on the 
network.  If not registered as multi-user, each time Quicken Payroll is 
exited and restarted, it will revert to the local drive and won't be able to 
find the company file.

You can either register each computer one at a time, or, to save time, you 
can make a list of serial numbers for each computer and obtain both your 
single use and multi-user registration numbers in one phone call or fax.  
You will still have to go into each computer and enter each registration 
number separately.

The method of registration will differ depending on whether you are 
registering Quicken Payroll (see below), or the Quicken Payroll Multi-User 
licence (see page 27).

Step 1 – Register for single user use

The first step is to register each copy of Quicken Payroll as a single user.  
The multi-user registration option is not available until the copy has first 
been registered for single use. 

Multi-user mode

Allows more than one 
person to access the 
company file at the same 
time.

G l o s s a r y T e r m
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The registration number you receive is entered into Quicken Payroll 
through the Register Quicken Payroll command from the Activities menu.

See Registering Quicken Payroll (as a single user) on page 24 for details.

Step 2 – Register for multi-user use

The second step is to purchase a multi-user licence and then register each 
computer for multi-user use.  The process for entering the multi-user 
registration licence is virtually identical to the process of entering the 
single user registration number.

To register Quicken Payroll for multi-user use
1 Choose Register Quicken Payroll from the Activities menu to start the 

Register Quicken Payroll wizard.  Click Next to continue.

2 Indicate if Quicken Payroll will be registering the current company 
and then click Next.

3 Enter the Contact details.  If you selected No in the previous step, you 
will also have to enter the company details.  Click Next.

4 Select  Register for a Multi-User Environment.

5 Click to select the method of registration and then click Next.  The next 
window displayed will depend on the registration method selected.

6 If you select register by Fax, the next window will allow you to print 
out the fax form. Complete and fax the form.  When you receive your 
registration number, open up the Register Quicken Payroll wizard 
again, select   I have already received my registration details and then enter 
the registration number. 

7 If you select register by Phone, the next window will display the 
registration phone number. Phone the registration phone number 
from the window. Make sure you have a valid credit card nearby.  You 
will need to pay for the licence before you can be given the registration 
numbers that will allow full multi-use access.

8 When you have received your registration details, enter the 
Registration Number.

9 Click Next. Quicken Payroll will display a window informing you that 
you have been registered for use in a multi-user environment.
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Registering the Quicken Payroll Multi-User package
If you purchased the Quicken Payroll Multi-User licence, you don't need 
to register first as a single user, since the multi-user mode is already 
enabled. However, you will still need to register Quicken Payroll for each 
computer that it is installed onto.

If you are not sure if you have the Multi-user version, close the registration 
wizard and then choose About from the Help menu. The screen will 
display “Quicken Payroll MU” if you have the multi-user version. 

1 Choose Register Quicken Payroll from the Activities menu to start the 
Register Quicken Payroll wizard.  Click Next to continue.

2 Click to select the method of registration and then click Next.  The next 
window displayed will depend on the registration method selected. 
See the following sections for details:

Registration by Phone on page 25

Registration by Fax on page 25

Registration on the Internet on page 25

3 When you have received your registration details, enter the 
Registration Number.

4 Click Next. Quicken Payroll will display a window informing you that 
the registration procedure is completed.
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Keeping Quicken Payroll current
To use Quicken Payroll, you should make sure that you have the latest tax 
scales and the latest upgrade of the program. Occasionally we issue a 
maintenance release for an existing version of Quicken Payroll. This can 
happen if a we update a feature or need to change the software to meet 
some new legislative requirement. Therefore, you should periodically 
perform an update to ensure that you are always using the most recent 
release of Quicken Payroll. 

You can obtain the latest tax scales and maintenance release by using the 
Update Quicken Payroll internet update feature. Additional charges may 
apply. This feature allows you to update Quicken Payroll through the 
internet.  By using this feature, you are saving yourself time and you don't 
have to know how to install any of the updates—Quicken Payroll will do 
that for you.  Some update files, such as tax scales or reports, will only be 
available if they have changed during the financial year.

To use this feature you must have a modem and Internet account with an 
Internet Service Provider. For details, see Internet Update on page 309.

If you don’t have an Internet connection, you can update tax scales 
manually through the Tax Scales and Payroll Tax Scales list, or you can use 
the Update Tax Scales by Disk feature, which will allow you to update the tax 
scales using a file sent to you on floppy disk. For details, see Update Tax 
Scales by Disk on page 309.
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Chapter Contents
 After you have installed and registered 
Quicken Payroll, you can set up your company 
file, preferences, awards and your employee 
details.

If this is your first time using Quicken Payroll, use the Company 
Wizard to set up your company data file. The Company Wizard 
helps you enter information about your company so that you can 
begin working with Quicken Payroll as soon as possible. 

If you want Quicken Payroll to speed up the entry of employees, 
or if your employees come under a federal award, you need to set 
up awards. Once that is done, you can set up your employees 
using the Employee Wizard, which takes you step-by-step 
through the process of adding an employee and ensures that you 
complete all of the required details.

If your company file was created in an earlier version, Quicken 
Payroll converts your existing company file, including your award 
and employee data.
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Upgrading from a previous version of Quicken 
Payroll

To use payroll data created in a previous version (QuickPayroll), you must 
first upgrade the files to Quicken Payroll v12 format.   The process for 
upgrading and the effectiveness of the upgrade will depend on what 
version you are upgrading from.

Before you upgrade your data files
Before transferring your information to the latest version it’s important 
that you have first created a reliable backup copy of your company files, 
using your existing QuickPayroll version (the version you are upgrading 
from). See Backing up your company data on page 319 for further details.

Upgrading from QuickPayroll v6, v7, v8 or 
Quicken Payroll v9

Upgrade using the Upgrade Wizard
When you open Quicken Payroll for the first time, the Quicken Payroll 
Upgrade Wizard takes you through the process of upgrading your company 
file and reports from a previous version of Quicken Payroll. You can also 
open the Upgrade Wizard from the Wizard menu.

1 The Upgrade Wizard is started automatically when you first open 
Quicken Payroll, or when you select Upgrade Wizard from the Wizard 
menu.
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2 Click Next. Quicken Payroll will locate the previous version data files 
and give you the opportunity to convert them to the new version. 
Your old company data file will be left unchanged in the previous 
version file folder.

3 Enter the requested details on each window. The wizard allows you to 
select which company files and reports you want to upgrade to the 
current version of Quicken Payroll.

4 When you have completed the information for each step, click Next. 
If you want to go back to a previous step, click Previous.  

5 When you have completed all of the steps, click Finish. Your company 
files and reports can now be used in Quicken Payroll v12.

You can also upgrade to Quicken Payroll v12 using the Open Existing 
Company menu command from the File menu, but we recommend that 
you use the Upgrade Wizard if you are upgrading from versions 6 to 9. 

Upgrading from earlier versions
If you are converting your payroll data from a version of QuickPayroll 
prior to v6, the conversion process does not work quite as well because of 
changes in data structure and features. For example, in version 3, 
Superannuation deductions were handled through the Deductions list, 
whereas in later versions, there is a separate Superannuation list.  

Accordingly, after converting from a version prior to QuickPayroll v6, it is 
imperative that you check your data carefully.  You must carefully check 
areas of your data where the program has gone though the most changes, 
in particular Employee records, Awards and Preferences.
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Transferring payroll information using the 
Open Existing Company menu command
Transferring payroll information from a company file created in a previous 
version is as simple as opening the previous version company file from the 
new version and letting the Quicken Payroll conversion process lead you 
through the conversion. For this process you MUST have the previous 
version of QuickPayroll installed on your computer.

You should only use this process for transferring payroll data from 
versions prior to QuickPayroll v6. For version 6 and subsequent versions, 
you should always upgrade using the Upgrade Wizard.

To upgrade payroll data created in versions prior to 
QuickPayroll v6
1 Choose Open Existing Company from the File menu to display the 

Select Company File window.

2 Locate the company file created in the previous QuickPayroll version. 

Warning 
Do not attempt to use the Restore procedure to restore a company 
backup file created in a previous version.

All of the current 
QuickPayroll company files 
are listed in this window 
with the extension QPW.

Version
Company file is found in 
folder named Company file name  

Version 2 QPROLLV2 {company name}.QP2

Version 3 QPROLLV3 {company name}.QP3

Version 4 QPROLLV4\DATA {company name}.QPW
34 CHAPTER 3 - Setting up your company and employee data



To locate company files created with versions prior to version 4, 
including those with QPC, QP2, QP3 and TPS extensions, select 
Other QP Companies from the Files of type drop-down list.

3 Click to the company file and then click Open. Quicken Payroll 
recognises that the file you are opening was created in a previous 
version and begins the conversion process. A message is displayed 
informing you that conversion is required.

4 Click Yes.  Quicken Payroll will now import the payroll data.  
The Converting Files window displays progress of the conversion 
process.  This process may take a few minutes.  How long it takes to 
import the payroll data depends on how much information is in the 
data file and the speed of the computer.

Notes If, after an hour, Quicken Payroll is still importing the data file 
contact Technical Support for advice (Monday to Friday, 9am to 
5pm EST). Do not turn the computer off, or shut down Quicken 
Payroll unless told to do so.

If the conversion process cannot locate your Company.TPS file, or 
it is corrupted, your converted company will display the name 
CHECK with a series of numbers after it.  In this situation you will 
need to re-enter the company details under File menu – 
Company Information.

5 When the Configuration Wizard is displayed, follow the onscreen 
instructions and click on Next after each step.  Press F1 while the 
Configuration Wizard is open for further information on each step. 
This will display Quicken Payroll Help with instructions for that 
specific step.

6 When the Configuration Wizard is finished, your company file has 
been fully converted. It is critically important that you carefully 
review your company data, in particular Employee details, Awards 
and Preferences.
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Setting up a new company with the Company 
Wizard 

The Company Wizard takes you step-by-step through the process of 
entering company details such as your company name and address, phone 
numbers, ABN and banking information. If you don't have all of the 
information handy, don't worry—other than the company name, you can 
leave any fields blank and then edit them later through the Company 
Information menu item.

After your company details have been entered, the Configuration Wizard 
is displayed, allowing you to select which payroll features you will be 
using.  If you change your mind on any of these later, you can change them 
through Company Preferences. Although you can only access the 
Company Wizard when you create a new company file, you can change 
any of the company details later through the Companies List window.

Using the Company Wizard
1 The Company Wizard is automatically started when you create a new 

company file. To start the Company Wizard and create a new 
company file, choose New Company from the File menu, or click on 
Create a New Company from the Navigator.

2 Enter the requested details on each window.  Press F1 while the 
Company Wizard is open for further information on each step or see 
Preferences on page 165 or Companies List on page 180. 

3 When you have completed the information for each step, click Next. If 
you want to go back to a previous step, click Previous.  

4 When you have completed all of the steps, click Finish. 

Wizard

A wizard is a handy tool that 
takes you step-by-step 
through a setup process. 
Quicken Payroll provides 
you with five wizards:

 Company Wizard

 Configuration Wizard

 Employee Wizard

 Report Wizard 

 Update Wizard

G l o s s a r y T e r m
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Setting up your preferences with the Configuration 
Wizard 

The Configuration Wizard allows you to specify which features of Quicken 
Payroll you want to use and lets you set up certain default values.  If you 
answer No to a question, you are turning that feature off and the feature 
will disappear until you turn it back on.  To turn a feature back on simply 
re-run the configuration wizard and answer Yes to the question, or change 
the preference through Preferences.

You can change any of these preferences later by choosing Preferences 
from the File menu.

Using the Configuration Wizard
1 The Configuration Wizard is automatically started as part of the 

Company Wizard when you create a new company file. 

If you want to change the configuration details for an existing 
company, choose Configuration Wizard from the Wizard menu.

2 Enter the requested details on each window. Press F1 while the 
Configuration Wizard is open for further information on each step. 
This will display Quicken Payroll Help with instructions for that step.

3 When you have completed the information for each step, click Next. 

4 If you want to go back to a previous step click Previous.  

5 When you have completed all of the steps click Finish.

For further details, either press the F1 key while you are in the 
Configuration Wizard, or see Preferences on page 165
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Setting up Awards 
If you want Quicken Payroll to speed up entry of employees or if your 
employees come under a federal award, you should set up awards before 
you set up your employees. If you have staff that are paid different rates 
for different times of the day, then you must set up awards with shift 
details for these employees.

Awards let you set up payroll details that a group of employees have in 
common. When you apply the award to an employee, the following details 
are transferred from the award to the employee record:

 Department

 Pay period

 Superannuation calculation

 Leave accrual details

 Allowances (optional)

 Additional pay rates (optional)

 Shift pay rates (only for timesheet awards)

Once awards have been created, adding new employees or changing pay 
details for a group of employees becomes quick and easy.

Awards are generally optional, however if you want to pay employees 
using the Timesheet method, you must set up awards with the timesheet 
section completed.
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Creating a new award 
Click Create a New Award on the Company Navigator to display the 
Adding a New Award window. Name the award on the Standard Details 
section and then enter the default department, pay period, leave loading 
and superannuation details.

Set up the pay rates for employees under this award on the Award 
Payment Details section. For each classification (or level) within the award, 
you can specify different remuneration amounts for permanent, part-time, 
or casual staff.  You can also specify allowances and additional pay rates 
that apply to a classification.

To pay employees according the time they start and finish a work shift 
using the Timesheet method (see page 210), you must complete the 
Timesheet Payments section. For each shift, complete a separate line. Make 
sure you don’t forget to allow for and enter unpaid meal and rest breaks.

For full details on awards, either press the F1 key while you are entering 
the award details, or see the Awards List on page 219. 

For details, see the 
Standard Details 
tab on page 220.

For details, see 
the Award 
Payment Details 
tab on page 222.

For details, see the 
Timesheet Payments 
tab on page 225.
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Setting up your employees with the Employee 
Wizard 

The Employee Wizard is the easiest way of creating a new employee 
record.  It takes you step-by-step through the process of adding an 
employee and ensures that you enter all of the required details. 

If you don't have all of the information handy, don't worry—not all of the 
details have to be entered right now. The Employee Wizard will let you 
know if you have not entered mandatory information at each step. You can 
add or change any of the employee details later through the Employee 
record (see page 186 for details). 

You can also create a new employee record through the Employees list, but 
we strongly recommend that you always use the Employee Wizard—that 
way you won't overlook any of the steps involved.

Creating a new employee  
To create a new employee record using the Employee Wizard, choose 
Create New Employee from the Wizard menu.

Enter the requested details on each window. When you have completed 
the information for each step, click Next. If you want to go back to a 
previous step, click Previous. Press F1 while the Employee Wizard is open 
for further information on each step. This will display Quicken Payroll 
Help with instructions for that specific step.
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If you want to add a photo to the employee record, or if you want to 
change the employee number from the number automatically assigned, 
you can do this through the Employee list.

When you have completed all of the steps, click Finish.

For further details, either press the F1 key while you are in the Employee 
Wizard, or see the Employees List on page 186. 

Setting up Superannuation 
Calculating, tracking and paying superannuation can be a very 
complicated business and it will be more complicated when the new 
multiple superannuation rules come into effect. Fortunately, once you set 
up all of your company and employee superannuation details, you can let 
Quicken Payroll do most of the work for you. 

Superannuation fund details
Quicken Payroll allows you to track multiple superannuation funds, as 
well as multiple employee contributions. You can create as many super 
funds as you require. 

Superannuation funds are set up through the Company Wizard and can 
be edited or added through the Super Funds list.

Enter the details for each superannuation fund. For details, see the 
Superannuation Funds List on page 254.
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If you wish to pay your superannuation funds electronically, you will 
need to contact your superannuation fund manager to find out if they will 
accept the information electronically. If your superannuation fund 
manager accepts contributions and the associated details electronically, 
you must enter all of the banking details.

Superannuation preferences
Your default superannuation calculation details are set up through the 
Configuration Wizard when you create a new company. You can edit these 
defaults through Preferences on the File menu.

Select which employees superannuation should be applied to and then 
enter the threshold if applicable, as well as the default Employer 
Superannuation Guarantee Contribution (SGC) percentage. 

For details, see Superannuation preferences on page 170.

Superannuation calculations
Once you have set up your Superannuation Fund details, you need to set 
up your employee details so that superannuation is automatically 
calculated for them each pay period. 

Please note that the rules and regulations regarding superannuation 
contributions can be complex, so make sure that you understand them 
fully. For details, contact the ATO and obtain the guide Superannuation 
Guarantee – A Guide for employers. See Getting answers to your PAYG and tax 
questions on page 335 for contact details.

Select which employees the 
super threshold applies to.
The super threshold is the 
amount that employees must 
earn before you have to pay 
employer super for them.
Enter the Superannuation 
Guarantee Contribution (SGC) 
percentage. This is the 
minimum super contribution 
you must make on behalf of each 
employee.

S.G.C.

Superannuation Guarantee 
Contribution (SGC) is the 
minimum amount of super 
contribution that you must 
make on behalf of each 
employee.

G l o s s a r y T e r m
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Step 1 – Set up the Super fund and rate details

First, you must set up the superannuation fund details and the amount of 
superannuation to be deducted from each pay period. This is done in the 
Employee Record – Super section (see page 202) for each employee.

For most employees, you must select at least Employer S.G.C. 
(Superannuation Guarantee Contribution). Some employees are exempt, 
such as those over 70 years of age and those under 18 working 30 hours a 
week or less. For details see S.G.C. exempt employees on page 203. 

You can set superannuation up as a flat dollar amount per pay cheque, or 
as a percentage of wages. You would use a flat dollar amount where the 
superannuation is based on a standard employee earnings base. More typical 
however is the situation where the superannuation is based on Ordinary 
Time Earnings (see page 45), in which case you would calculate 
superannuation based on a percentage of OTE.
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Step 2 – Set up what superannuation is calculated on

Once you have set up the superannuation rate, you need to tell Quicken 
Payroll what you want to apply the rate to. For most employees, this is 
done through the Employee Record, on the Pay Rates tab. For employees 
paid using the Timesheet method, you must set these details up through 
the award that the employee is working under.

For employees paid by the Normal or Spreadsheet pay method, this is 
done on the Employee Record – Pay Rates section (see page 194).

If you have employees paid under the Timesheet method (see page 225), 
you must set up an award with timesheet details. 

On the Award Timesheet Payments tab, you will need to set up how 
Superannuation is applied to the shift and to overtime. For example, you 
might set up your award so that superannuation is only calculated on 
regular shift times, but not on overtime, or weekend work.

When you set up allowances, sundry items, commissions or bonuses, you 
will have to indicate if superannuation applies to the item. 

In this example, 
Superannuation is only 
applied to Normal hours and 
not to overtime or weekend 
rates.

For employees paid using the 
timesheet method, you 
indicate how superannuation 
is applied to the shift through 
the Award – Timesheet 
Payments tab.
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Ordinary Time Earnings (OTE)
Under the Superannuation Guarantee Contribution rules, an employer’s 
superannuation liability is based on the employee’s notional earnings base. 
Where there is no acceptable earnings base, OTE is used as a default 
earnings base. Ordinary Time Earnings (OTE) is defined at the earnings an 
employee receives on a regular basis. 

OTE includes payments such as wages for ordinary hours of work, 
remuneration while on annual, long service or sick leave, allowances and 
some bonuses.

OTE excludes payments such as overtime payments, Christmas bonuses, 
payments in lieu of notice, some redundancy payments, lump sums paid 
for accrued leave on termination of employment and payments when on 
maternity or paternity leave.

The above is only a partial listing of inclusions and inclusions. For the 
complete listing and explanation, obtain a copy of ATO Ruling SGR 94/4 – 
Superannuation Guarantee Ruling – Ordinary Time Earnings. You can obtain 
this online from the ATO Legal Database at the following website: 
http://law.ato.gov.au/atolaw/index.htm

Reporting new employees to your super fund
In the Super by Fund report, Quicken Payroll will automatically places any 
superannuation contributions for new employees into the New Employee 
column.  This ensures that the superannuation fund knows there is a new 
employee and can ensure the required information is sent to them.

1 Choose Super from the Reports Menu.

2 Choose By Fund Name>Current Pay. 

3 The Report Writer opens up and displays the report.  For any new 
employees, Yes is displayed in the New Employee column. If any 
contributions have been made, the contribution amount will be 
reported in the Exception Amount column.

Employees are moved from the New Employee column when you 
export the superannuation file. Therefore, to remove the employees 
from the New Employee column, export the superannuation file—
even if you are not using the electronic lodgment feature.  

Ordinary Time Earnings 
(OTE)

OTE, for Superannuation 
Guarantee purposes, is the 
total of the employee's 
earnings for ordinary hours 
of work, over-award 
payments, shift loading and 
commission. The ATO has a 
ruling available which 
explains this further. Obtain 
(Superannuation Guarantee 
Ruling SGR 94/4).
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4 To create a report for a single fund, select the fund name from the 
Super Funds drop-down list.

5 Make any adjustments required and then click on the Print icon. The 
report highlights new employees and allows the payroll administrator 
to enter the contact details should the fund manager have any 
questions.

Reporting contributions to your super funds
Quicken Payroll provides you with two ways to report superannuation 
contributions:

 The Super Report (page 306) lists contributions by employee or by 
fund and shows the amounts payable and what accounts they should 
be paid to.

 The Export Superannuation Details Activities menu command creates 
three files for transferring the superannuation details and the 
payment to the relevant superannuation fund. Before transferring any 
money, be sure to speak with your fund manager to see if they support 
this method of transferring the payroll information.

Contact your fund manager to find out if you can send the files to them by 
email, otherwise copy the three files onto a floppy disk and mail the disk 
along with the payment to your superannuation fund.

For details see Export Superannuation on page 285.
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 When it’s time to pay your employees, just 
choose which employees you want to pay, 
make any adjustments required and then let 
Quicken Payroll calculate wages and 
superannuation, deduct taxes and print the 
pay slips, monthly schedule and any other 
reports you need.

Quicken Payroll also makes paying your employees and your 
payroll liabilities as easy as possible, no matter how you choose to 
pay them. You can make payments through QuickBooks, 
electronic funds transfer, or using the information provided by 
Quicken Payroll’s payroll reports.
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Before you start
Before you prepare your payroll, you make sure that you have up-to-date 
tax scales.  Quicken Payroll provides three ways to update your tax scales:

 manually through the tax scales list (see page 258),

 automatic update over the Internet (see page 309), or 

 using a floppy disk (see page 309). 

Preparing your payroll
Payroll preparation includes choosing which employees you want to pay 
and making any modifications to individual pays. 

Typical modifications to individual pays include entering hours worked 
for employees paid using the timesheet or spreadsheet method, making 
any changes to the employee's standard pay details, entering leave details, 
paying bonuses and commissions, or making sundry adjustments.  

You must enter additional information through the Prepare Pays window 
in any of the following situations:

 You use the timesheet or spreadsheet method to enter your employees’ 
hours;

 You need to record hours worked that differ from an employee's 
standard hours;

 You need to make any kind of adjustments to allowances, deductions, 
or superannuation that apply to this pay only;

 An employee is taking annual, sick, or any other type of leave;

 You are paying a commission or bonus; or

 You need to enter a sundry item or adjustment to the employee's pay.

If all your employees receive the same wage each pay period, with no 
variations in hours, deductions, allowances, or in other details, all you 
need to do at this stage is proceed to the next step and Process the Pays. 
See page 89 for details on processing pays.
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The Pays Summary window 

The Pays Summary window displays all of your pays before they have 
been processed and is the starting point to entering and editing current 
pay details and selecting which employees to pay. All your employees' 
pays are displayed here, allowing you to see each employee’s pay details 
before you actually process the pays. 

All employees that will be paid on this pay run will have Yes in the Pay 
column. A grey line indicates an employee that will be excluded from this 
pay run. this includes Employees on leave and those whose pay has been 
disable. An “S” (Suspend) followed by a number in the Pay column 
indicates the number of pays that the employee will be excluded from. 

Red highlighting indicates that the pay amount is negative —probably 
because you haven’t entered the hours worked or pay amount yet.

To open the Pays Summary window, choose Prepare Pays from the 
Activities menu or click Pays on the toolbar.

The default view is to display all employees. However, if you prepare 
payroll for one pay period at a time, you can select the appropriate pay 
period and you will be able to view just the employees working under that 
pay period.

Click on any of the headings to 
sort the list by that heading.
Double click on the employee’s 
name to edit their pay.
Select Activities >Process 
Pays to process pays for the 
current pay period.
The Pay column indicates if the 
employee will be paid during 
this pay. Select the pay period that you want to pay— All Employees, Weekly, 

Fortnightly, Bi-monthly or Monthly.

Select the pay period from the 
droop-down list at the 
bottom of the window.
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For example, you may process payroll for weekly employees each Friday 
and process payroll for monthly employees on the last business day of the 
month. In this case when preparing the weekly employee’s payroll, you 
can display the list of weekly employees by selecting Weekly.

Sorting the list
When you view the Pays Summary window, you will notice a blue arrow 
in one of the headings.  This arrow indicates which column the employees 
are being sorted by and what order they are being sorted by.

In the above example, when the Name column has the blue arrow in it, the 
list is sorted by employee name. With the arrow pointing up, the list is 
sorted in ascending order (A to Z).  With the arrow pointing down, the list 
is sorted in descending order (Z to A).

To change the sort column, click in the heading of the column you want to 
sort by.  By default Quicken Payroll will sort in ascending order.  To sort in 
descending order, click the column heading again.

Finding an employee 
You can find an employee by clicking on the column heading to sort by 
that column and then scrolling down, but if you have a lot of employees, 
you may want a quicker method to locate the employee on the list. 
Quicken Payroll provides an additional way to quickly find an employee—
using the Scroll bar. If you click and hold the mouse button down while 
dragging the scroll bar, a small scroll window will appear displaying the 
position on the column selected for sorting. 

Simply click any column 
to sort by that heading. 
Click again to reverse the 
sort order.

As you scroll down on the list, the 
position on the column selected for 
sorting appears. This is a quick way to 
find a particular employee.
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Selecting employees to pay
Quicken Payroll provides you with the ability to select which employees 
you want to pay at two levels:

1 On the Pays Summary window – The Pays Summary window allows 
you to select which employees will be paid and which employees will 
be excluded, on an employee by employee basis. The default setting is 
to include all employee in the current pay run.

2 On the Process Pays window – After your payroll has been prepared, 
the Process Pays window allows you to select which employees will be 
paid on a group basis—any combination of weekly, fortnightly, bi-
monthly, or monthly. You also have the option to pay only a single 
department, or a single employee. 

For example, if you want to pay bi-monthly and monthly employees 
in this pay period, when you process the pay, you can select these 
periods. You do not have to use the Pays Summary window to exclude 
any of the groups not being paid.

Excluding an employee from a pay run
Employees are excluded from a pay run when you disable the pay for the 
current payroll run, or if you made a payment in a previous pay run that 
covered more than one pay period.

Disabling a pay
Disable a pay if an employee does not need to be paid this week and they 
are not on leave.   A pay for that employee will not be processed for the 
current pay period.

To exclude an employee from the current pay run, select the employee and 
click Activities>Disable Pay.  The Yes in the Pay column will disappear 
and the line will appear with a grey line through it. The pay will be 
excluded until you enable the pay again.

Note Red highlighting indicates that the pay amount is negative —
probably because you haven’t entered the hours worked or pay 
amount yet. Before you can process the pays, you will have to 
record the hours, or else disable the pays.
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Excluding an employee from a set number 
of pay runs
You can also exclude an employee from a set number of subsequent pay 
runs, simply by indicating the number of pay periods that the current pay 
covers.

Example An employee normally paid weekly is going on annual leave 
for four weeks and you want to pay the entire four weeks 
vacation pay in advance and automatically exclude the 
employee from the next three pay runs.

To exclude an employee from a set number of subsequent pay runs, simply 
enter the number of pay periods that the current pay covers (including the 
current pay). Quicken Payroll will then automatically exclude the 
employee from the specified number of subsequent pay runs. 

In subsequent periods, the Pay column will display the letter S (for 
suspended) followed by the number of pay periods the employee will be 
suspended from and the line will appear with a grey line through it.

See Previewing and adjusting an employee’s pay on page 52 for details.

Adding an employee back into a pay run
To add a pay back into the pay run, select the employee and click 
Activities >Enable Pay.  The Pay column will change to Yes and the grey 
line will be removed.

Previewing and adjusting an employee’s pay

Previewing an employee’s pay
The Pays Summary window displays most of the pay totals for the current 
pay run. However it does not display the details, sundry payments, or the 
number of pay periods covered by the current pay.

To view pay details, select the employee and choose Activities>Edit 
Pay(s), or double -click on the employee name. The Pay Details window 
will be displayed.
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To close the Pay Details window without making any changes, click 
Cancel, or press the keyboard Esc key.

Prepare Pays Reports
These reports display a comprehensive preview of what has been 
calculated for each employee. After reviewing the report, you can edit the 
unprocessed pay if you need to.  The advantage of this is that you no 
longer need to wait until the payroll has been processed to create a report 
listing the full pay details for each employee.

Click Reports, and then select the report you want to print. The Quicken 
Payroll Report Writer will display the report selected.

Editing and adding additional details
You will need to edit an employee’s pays to enter to record hours worked 
for employees paid using the timesheet or spreadsheet method, to make 
changes to the employee's standard pay details, to enter leave details, to 
pay bonuses and commissions, or to make sundry adjustments. 

To make changes to an employee’s pay details that apply to every pay, you 
should make the changes through the Employee record. By making 
changes through the employee record, you won’t have to enter the details 
for each pay run.

To edit an employee’s pay
Select the employee and click Activities>Edit Pay(s), or double-click on 
the employee’s name. The data entry window displayed next will depend 
on the method used to pay the employee (selected in the Employee 
record).

The Normal Pay window

For employees paid under the Normal pay method, the Normal Pay 
window allows you to enter pay rates, deductions, allowances, sundries, 
commission and superannuation details for the current pay. This is the 
most common method of entering pay details. See The Normal Pay window 
on page 55 for further details.
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The Timesheet Entry window

For employees paid using the Timesheet method, shifts worked are 
entered on the Timesheet Entry window, which is similar to the Normal 
Pay window, except that instead of an Hours tab, the Timesheet entry 
window has a Timesheet tab and a separate Leave tab. 
For details, see The Timesheet Entry window on page 71.

The Spreadsheet entry window

For employees paid under the Spreadsheet method, hours for the pay 
period are entered on a spreadsheet-style window. 
To enter additional details click on the Details drop-down list arrow. 
The hours entered on the spreadsheet are automatically transferred to the 
Hours section. For details, see The Spreadsheet Entry window on page 78.
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The Normal Pay window   
The Normal Pay window allows you to edit or enter pay rates, deductions, 
allowances, sundries, commission and superannuation for an employee's 
pay.  Depending on the options you have enabled or disabled in 
Preferences, some of these tabs may not be visible.

Use this method for employee whose hours and pay details are usually the 
same each pay period. When you prepare the employee’s pay, the 
employee’s hours, pay rates, allowances, deductions and most other pay 
details will come direct from the employee record. You will only need to 
modify the pay if you need to adjust the hours for this pay period, or if you 
want to add leave taken, sundry items, commissions or bonuses.

The Pay Totals section displays all of the pay amounts for the employee.  
Click on any of the fields to display a Q-Zoom window, which details how 
the amount was calculated.

Pay Periods 
This represents the number of pay periods that this payment covers. 
Generally, you should leave this field at “1”. If you enter a number greater 
than one, the employee will be excluded from some future pay runs.

Click on any of these fields 
for a Q-Zoom report 
showing how the amount 
was calculated.
If the pay covers more than 
one pay period, enter the 
number of pay periods in the 
Pay Periods box.
If you manually change the 
Tax amount,  Manual 
Tax appears here. To revert to 
the calculated amount, click 
to clear the check mark. 
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In the above example, an employee is going on annual leave for three 
weeks and is being paid the entire three weeks in advance in addition to 
the current pay, so “4” weeks is entered. The employee will then be 
automatically excluded from the next three pay runs and tax will 
calculated accordingly.

Note When you make any payment that covers more than one pay 
period, don’t forget to also adjust any allowances or deductions 
accordingly. 

Pay Totals 
The Pay Totals section displays most of the pay totals for the current pay 
run. Click on any of these fields to display a Q-Zoom report showing how 
the amount was calculated.

Data entry section 
Pay details such as deductions, allowances, superannuation details and 
normal hours from the employee record.  You can edit these details for this 
pay through the Pay Details window, but if you want the details to be 
changed permanently, you must change them in the Employees record.

Leave taken, sundry items, commissions and bonuses, on the other hand, 
can only be entered through the Pay Details window—they cannot be set 
up in the employee record.

On each tab, to add a new line, click Insert, or TAB to a new line.  To delete 
a line, select the line, click Delete and then click OK to confirm that you 
actually want to delete the line. 

Edit This Pay
To help prevent inadvertent changes, you cannot edit a past pay unless the 

 Edit This Pay check box has been selected on Pay windows. Accordingly 
this check box does not apply when setting up a pay. See Editing a past pay 
on page 248 for details.

Manual tax
If you adjust the tax manually, a check mark  will be placed in the 
Manual Tax  check box at the bottom of the window. To revert to the 
calculated amount, click to remove the check mark.

Q-Zoom report

A Q-Zoom (QuickZoom) 
report is a “drill-down” 
report that displays the 
detail behind a number.

G l o s s a r y T e r m
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Editing a Normal pay 
1  Choose Prepare Pays from the Activities menu to display the Pays 

Summary window.

Note that you cannot edit a past processed pay unless the Edit This 
Pay check box has been selected.

2 Click to select the employee you wish to edit pay for.  The Employee 
Pay Method box shows the pay method how the employee is paid. 

3 Choose Activities>Edit Pay(s).  The Normal Pay window displays pay 
details for the employee.

4 Enter or edit pay information on the normal pay tabs. Press F1 while 
the window is open for additional information on completing each 
section, or refer to the guide sections below:

Hours tab – Enter or edit the pay that the employee is eligible to 
receive this pay period, including leave payments. See page 58 for 
details.

Deduction tab – Enter or edit any deductions that will be taken from 
the employee's pay for this pay run.  Do not use deductions to record 
salary sacrifice—this should be done through the superannuation 
section. See page 60 for details.

Allowance tab – Enter or edit any allowances that are to be paid to the 
employee this pay run. See page 61 for details.

Sundry tab – Enter or edit any sundries or adjustments that are to be 
paid to the employee this pay run. See page 65 for details.

Commission/Bonus tab – Enter or edit any commissions or bonuses 
amounts that are to be paid to the employee this pay run. See page 68 
for details.

Super tab – Check that the superannuation details are correct for this 
pay. See page 70 for details.

5 Click OK to save the details ready for processing.

For detailed examples see the following:

 Preparing a pay with allowances and deductions on page 81

 Preparing a pay with Workers Compensation payments on page 84

 Preparing a pay with leave on page 85
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 Preparing a pay with commissions or bonus payments on page 87

For further examples, see the following sections in the Quicken Payroll 
Help (choose Search for Help On.. from the Help menu):

 Process a pay with leave – Normal Pay method 

 Process a pay with allowances and deductions – Normal Pay method

Hours tab (Normal and Spreadsheet methods)

Generally, this information should come from the Employee record – Pay 
Rates window (page 194). If you need to make any additions or 
adjustments that apply only to the current pay, you can make them here.

Pay Rate – Select the pay rate that is being used to pay the employee.  For 
leave to accrue correctly you need to include the Normal Hours pay rate, 
or a rate designated as a Normal Hour rate.  If you need a pay rate not on 
the list, type in the name and then press TAB. Click Setup on the Quick-Add 
window to add the rate to the Pay Rates list. 

If the employee is taking leave and is eligible for leave loading, select 
Annual Leave.  This is the only pay rate that Quicken Payroll will calculate 
the tax-free threshold for. If the employee is eligible for leave loading, the 
hourly amount will be grossed up by the leave loading percentage. 

Type – Select the pay rate type.  Use Hourly Rate for employees who 
receive a dollar amount for each hour they work. Use Salary for employees 
who are paid a fixed dollar amount for each pay period they work. 

 Selecting Hourly Rate lets you enter the rate per hour.

 Selecting Salary lets you enter the total gross wage for the pay period. 

Normal Hours pay rate

The term “Normal Hours” 
pay rate has a special 
meaning in Quicken 
Payroll. The “Normal 
Hours” rate for an 
employee is the base rate of 
pay that other rates (such 
as double time) are based 
on. It is also used in awards 
in calculating leave 
accruals.

G l o s s a r y T e r m
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Note that Annual Salary cannot be selected in the pay screen. It can 
only be selected in the award or employee record.  When a pay is 
prepared for the employee, Quicken Payroll calculates the pay for the 
current pay period based on the annual salary and inserts “Annual 
Salary” into the pay type column.

 Selecting Items lets you enter a pay based on other units. For example, 
you would select this to pay an employee for quantity of fruit picked.

Hours/Qty – Enter the number of hours or units that apply to this pay rate.  
You should enter the number of hours for salary and annual salary 
payments—this helps Quicken Payroll calculate the correct annual leave 
rate and correct leave accrual.

Amount – Enter the dollar amount per hour, pay period or item here.

Super – Select Yes if you want the pay rate to be included in 
superannuation calculations.  Select No if you want the pay rate to be 
excluded from superannuation calculations.

Customer:Job – You can specify that the pay rate should be billed to a 
particular customer or job. Select the customer and job from the drop-
down list, or type a new one in.

Class – If you want to assign this pay rate to a specific class, enter the class, 
or select the class from the drop-down list.  You can use classes to classify 
your payroll by department, business office or location, separate 
properties you own, or any other meaningful breakdown of your business.
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Deductions tab

Generally, this information should come from the Employee record – 
Deductions window (page 196). If you need to make any additions or 
adjustments that relate only to the current pay, you can make them here. 
If you want the details to be changed permanently, you must change them 
in the Employee record – Deductions window.

Deduction – Select the deduction to be taken from the employee's pay.  If 
the deduction name you need is not on the list, type in the name and then 
press TAB. Click Setup on the Quick-Add window to add the deduction to 
the Deductions list.  When you select an existing deduction, Quicken 
Payroll will automatically enter the defaults for the deduction.

Note Do not use deductions to record salary sacrifice—this should be 
done on the super tab.

ID – Enter the ID for this employee's deduction.  This makes it easier to 
identify the deduction for a particular employee on a report.

Amount – Enter the amount of the deduction.

Ex Tax – If the deduction is tax-deductible for the employee—to be 
deducted from gross wages before tax is calculated, select Yes in the Ex Tax 
column.  If it is not tax-deductible—to be removed from the net after tax is 
calculated, select No.

Union – If the deduction is for union dues, select Yes from the drop-down 
list.  Any contributions made using this deduction will appear in the Union 
Fees section of the employee’s Payment Summary.
60 CHAPTER 4 - Preparing and processing your payroll



Allowances tab

Generally, allowances should come from the Employee record – 
Allowances window (page 198). If you need to make any additions or 
adjustments that relate only to the current pay, you can make them here. 
If you want the details to be changed permanently, you must change them 
in the Employee record – Allowances window.

Notes If the allowance is Payroll Tax exempt or WorkCover exempt, you 
must set the exempt status though the Allowances list.

If you have an allowance that you pay both to contractors and to 
your normal staff, you will need to define two separate 
allowances—one for employees that displays the allowance on 
the Allowance section of the Payment Summary and another 
allowance for contractors the includes the allowance in the Gross 
section.

Allowance – Select the allowance to be added to the employee's pay.  If the 
allowance name you need is not on the list, type in the name and then 
press TAB. Click Setup on the Quick-Add window to add the allowance to 
the Allowances list.  When you select an existing allowance, Quicken 
Payroll will automatically enter the defaults for the allowance.

% or Units – If the allowance is a percentage of a pay rate, enter the 
percentage amount.  If the allowance is per pay period, enter the number 
of pay periods that are being paid.  If the allowance is for an item, such as 
kilometres, enter the number of kilometres.

Based On – Select what the allowance is a percentage of from the drop-
down list.   For example, if you select Wages, the allowance dollar value will 
be a percentage of the total wages for that particular pay. 
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Amount – Enter the amount of the allowance.  If the allowance is per pay 
period, just enter the amount for one pay period—Quicken Payroll will 
calculate the total allowance amount to pay.

Super – Select Yes if you want the allowance to be included in 
superannuation calculations.  Select No to exclude the allowance from 
superannuation calculations.

Ex Tax – If the allowance is non-taxable— to be added to the net after tax is 
calculated, select Yes in the Ex-Tax column.  If it is taxable—to be added to 
the gross before tax has been calculated, select No. See page 199 for details 
on the tax treatment of allowance.

Customer:Job – The allowance can be assigned to a particular customer or 
job.  Customer:jobs can be used to identify employee costs by job or to 
assign employee labour to a client.  If no customer:job have been set up yet, 
enter a customer:job name.  When you are prompted to add the 
customer:job to your lists, click Yes.

Classes – The allowance rate can be assigned to a specific class.  Enter the 
class, or select the class from the drop-down list.  You can use classes to 
classify your payroll by department, business office or location, separate 
properties you own, or any other meaningful breakdown of your business.

How do I pay an allowance based on the 
number of hours worked?
To pay an allowance based on hours worked, you need to associate the 
allowance with a specific pay rate in the Allowances tab of the employee 
record, or in the pay details window when you process the pay.

1 Select the employee from the Employee list and then click Edit (or 
double click on the employee name).

2 From the Employee record, select the Allowances tab. By entering the 
amounts in the employee record, the allowance will be calculated for 
each pay. 
To enter an allowance for a single pay, enter the amounts through the 
Allowance tab of the pay details window (see page 61).

3 In the % or Units column, enter 0 (zero).
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4 In the Based on column, select the pay rate that the allowance will be 
based on.  

5 In the Amount column, enter the hourly rate for that allowance.

6 When you pay the employee, you only need to enter the hours for 
each pay rate. You do not need to enter anything in the allowance 
section.  The allowance will be calculated as the hourly rate you 
entered in the Amount column, times the number of hours worked for 
the associated pay rate.

Example 

Lyall is a casual employee who is paid an allowance of $5 per hour for each 
normal hour worked, plus an allowance of $7 for each overtime hour.  In 
the employee record, these amounts are entered onto the Allowances tab:

Entering 0 in the % or Units column will result in the allowance being 
calculated as the number of Normal hours times $5 plus the number of 
overtime hours times $7.

When Lyall's pay is processed, enter the hours on the Hours tab of the Pay 
Details window.  The allowances are calculated automatically—there is no 
need to enter any amounts on the Allowance tab.  The allowance is 
calculated as 40 X $5 plus 20 X $7 = $340.
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If you look on the allowance tab, you will notice that the amounts from the 
employee record carry forward automatically. You don't need to enter 
anything here, unless you are entering an allowance that applies just to 
this pay.

How do I determine where an allowance 
is reported on Payment Summaries?
Where an allowance is shown on a Payment Summary is determined by 
the settings on the allowance, through the Allowances list.

1 Choose Allowances from the Lists menu.

2 Select the allowance you wish to add to the Allowance Section and 
then click Edit.

3 From the drop-down list, select where the allowance amount is to be 
displayed in Payment Summaries—in the Gross wage section, the 
Allowance section, or not displayed at all.
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Sundries tab

Sundry items include non-recurring adjustments, back pay and expense 
reimbursements that apply to a single pay. Unlike deductions, a sundry 
item cannot be added to the Employee record, because they only apply to 
a single pay.  A sundry item must be added through the Pay Details – 
Sundries window when the pay is being processed.

If you have a sundry item that you want to be paid automatically with each 
pay, it must be set up on the Pay Rates, Deductions, or Allowances window 
of the Employee record.

Sundries and Adjustments – Select the sundry item to be taken from the 
employee's pay. Quicken Payroll includes the following preset sundry 
items:

 Reimburse Expense – Select Reimburse Expense for items that include 
GST. To pay a sundry that does not include GST, either create a new 
sundry item of the Normal Sundry sundry type, or else just override the 
GST amount. See the Sundries List on page 256 for details.

 Back Pay <= to 12mths – Select this for back payments of salary or 
wages that accrued twelve months or less ago. This amount will be 
included as part of Gross on the employee's Payment Summary.

 Back Pay > 12mths –  Select this for back payments of salary or wages 
that accrued more than twelve months ago.  This amount will be 
included  in Lump Sum E on the employee's Payment Summary. 

Quicken Payroll 
automatically calculates 
GST for sundries of the 
sundry type “Reimburse 
Expense”.
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 Invoice with ABN and Invoice without ABN – If you are paying an 
invoice and you are exporting your payroll data to QuickBooks, select 
one of these options. This will result in the payment being reflected in 
one of the “G” (acquisition) fields in the Activity Statement produced 
through QuickBooks. 

Payments entered through the Hours tab will be included in the “W1” 
(wages) field on the QuickBooks Activity statement.

To create a new sundry type, enter the name and then press TAB. Click 
Setup on the Quick-Add window to add the item to the Sundries List. 

Amount – Enter the amount of the sundry or adjustment. Enter sundry 
deductions as a negative ( – ) amount. Enter the amount including GST, if 
applicable. For example, on a $11 expense, including $1 GST, enter $11. 
Note that GST is only calculated for sundries of the Reimburse Expense 
Item type.

GST Amount – Quicken Payroll calculates the GST amount based on the 
sundry type and the amount entered in the Amount column. Edit the 
amount if necessary.

Super – Select Yes if you want the sundry or adjustment to be included in 
superannuation calculations.  Select No if you want the sundry or 
adjustment to be excluded from superannuation calculations.

Ex Tax – If the sundry or adjustment is non-taxable—to be added to the net 
after tax is calculated, select Yes in the Ex Tax column.  If it is taxable—to be 
added to the gross before tax has been calculated, select No.

Calculating tax on back pay: Due to the complexity and number of 
factors to consider when paying back pay, Quicken Payroll does not 
calculate the tax on back pay. For a pay that includes back pay, you must:

1 Write down the tax amount before back pay is calculated. 

2 Manually calculate the tax on the back-pay as per ATO instructions.

3 In the Pay Totals section, click on the Tax box and then add the back 
pay tax to the calculated tax amount, using the Q-Calc window.
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Customer:Job – The sundry item can be assigned to a customer or job.  
Customer:jobs can be used to identify employee costs by job or to assign 
employee labour to a client.  If no customer:jobs have been set up yet, enter 
a customer:job name.  When you are prompted to add the customer:job to 
your lists, click Yes.

Classes – The sundry item can be assigned to a specific class.  Enter the 
class, or select the class from the drop-down list.  You can use classes to 
classify your payroll by department, business office or location, separate 
properties you own, or any other meaningful breakdown of your business.

Expense Reimbursements
Select the Reimburse Expense to reimburse an employee for purchases made 
on behalf of the company such as lunch room or office supplies. For 
allowances such as meal, tool or mileage allowances, record the payment 
on the Allowances tab.

Selecting the correct reimbursement sundry item will ensure that GST is 
tracked correctly in the Business Activity Summary and when you export 
your payroll data to QuickBooks.

If the employee is claiming a reimbursement for purchasing goods over 
$50, the employee should provide you with an invoice or receipt that 
shows the GST paid. This documentation is required so that you can claim 
an input credit on the reimbursement.  You must have an Australian 
Business Number (ABN) in order to claim GST input credits on 
reimbursements.
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Commission/Bonus tab

Unlike deductions or allowances, commissions and bonuses must be 
entered here for each pay—they cannot be entered on the Employee 
record to be automatically entered with each pay. This is because bonuses 
are typically paid on an infrequent basis and commissions details must be 
entered for each commission payment.

Commission – Enter the commission or bonus name or select it from the 
drop-down list.  If the commission name you need is not on the list, type 
in the name and then press TAB.  When you are prompted, click Yes to add 
it to your drop-down list. 

Gross – Enter the total gross sales for the employee.  This field is optional.

% Comm – Enter the percentage amount that the employee receives from 
their gross sales. For example, to enter 6%, enter 6.  This field is optional.

Net – Quicken Payroll calculates the net amount based on the amounts in 
the Gross and % Comm columns. 

Period – Select the period that the commission is being paid for. 
For example, if you are paying a commission for a month, select monthly. 
That way, Quicken Payroll will calculate the correct amount of tax on the 
commission.

Super – Select Yes if you want the commission to be included in 
superannuation calculations.  Select No if you want the commission to be 
excluded from superannuation calculations.

Ex Tax – If the commission or bonus is non-taxable—to be added to the net 
after tax is calculated, select Yes in the Ex Tax column.  If it is taxable—to be 
added to the gross before tax has been calculated, select No.

Bonus

A bonus is a payment 
typically made to an 
employee as a means of 
recognition of 
performance. They are not 
necessarily in respect of a 
particular period of 
employment.

G l o s s a r y T e r m
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How is tax calculated on bonuses and 
commissions?
If a bonus or commission is paid in relation to a single period of one week 
to one month, the amount is added to any other salary or wages for that 
period and PAYG is calculated along with the other salary or wages.

If the bonus or commission relates to a period in excess of one pay period, 
or is paid on an irregular basis, PAYG is calculated as follows:

1 The bonus or commission is divided by the number of pay periods to 
which it relates.

2 That amount is added to the normal salary or wages for a single pay 
period.

3 PAYG on the combined amount is calculated.

4 The amount of tax payable from normal pay for one period is 
subtracted from the combined amount.

5 The result (which represents the PAYG amount on the bonus portion) 
is multiplied by the number of pay periods to which the bonus or 
commission related.
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Superannuation tab

Generally, this information comes from the Employee record – 
Superannuation window (page 202). If you need to make any additions or 
adjustments that relate only to the current pay, you can make them here. 
If you want the details to be changed permanently, you must change them 
in the Employee record – Superannuation window.

Type – Select the type of superannuation payment to be made. For a 
description of payment types, see Superannuation details on page 202.

Fund Name – Select the superannuation fund that the contribution will be 
made to. When you select an existing superannuation, Quicken Payroll 
will automatically enter the defaults for the superannuation.
If the fund name you need is not on the list, you can type in the name and 
then press TAB.  When you are prompted, click Yes to add it to your 
superannuation list.  However, generally, superannuation funds should be 
set up in company information before you pay an employee.

Member A/C – Enter the employee's ID number for the superannuation 
fund you have selected.

Joined – Enter the date the employee joined the fund.  This is usually the 
day they joined the company.

Amount – Enter the amount of superannuation to be paid to the fund. 
Generally, most employers will use the dollar amount when they want to 
manually enter the superannuation.
Most employees are entitled to Employer SGC of 9%.

% $ – If the amount is a percentage, select (%).  If the amount is a dollar 
value, select ($).

Amt Paid – Quicken Payroll will calculate the amount of superannuation 
to be paid and then enter the dollar value here.
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The Timesheet Entry window  
The Timesheet Entry window lets you enter the start and finish times for 
each day the employee works. Quicken Payroll will calculate any breaks as 
well as the different rates (such as overtime rates) that apply between the 
times that you enter.

Use the timesheet method if you have employees that are paid according 
the time they start and finish a work shift. 

Allowances, deductions and most other pay details will come direct from 
the employee record. When you prepare the employee’s pay, you will also 
need to enter any leave taken, sundry items, commissions or bonuses for 
the current pay period. 

The Timesheet Entry window is identical to the Normal entry window, 
except that, instead of an Hours tab, there is a Timesheet tab where you 
calculate the hours and a Leave tab where you enter leave details.

To use the Timesheet feature, you must first do the 
following
1 Create an award that includes a classification with an hourly rate and 

define the shifts that employees under that award work. 

You will only be able to record hours worked during shifts that have 
been defined in the award. See Awards – Timesheet Payments tab on 
page 225 for details.

When paying the employee 
for leave, enter details on the 
Leave Taken tab and enter the 
periods covered by the 
payment.
You only need to enter the 
start and finish times. 
Quicken Payroll applies pay 
rates to the shift based on the 
award selected for each line. 
Note that you can only record 
hours worked during shifts 
that have been defined in the 
award.
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If you selected the  Use Award Pay Rates check box in the employee 
record – Pay Rates window, the rate used will be the award rate that 
corresponds to the employee’s classification and award. 
If you did not select the  Use Award Pay Rates check box in the 
employee record – Pay Rates window, the rate used will be the rate set 
up in the Pay Rates window.

2 Select the Timesheet as the method of paying the employee in the 
employee record– Personal Details window and

3 Select a award and a classification in the employee record – Company 
Details section.

Pay Periods 
This represents the number of pay periods that this payment covers. 
Generally, you should leave this field at “1”. If you enter a number greater 
than one, the PAYG will be calculated accordingly and the employee will 
be excluded from some future pay runs.

For example, if an employee normally paid weekly, is going on annual 
leave for three weeks and you want to pay the entire three weeks in 
advance in addition to the current pay, enter “4”. PAYG will be 
calculated based on the pay covering a four week period. The 
employee will then be automatically excluded from the next three pay 
runs.

If change the number of pay periods, you may also need to change the 
allowances and deductions to account for the fact that the payment covers 
multiple pay periods. For example, if you make a pay covering more than 
one pay period for an employee with child support deductions, you will 
have to increase the child support deduction accordingly.

Pay Totals 
The Pay Totals section displays most of the pay totals for the current pay 
run. Click on any of these fields to display a Q-Zoom report showing how 
the amount was calculated.
72 CHAPTER 4 - Preparing and processing your payroll



Data entry section 
Pay details such as deductions, allowances, superannuation details and 
normal hours from the employee record.  You can edit these details for this 
pay in the pay details window, but if you want the details to be changed 
permanently, you must change them in the Employees record.

Leave taken, sundry items, commissions and bonuses, on the other hand, 
can only be entered through the Pay Details window—they cannot be set 
up in the Employees record.

On each tab, to add a new line, click Insert, or TAB to a new line.  To delete 
a line, select the line, click Delete and then confirm that you actually want 
to delete the line. 

Manual tax
If you adjust the tax manually, Quicken Payroll will place a check mark  
in the Manual Tax  check box at the bottom of the window. To revert to the 
calculated amount, click to remove the check mark from the Manual Tax 
check box.

Preparing a Timesheet pay
1 Choose Prepare Pays from the Activities menu or Pay Run on the 

toolbar to display the Pays Summary window.

2 Click to select the employee you wish to enter timesheet hours for.  The 
Employee Pay Method box shows the pay method how the employee 
is paid. 

3 Choose Activities>Edit Pay(s).  The Timesheet Entry window displays 
pay details for the employee.  The Timesheet Pay Details window is 
the same as the Normal Pay Details window, except that instead of an 
Hours tab, it has a Timesheet and a Leave Taken tab.

4 If necessary, make any adjustments to deductions, allowances, 
sundries, commissions, or superannuation. Press F1 while the 
window is open for additional information on completing each 
section, or refer to the guide sections below:
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Timesheet tab – select the award(s) the employee is to be paid under.   
An employee can be paid under different awards, the only restriction 
is that each award used must have the same classifications.
Enter the shift starting and ending date and time. Quicken Payroll will 
calculate the hours worked and the wages to be paid. See page 75 for 
details.

Note  You will only be able to record hours worked during shifts that 
have been defined in the award. For example, if the award has 
only defined shift that occur on weekdays, you will not be able to 
enter an time worked on a weekend.

Leave Taken tab – enter details of any leave taken. See page 76.

Deduction tab – Enter or edit any deductions that will be taken from 
the employee's pay for this pay run.  Do not use deductions to record 
salary sacrifice—this should be done through the superannuation 
section. See page 60 for details.

Allowance tab – Enter or edit any allowances that are to be paid to the 
employee this pay run. See page 61 for details.

Sundry tab – Enter or edit any sundries that are to be paid to the 
employee this pay run. See page 65 for details.

Commission/Bonus tab – Enter or edit any commissions or bonuses 
amounts that are to be paid to the employee this pay run. See page 68.

5 Click OK to save the details ready for processing.

6 When all employee pay details are completed, choose 
Activities>Process Pays to open the Process Pays window.

For detailed examples see the following:

 Preparing a pay with allowances and deductions on page 81

 Preparing a pay with Workers Compensation payments on page 84

 Preparing a pay with leave on page 85

 Preparing a pay with commissions or bonus payments on page 87

For further examples, see the following sections in the Quicken Payroll 
Help (choose Search for Help On.. from the Help menu):

 Process a pay with allowances and deductions – Timesheet Pay method 

 Process a pay with leave – Timesheet Pay method 
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Timesheet tab (Timesheet method only)

Award – Select the award the employee is to be paid under.   An employee 
can be paid under different awards; the only restriction is that each award 
used must include the employee’s classification. This is because you can 
only select one classification for an employee. 

Shift Starting Date and Time – You can either enter the date directly, or 
click on the drop-down list arrow to bring up the Q-Date window. Time can 
be entered in 24 hour format, or in 12 hour format using A or P to specify 
am or pm.

Note You will only be able to record hours worked during shifts that 
have been defined in the award. For example, if the award has 
only defined shift that occur on weekdays, you will not be able to 
enter an time worked on a weekend.

If you have entered an unpaid break, such as a meal break, you only need 
to enter the start and end time. Quicken Payroll will automatically 
calculate the unpaid period. For details, see Setting up an unpaid break on 
page 227.

Shift Ending Date and Time – Enter the ending date and time.  Once you 
have entered this information, Quicken Payroll will calculate the hours for 
each period of the day as specified in the award and pay the employee 
accordingly.

Customer:Job and Class – You can assign the wages to a particular 
customer:job or to a class.

For employees paid under the timesheet method, you need to set up which 
shifts are subject to superannuation and if overtime payments are subject 
to superannuation. This is done through in the award. For details see 
Timesheet Payments tab on page 225.
The Timesheet Entry window 75



Leave taken tab (Timesheet method only)

Leave Type – Select the type of leave being paid. If the employee is taking 
leave and is eligible for leave loading, select Annual Leave.  This is the only 
pay rate that Quicken Payroll will calculate the tax-free threshold for.

Pay Rate – Click on the drop-down list arrow to select the leave type.  The 
leave types are set up on the Pay Rates window.

If you are also paying the employee normal pay – for example a bi-weekly 
employee taking just one week leave, click Insert to add an additional line.

Type – Click the drop-down list arrow and select Hourly Rate.  Note that 
Leave Loading and the $320 tax-free threshold is ONLY calculated when 
the Annual Leave pay rate is used to record leave. 

Hrs/Qty – Enter the number of hours of leave taken.  If the employee does 
not have enough leave you will be warned. If you wish to pay them the full 
hours click OK.

Press TAB after entering the hours.  The Leave Taken window is displayed.  
You will be prompted to enter the date the leave will start and the date the 
leave will finish.  On both fields, you can right mouse click and enter the 
dates using the Q-Date Calendar window. 

Amount – Adjust the hourly amount if necessary. 

If the employee is eligible for leave loading, the hourly amount will be 
grossed up by the leave loading percentage. For example, if the normal 
hourly rate is $10 per hour and the employee is eligible for 17.5% leave 
loading, Quicken Payroll will enter $11.75 ($10 + 17.5%) in the amount 
column. 

Leave Loading and the $320 tax-free threshold is ONLY calculated when 
the Annual Leave pay rate is used to record leave.  For further details, see 
Leave Loading on page 207.
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Paying a timesheet employee using multiple pay rates and 
multiple awards

When you are preparing a timesheet pay, you may want to pay an 
employee under more than one award or with more than one pay rate. For 
example a builder may have an employee that does brickwork one day and 
general carpentry on another day. To use more than one pay rate, you must 
use multiple awards. To set up multiple awards:

1 Set up each award with the appropriate pay rates and other pay 
details. Note that each award used must include the classification that 
the employee works under.

2 In the employee record, select Timesheet Method from the Personal 
tab and then on the Pay Rates tab, select Use Award Pay Rates.

Each award used must 
include the classification 
that the employee is 
working under.
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The Spreadsheet Entry window  
The Spreadsheet Entry window allows you to enter the hours for a large 
number of employees on one easy-to-use spreadsheet-style window. 

Use this method if you have a lot of employees whose hours vary each 
period, such as casual employees. 

The employee’s pay rates, allowances, deductions and most other pay 
details will come direct from the employee record. When you prepare the 
employee’s pay, you will also need to enter any leave taken, sundry items, 
commissions or bonuses for the current pay period.

To use the spreadsheet feature, you must select the Spreadsheet as the 
method of paying the employee in the Employee record- Personal Details 
section.

Entering or editing a Spreadsheet Entry pay 
1 Choose Prepare Pays from the Activities menu to display the Pays 

Summary window.

2 Click to select the employee.  The Employee Pay Method box shows 
the pay method how the employee is paid.  The following instructions 
apply to employees paid using the Spreadsheet Pay Method. 

Choose Activities>Edit Pay(s).  The Spreadsheet entry window 
displays spreadsheet details for all employees paid using the 
spreadsheet method. 

The Employee Pay Summary at 
the top displays results for the 
selected employee. 
Enter the pay hours in the 
appropriate columns for each 
employee.
To enter hours for a pay rate not 
on the screen or to enter other 
pay details such as deductions, 
allowances, etc, click on the 
Details column.
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3 Enter the pay hours in the appropriate columns for each employee.  
You can enter hours by clicking on a field and typing in the number, 
or right clicking to bring up the Quicken Payroll Calculator.  You can 
also move through the screen using the keyboard arrow or tab keys.

The easiest way to enter amounts is by pressing TAB after each entry, 
or by using the keyboard arrow keys to move around.
If you need to enter hours for a pay rate that is not displayed on the 
spreadsheet, you can either add a new pay rate to the spreadsheet, or 
you can add the hours for that pay rate through the details column.

To enter hours for a pay rate not on the screen, click on the Details 
column and then either press the Enter key or click on the drop-
down list arrow.  Be sure to check which employee you are entering 
the details for.  Doing this will display the Normal Pay window, where 
you can add additional hours, as well as edit other details such as 
allowances, deductions, adjustments, sundry items, commissions or 
bonuses, or superannuation.

To add a pay rate to the Spreadsheet Entry window:

i) Right mouse click anywhere on the Spreadsheet entry window. A 
list of pay rates is displayed.  Pay rates currently on the 
spreadsheet entry window are indicated with a check mark.

ii) Click on pay rate you want to add.  The pay rate is added;  you 
may have to scroll to the right to see it.

iii) If you click on a pay rate that has a chicanery, the pay rate will be 
deleted from the Spreadsheet Entry window.

4 To enter leave, allowances, deductions, adjustments, sundry items, 
bonuses, commissions, or superannuation, click the Details column 
and then either press the Enter key or click on the drop-down list 
arrow.  Doing this will display a normal pay window, where you can 
edit or enter all of these details. 

Press F1 while the window is open for additional information on 
completing each section, or refer to the guide sections below:

Hours tab – The hours tab now includes the hours entered 
through the Spreadsheet Entry window. Enter details for any 
leave taken. See page 58 for details.

Deduction tab – Enter or edit any deductions that will be taken 
from the employee's pay for this pay run. See page 60 for details.
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Allowance tab – Enter or edit any allowances that are to be paid 
to the employee this pay run. See page 61 for details.

Sundry tab – Enter or edit any sundries that are to be paid to the 
employee this pay run. See page 65 for details.

Commission/Bonus tab – Enter or edit any commissions or 
bonuses amounts that are to be paid to the employee this pay 
run. See page 68 for details.

Super tab – Check that the superannuation details are correct for 
this pay. See page 70 for details.

5 Make any changes required and then click OK.  The Spreadsheet Entry 
window is displayed.

6 When you have entered hours for all employees that you want to 
process pay for using the spreadsheet method, click Close to save the 
details for processing.  The Pays Summary window is displayed.

7 When all employee pay details are completed, choose 
Activities>Process Pays to open the Process Pays window.

For detailed examples see the following:

 Preparing a pay with allowances and deductions on page 81

 Preparing a pay with Workers Compensation payments on page 84

 Preparing a pay with leave on page 85

 Preparing a pay with commissions or bonus payments on page 87

For further examples, see the following sections in the Quicken Payroll 
Help (choose Search for Help On.. from the Help menu):

 Process a pay with leave – Spreadsheet method

 Process a pay with allowances and deductions – Spreadsheet method 
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Examples of common payroll situations
The main difference between the Normal, Timesheet and Spreadsheet 
methods is how employee hours are entered. In all three methods, the 
process of entering allowances, deductions, compensation, sundry items, 
commission/bonuses and superannuation is the same. Entering leave 
taken is virtually the same, except that under the timesheet method, leave 
taken is entered on a separate Leave tab, instead of on the Hours tab.

The following sections explain in more detail how to process a pay with:

Preparing a pay with allowances and deductions
In most cases, allowances and deductions are set up in the employee 
record and don't change from pay period to pay period.  However, 
sometimes you may need to adjust or add an allowance or deduction for 
just one pay.  In these cases, the best way is to adjust the allowances or 
deductions when you are preparing the pay.

1 Choose Prepare Pays from the Activities menu or Pay Run on the 
toolbar to display the Pays Summary window.

2 To enter or modify the employee’s pay, click to select the employee 
and then choose Activities>Edit Pay(s).  The Employee Pay Method 
box shows the pay method how the employee is paid.  Edit pay details 
on the Pay window.  For further information on entering hours and 
making modifications, see one of the following:

The Normal Pay window on page 55

The Timesheet Entry window on page 71

The Spreadsheet Entry window on page 78

If the employee is paid using the Spreadsheet method, the 
Spreadsheet Entry window is displayed.  Click the drop-down list 
arrow in the Details column to display the Pay Details window.

 Allowances and deductions 
– page 81

 Workers Compensation – page 84

 Leave – page 85  Commission or bonus – page 87
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3 If the pay covers more than one pay period, enter the number of pay 
periods in the Pay Periods box.
For example, if you are paying an employee four weeks annual leave 
in advance, enter 4.

4 Click on the Deduction tab and then enter or edit any deductions that 
will be taken from the employee's pay for this pay run.  

Do not use deductions to record salary sacrifice—this is done through 
the superannuation section.

Deduction – Select the deduction to be taken from the employee's 
pay.  If a deduction name you need is not on the list, type in the name 
and then press TAB. Click Setup on the Quick-Add window to add the 
deduction to the Deductions list.  When you select an existing 
deduction, Quicken Payroll will automatically enter the defaults for 
the deduction.

ID – Enter the ID for this employee's deduction.  By entering an ID, it 
becomes easier to identify the deduction for a particular employee on 
a report.

Amount – Enter the amount of the deduction.

Ex Tax – If the deduction is tax-deductible for the employee—to be 
deducted from gross wages before tax is calculated, select Yes in the 
Ex Tax column.  If it is not tax-deductible—to be removed from the 
net after tax is calculated, select No. Most deductions are not tax-
deductible.

To add a new line, click Insert, or TAB to a new line.  Enter details as 
per the above.  To delete a line, select the line and then click Delete.  
Click OK to confirm that you actually want to delete the line. 

5 Click on the Allowance tab and then enter or edit any allowances that 
are to be paid to the employee this pay run.

Allowance – Select allowance to be added to the employee's pay.  If 
the allowance name you need is not on the list, type in the name and 
then press TAB. Click Setup on the Quick-Add window to add the 
allowance to the Allowances list.  When you select an existing 
allowance, Quicken Payroll will automatically enter the defaults for 
the allowance.
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% or Units – If the allowance is a percentage of a pay rate, enter the 
percentage amount.  If the allowance is per pay period, enter the 
number of pay periods that are being paid.  If the allowance is for an 
item, such as kilometres, enter the number of kilometres.

Based On – Select what the allowance is a percentage of from the 
drop-down list.   For example, if you select Wages, the allowance 
dollar value will be a percentage of the total wages for that pay. 

Amount – Enter the amount of the allowance.  If the allowance is per 
pay period, just enter the amount for one pay period—Quicken 
Payroll will calculate the total allowance amount to pay.

Super – Select Yes if you want the allowance to be included in 
superannuation calculations.  Select No to exclude the allowance 
from superannuation calculations.

Ex Tax – If the allowance is non-taxable—to be added to the net after 
tax is calculated, select Yes in the Ex-Tax column.  If it is taxable—to be 
added to the gross before tax has been calculated, select No.

Customer:Job – The allowance can be assigned to a customer:job.

Classes – The allowance rate can be assigned to a specific class.  Enter 
the class, or select the class from the drop-down list. 

To add a new line, click Insert, or TAB to a new line.  Enter details as 
per the above.  To delete a line, select the line and then click Delete.  
Click OK to confirm that you actually want to delete the line. 

6 Manual tax – If you adjust the tax manually, Quicken Payroll will place 
a check mark  in the Manual Tax  check box at the bottom of the 
window. To revert to the calculated amount, click to remove the check 
mark from the Manual Tax check box.

7 Enter or modify other pay details if required and then click OK.

8 When you have made any modifications required, the next step is to 
Process the Pays.  Choose Activities>Process Pays to open the Process 
Pays window.

For more detailed examples, see the following sections in the Quicken 
Payroll Help (choose Search for Help On.. from the Help menu):

 Process a pay with allowances and deductions – Normal Pay method 

 Process a pay with allowances and deductions – Spreadsheet method 

 Process a pay with allowances and deductions – Timesheet Pay method 
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Preparing a pay with Workers Compensation  payments
Rather than enter Workers Compensation or WorkCover (SA and QLD) 
through the Lists menu, you can enter a claim and then just process the 
pay.  By using the Compensation rate you can have Quicken Payroll 
automatically record the details in the Workers Compensation window.

You can also enter compensation payments through the employee record 
or through the Workers Compensation list.

1 Choose Prepare Pays from the Activities menu to display the Pays 
Summary window.

2 Select the employee and then choose Activities>Edit Pay(s).  The Pay 
Details window displays pay details for the employee. 

If the employee is paid using the Spreadsheet method, the Spreadsheet 
Entry window is displayed.  Click the drop-down list arrow in the 
Details column to display the Pay Details window.

3 On the Hours tab, click Insert to insert a compensation payment line.

4 In the Pay Rate column, click the drop-down list arrow and then select 
Compensation.

5 In the Type column, click the drop-down list arrow and then select 
Items.

6 In the Amount column enter the amount of the payment.

7 In the Super column, click the drop-down list arrow and then select 
No.

8 Enter or modify other pay details if required and then click OK.

9 When you have made any modifications required, the next step is to 
Process the Pays.  Choose Activities>Process Pays to open the Process 
Pays window.

10 To enter a description of the injury, you will need to enter the details 
through the employee record.  This can be done before or after the pay 
is processed. To enter the description enter the details on the 
Compensation tab of the employee record. For details see page 208.
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Preparing a pay with leave  
Quicken Payroll tracks how much leave entitlement an employee accrues, 
how much leave has been taken and how much is remaining. In order to 
track leave properly, it is very important that you always record any leave 
taken correctly, using the correct leave pay rate. 

1 Choose Prepare Pays from the Activities menu to display the Pays 
Summary window.

2 Select the employee and then choose Activities>Edit Pay(s).  The Pay 
Details window displays pay details for the employee. 

If the employee is paid using the Spreadsheet method, the 
Spreadsheet Entry window is displayed.  Click the drop-down list 
arrow in the Details column to display the Pay Details window.

3 On the Hours tab (or the Leave Taken tab if you are using the 
Spreadsheet method), click the Pay Rate drop-down list arrow to 
select the leave type. 

If you click Insert to add a new line for leave and use the TAB key 
after you enter the number of leave hours, leave hours that are 
entered will be deducted from the first Normal hours pay rate line, so 
you don’t have to reduce the normal hours – Quicken Payroll will do 
that for you.

So for example, if an employee's normal hours are 40 per week and 
you want to record 8 hours of sick leave, click Insert to create a new 
line. When you enter the sick leave hours and press TAB, the 8 sick 
leave hours will automatically be deducted from the Normal Hours 
line, which will now show 32 hours.

If you are paying an employee in advance for annual leave and 
therefore the pay covers more than one pay period, make sure that 
you enter the number of periods covered into the Pay Periods box. 
This will ensure that tax is calculated correctly, factoring in the 
number of periods covered. Also note that if you are paying the 
employee for more than one period, you may need to adjust the 
employee’s deductions and allowances.

4 Select the pay rate type (hourly, salary, etc) from the Type list.

5 Enter the number of hours of leave taken in the Hrs/Qty column and 
then press TAB.
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If the employee does not have enough leave accrued, you will be 
warned. If you wish to pay them the full hours anyway, click OK.

6 After you press TAB, the normal hours are adjusted and the Leave 
Taken pop-up window is displayed.  You will be prompted to enter 
the date the leave will start and the date the leave will finish.  On both 
fields, you can right mouse click and enter the dates using the Q-Date 
Calendar window. 

7 In the Amount column, adjust the hourly amount if necessary. 

If the employee is eligible for leave loading, the hourly amount will 
be grossed up by the leave loading percentage.  For example, if the 
normal hourly rate is $10 per hour and the employee is eligible for 
17.5% leave loading, Quicken Payroll will enter $11.75 ($10 + 17.5%) 
in the amount column. 

Leave Loading and the tax-free threshold is ONLY calculated when 
the Annual Leave pay rate is used to record leave. For further details, 
see Leave Loading on page 207.

8 Manual tax – If you adjust the tax manually, Quicken Payroll will place 
a check mark  in the Manual Tax  check box at the bottom of the 
window. To revert to the calculated amount, click to remove the check 
mark from the Manual Tax check box.

9 Enter or modify other pay details if required and then click OK.

10 When you have made any modifications required, the next step is to 
Process the Pays.  Choose Activities>Process Pays to open the Process 
Pays window.

For more detailed examples, see the following sections in the Quicken 
Payroll Help (choose Search for Help On.. from the Help menu):

 Process a pay with leave – Normal Pay method 

 Process a pay with leave – Spreadsheet method

 Process a pay with leave – Timesheet Pay method 
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Preparing a pay with commissions or bonus payments
A bonus includes any lump sum payment made to an employee irregularly 
such as an annual bonus, gratuities, or back pay.  Commissions and 
bonuses must be entered correctly, in order that PAYG can be correctly 
calculated on this amount.

1 Choose Prepare Pays from the Activities menu or Pay Run on the 
toolbar to display the Pays Summary window.

2 Select the employee and then choose Activities>Edit Pay(s).  The Pay 
Details window displays pay details for the employee.

If the employee is paid using the Spreadsheet method, the 
Spreadsheet Entry window is displayed.  Click the drop-down list 
arrow in the Details column to display the Pay Details window.

3 Click the Commission/Bonus tab.  To add a commission or bonus, click 
on the first line and enter the details  

Commission – Enter the commission or bonus name, or select it from 
the drop-down list.  

If a commission or bonus name you need is not on the list, type in the 
name and then press TAB.  When you are prompted, click Yes to add 
it to your drop-down list. 

Gross – Enter the total gross sales for the employee.  This field is 
optional.

% Comm – Enter the percentage amount that the employee receives 
from their gross sale. 
For example, if you need to enter 6%, enter 6.  This field is optional.

Net – Quicken Payroll calculates the net amount based on the 
amounts in the Gross and %Comm columns. 

Period – Select the period that the commission or bonus is being paid 
for. For example, if you are paying a commission or bonus for a 
month, select monthly. That way, Quicken Payroll will calculate the 
correct amount of tax on the commission or bonus.

Super – Select Yes if you want the commission or bonus to be 
included in superannuation calculations.  Select No if you want the 
commission or bonus to be excluded from superannuation 
calculations.
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Ex Tax – If the commission or bonus is non-taxable—to be added to 
the net after tax is calculated, select Yes in the Ex Tax column.  If it is 
taxable—to be added to the gross before tax has been calculated, 
select No.

4 To add a new line, click Insert, or TAB to a new line.  Enter details as 
per the above.

5 To delete a line, select the line and then click Delete.  Click OK to 
confirm that you actually want to delete the line. 

6 Manual tax – If you adjust the tax manually, Quicken Payroll will place 
a check mark  in the Manual Tax  check box at the bottom of the 
window. To revert to the calculated amount, click to remove the check 
mark from the Manual Tax check box.

7 Enter or modify other pay details if required and then click OK.

8 When you have made any modifications required, the next step is to 
Process the Pays.  Choose Activities>Process Pays to open the Process 
Pays window.
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Processing the pays  
Once you have entered the pay details for each employee you can then 
process the pays.  The Process Pays window allows you to select which pay 
period to pay and then enter the pay dates. You can also restrict the pay to 
a single department or employee.

Processing the pays
1 Prepare the pay on the Pays Summary window. 

2 Choose Activities>Process Pays to open the Process Pays window.

3 On the Standard tab, select each pay period that you wish to pay.  
The employees will only be paid if the option for their pay period is 
pressed in.  If you do not use a particular pay period, the option for 
that pay period will not be available. 

Example If you do not have any fortnightly employees, you will not 
be able to select the fortnightly option.

Click on the Pay Dates tab 
to make sure that the Pay 
Date and Date Paid dates 
are correct. 

In this example, pays will 
only be processed for 
employees paid monthly.

Click on the Advanced 
tab if you want to just 
pay one employee or 
one department.
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4 On the Pay Dates tab, make sure that the Pay Date and Date Paid dates 
are correct. Quicken Payroll automatically advances the Pay Date and 
Date Paid when you process a payroll.  For example, when you 
process a weekly payroll, the Pay Date for Weekly will be advanced by 
seven days when you process the next pay.  Refer to the Pay Dates 
below for further information.

Pay Date – is the pay period ending date.  If necessary, change the 
pay dates to reflect the last day of the pay period that you are 
currently paying.

Date Paid – is the date that the payroll is processed and employees 
are paid.  Typically this will be the same as the pay date.  If necessary, 
change the Date Paid to the date that the employees were actually 
paid.

Preserve Employee Pay Dates – Selecting this allows individual 
employees to have different pay dates. The Pay Date entered will be 
overridden for individual employees. For example, if a weekly 
employee was last paid on 7 March, the employee’s next pay date will 
be 14 March no matter what pay date is entered on this window.

Quicken Payroll automatically 
advances pay dates each time you 
process pays. You should always 
check the dates to ensure that they 
are correct.
The Preserve Employee Pay 
Dates option allows individual 
employees to have different pay 
dates.
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5 If you want to pay only a specific department, or a specific employee, 
click the Advanced tab, otherwise continue to the next step.

Department – If you wish to pay only employees in a specific 
department and no other employees, click Selected, click the drop-
down list arrow and then select the department you want to pay.

Employee – If you wish to pay only one specific employee and no 
other employees, click Selected, click the drop-down list arrow and 
then select the employee you want to pay.

6 Choose Activities>Process Pays.  The pay is processed and then the 
Print Pay Reports window is displayed.

7 Click to select  the report(s) you want to print and then click Print 
Reports. If you want to print a report for a period other than the 
default period displayed, select the period from the drop-down list. 

If you don't want to print the reports right now, you don't have to.  You 
can select  Do not Print and then print the reports later.

Click here to process pays 
for a single department.

Click here to process pays 
only for the employee 
selected.

If you want to print a report 
for a period other than 
default period displayed, 
select the reporting period 
from the drop-down list.
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8 After the reports are printed, the Employees List is displayed and 
shows the pay date in the Last Paid column.  You can review individual 
pays by selecting the employee and then clicking Show Pays.

10 Now that your payroll has been processed, the final step is to make 
your payroll payments.  No matter how you pay your employees, 
Quicken Payroll makes it easier.

Pay dates
Payroll is very date dependent, therefore it is extremely important that the 
Pay Date and Date Paid dates are correct.

Quicken Payroll automatically advances the Pay Date and Date Paid when 
you process a payroll.  For example, when you process each type of payroll, 
the Pay Date for:

 Weekly will be advanced by 7 days when you process the next pay.

 Fortnightly will be advanced by 14 days when you process the next pay.

 Bi-monthly will be advanced by half of a month when you process the 
next pay.

 Monthly will be advanced by 1 month when you process the next pay.

If an employee has already been paid for the pay date entered, when you 
process the pays, you will get a message informing you that a pay has 
already been processed for the employee for this pay.   Click Yes to process 
a second pay for this employee for this pay date, or click No to exclude this 
employee from this pay date.

If you only pay one employee, Quicken Payroll will still move Pay Date 
ahead.  If you then need to pay additional employees under that Pay Date, 
you will have to adjust the dates when you process their pays.

If you select Preserve Employee 
Pay Dates on the Pay Dates tab, 
individual employees can have 
different pay dates. For 
example, if a weekly employee 
was last paid on 7 March, the 
employee’s next pay date will be 
14 March no matter what pay 
date is entered on this window.
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Making your payroll payments
Now that your payroll has been calculated, you need to pay your 
employees, the ATO, your Workers Compensation insurer and possibly 
your employee's superannuation funds.  Quicken Payroll makes these 
payments as easy as possible, by providing you with several options. You 
can make your payments through QuickBooks or Quicken, through 
electronic funds transfers (EFT), or you can use Quicken Payroll’s reports 
to provide the information you need to make your payments manually.

Making payments through QuickBooks or Quicken
For full and up-to-date information on making your PAYG withholding 
payments, contact the ATO or go to their website: http://www.ato.gov.au 
You should also obtain the “Guide to Pay as You Go” for Business, also 
available on their website. See Getting answers to your PAYG and tax questions 
on page 335 for ATP contact details.

If you use QuickBooks (v6 or later version) or Quicken to pay your 
employees, you can transfer your payroll data using the Quicken and 
QuickBooks export feature from the Activities>Export menu.  You can 
then use Quicken or QuickBooks to create cheque for payments to 
employees, superannuation fund, the ATO and any others.

For details, see Export Payroll Data to QuickBooks on page 279, Export Payroll 
Data to Quicken on page 282 and Exporting data to other software programs on 
page 283.
Making your payroll payments 93



Making payments manually using reports
If you prefer to make payments manually or you require payroll data to 
use with accounting software that doesn’t import Quicken Payroll data, 
use Quicken Payroll's reports to provide you with all of the information 
that you need.

The Banking reports (page 294) provide you with all the information you 
need to pay your employees, whether they are paid by cheque, cash or 
EFT. Each banking report shows the following details:

 - The employee's name and number

 - The employee’s bank details

 - The type of bank split (for example, Cash, Cheque or EFT)

 - The amount to be paid to cash, cheque or EFT

 The Cash Breakup report shows you how much to pay each employee, 
broken down by the number of each currency denomination required 
per employee.

 The Print Cheque report shows you each employee that is being paid an 
amount by cheque and the amount to pay them. 

 The Print EFT Direct Debit Report that shows you each employee that 
is being paid via a transfer to their bank account and the amount to 
pay them. 

 The Banking-Print All report combines all of the above information.  The 
cash transactions are shown first, followed by cheque transactions and 
finally by any EFT transactions. 

You can print Pay Slips (page 299) to can hand to your employees on pay 
day.  Depending on the pay slip preferences you have selected, you will get 
either 1, 2 or 3 pay slips per page. You can select from Plain, Classic or 
Graphics version of pay slips.

The PAYG Reports (page 300) provide the information you need to 
manually write a cheque for payment to the ATO.

The Super Report (page 306) shows you how much superannuation you 
have to pay to a particular superannuation fund and for which employees.
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The Deductions (page 297) report lists all of the deductions taken from 
employee's wages.

Payment Summary reports (page 300) print Payment Summaries, the 
Reconciliation Statement and ETP Payment Summaries. Depending on 
what you have set up in Preferences, the Payment Summaries will either 
print on the stationery provided by the ATO or on blank A4 paper.

Making payments by electronic funds transfer 
Paying your employees by electronic funds transfer (EFT) is the most 
convenient way to pay your employees. You don’t need to rush around on 
pay day to write cheques, stuff them in envelopes and then hand them out 
to employees. Not only can you pay your employees electronically, but 
you can also make your ATO and Superannuation payments electronically. 

To make an EFT payment you must create an EFT data file with Quicken 
Payroll and then transfer the file to your bank using software provided by 
your bank. Funds will then be transferred from your company bank 
account to your employees’ bank accounts, your superannuation funds’ 
bank accounts, or to the ATO.

Before you start
Before you can make electronic payments, you must set up your EFT 
preferences and EFT banking details.

 In General Preferences (see page 166) select  Enable Electronic Funds 
Transfer. 

 In Files Preferences (see page 176) select the Electronic Funds Transfer 
Options advised by your bank. Each bank uses a variation of the 
Australian Payments Clearing Association (APCA) specifications and 
only your bank will be able to tell you which of the four items are 
needed.

 Set up your company banking details on the Company Information 
window – Banking tab (see page 183).

 Set up employee banking details for each employee on the Employee 
record -Banking tab (see page 204). 

Electronic Funds 
Transfer (EFT)

A banking transaction that 
is done electronically, not 
requiring distribution of 
funds by cash or cheque. 
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 Set up superannuation fund banking details on the Superannuation 
Funds List(see page 254).

 ATO details are set up in the ATO Electronic Funds Transfer List (see 
page 234).

Paying your employees by Electronic Funds Transfer 
To create an EFT file that you can use with your banking 
software to pay your employees 
1 Set up your EFT preferences and your payroll account banking details. 

See Before you start on page 95 for details.

2 Set up each employee’s banking details.
For each employee, enter banking details on the Employee record -
Banking tab (see page 204). You can pay you employees by cash, 
cheque, EFT, or by any combination these methods. 

3 Create an EFT Export file
Choose Export>Payroll Data to EFT (For Banking) from the Activities 
menu. Create the file using the Export Payroll Data window.

In this example, 100% of the 
employee’s pay will be 
deposited by EFT. This 
would be the most common 
EFT situation, but you could 
also choose any combination 
of cash, cheque and EFT.

The EFT Date should be 
a current or future date. 
Using a date in the past 
usually results in 
transmission errors in 
your banking software.

Generally you shouldn’t need to 
change the EFT file name or location. 
However, if you do, just highlight it 
and type in the new name. Make sure 
the file name ends with an extension 
of “ABA”
If you want to change the export file 
location, click Browse, select the 
Drive and folder where you want to 
place the EFT file and then click OK.
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Click Export and then click Yes to confirm that you want to export the 
wages for the pay date specified. Quicken Payroll creates an EFT file 
that you can use with your bank’s EFT software to transfer wages 
from your company' payroll bank account to your employee's bank 
accounts. 

4 Send the EFT transfer file to your bank using your banking software
Open your banking software and transfer the QPExport.ABA file to 
your bank.

You may have to tell your bank software where the name and 
location of your payroll export file. You will find the name and 
location on the Export Payroll Data window (step 3 above).

Make sure that you are exporting an EFT with the most recent payroll 
data and not the file for a previous pay period. If you are not sure, 
then do the export again.

If your bank will not accept the EFT file you are sending, you probably 
need to change your EFT options in Files Preferences (see page 175). See 
Changing the EFT options if your bank will not accept the EFT file you are 
sending them (see page 100).

Paying the ATO by Electronic Funds Transfer
If you are using electronic funds transfers (EFT) to pay your employees, 
you will probably want to make your Australian Tax Office (ATO) 
payments electronically as well. Not only can you pay your PAYG, child 
support and other payroll related liabilities, but you can also use electronic 
funds transfers to pay items not tracked by Quicken Payroll, such as 
penalties, sales tax and company tax.

To create an EFT file that you can use with your banking 
software to make your ATO payments
1 Set up your EFT preferences and your payroll account banking 

details. See Before you start on page 95 for details.
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2 Create an EFT file for transferring the funds. 
To create an EFT transaction file click Create Tax Payments on the 
Navigator Tax Payments tab, or click Add on the Electronic Funds 
Transfer list, or. The ATO Electronic Funds Transfer window is displayed.

For detailed instructions on completing this window see the ATO 
Electronic Funds Transfer List on page 234.

When you have entered all of the details, click OK. Quicken Payroll 
creates a file in your C:\Program Files\QPRollv12\Data folder.

3 Send the EFT transfer file to your bank using your banking software
Open your banking software and transfer the ATO.ABA file to your 
bank. You may have to tell your bank software where the name and 
location of your payroll export file. You will find the name and location 
on the Export Payroll Data window (step 2 above).
If your bank won’t accept the EFT file you are sending, you probably 
need to change your EFT options in Files Preferences (see page 175). 
See Changing the EFT options if your bank will not accept the EFT file 
you are sending them on page 100.

Paying your superannuation funds by Electronic Funds 
Transfer

Choosing Export Super Contributions from the Activities menu will 
display the Export Payroll Data window, allowing you to create two files 
for transferring superannuation contribution details to the relevant 
superannuation fund. It also creates a third file – an EFT file that you can 
use along with your banking software to pay the superannuation funds 
electronically.

Before transferring any data, be sure to speak with your fund manager to 
see if they support this method of transferring the payroll information. 

The EFT code identifies you 
as the payer and provides 
information about the 
payment you are making. 
You can obtain the EFT code 
from correspondence sent to 
you from the ATO. It is also 
located just above the barcode 
on your payment advice.
98 CHAPTER 4 - Preparing and processing your payroll



To create an EFT file that you can use with your banking 
software to make your super contribution payments
1 Set up your EFT preferences and your payroll account banking details. 

See Before you start on page 95 for details.

2 Set up each superannuation account’s banking details. 
For each superannuation fund, enter all banking details on the 
Superannuation Funds List (see page 254). 

3 Create the superannuation export files. 
Choose Export>Super Contributions from the Activities menu to 
display the Export Superannuation Data window. 

This will create two superannuation details files and an EFT file, by 
default named QPSuper.ABA to the C:\Program Files\QPRollv12\Data 
folder. If your superannuation funds are at different superannuation 
companies you will need to create a file for each individual fund. 

For further details, see Export Superannuation on page 285.

4 Send the EFT transfer file to your bank using your banking software
Open your banking software and transfer the QPSuper.ABA file to 
your bank. You may have to tell your bank software where the name 
and location of your payroll export file. You will find the name and 
location on the Export Payroll Data window.

If your bank will not accept the EFT file you are sending, you probably 
need to change your EFT options in Files Preferences (see page 175). See 
Changing the EFT options if your bank will not accept the EFT file you are 
sending them on page 100.

Export Super Contributions 
creates three separate EFT files:

Two EFT files for 
transferring your super 
details to the 
superannuation fund, and
An EFT file you can use 
with your banking software 
to pay your superannuation 
funds electronically.
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Changing the EFT options if your bank will not accept the 
EFT file you are sending them

Depending on which banking institution you use, you may need to turn 
certain fields within the EFT file on or off.  These options are found in the 
Files section of the Preferences window. 

The EFT Options allow you to specify what sections should or shouldn't be 
in the EFT file. Not all banks require all the sections in the EFT file.  It is up 
to you to contact your bank's data processing department and find out 
exactly what options you need enabled. 

For example, if your bank does not require a self balancing line you 
would clear the  Include Balance Record option.

If your bank is having trouble accepting your EFT file it is probably because 
either: 

 Their software does not require some of the options that by default 
appear in Quicken Payroll's EFT file.  You will need to modify your 
preferences and re-export the EFT file; or

 They do not conform to the Australian (APCA) standard. 

Quicken Payroll supports the full specification and therefore works with 
any banking institution. If you cannot obtain your bank's EFT 
requirements, you can make the EFT file comply with their requirements 
by: 

1 Have all the EFT options in your preferences turned on. 

2 Export the file and send it to the bank, or the bank’s transfer software. 

3 Get the bank to tell you what error message they received; the transfer 
software should provide you with the same messages. 
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4 Adjust the preferences according to the error messages you receive 
from your bank.

5 Re-export the EFT file and re-send it to the bank. 

6 If the EFT file now works fine, write the details down in the front of 
your User Guide.  If you still have problems, repeat steps 3 to 5 until 
the EFT file transfers without any problems. 

Depending on the software your bank has supplied you may receive 
messages that vary slightly to the ones above. You can find details 
regarding bank software requirements in the Product Support area on our 
web site – http://software.quicken.com.au 

If you receive the 
following message

EFT Transfer Option Solution 
(Preferences>Files)

Debit record not required  Clear Include Debit Total
Credit record not required  Clear Include Credit Total
Net record not required  Clear Include Net Total
Balance record not 
required 

 Clear Include Balance Record.

Debit record missing Select Include Debit Total.
Credit record missing  Select Include Credit Total 
Net record missing  Select Include Net Total
Balance record missing  Select Include Balance Record.
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Printing and submitting your Payment Summaries
Under the new tax system, Group Certificates have been replaced by 
Payment Summaries. The standard Group Certificate has been replaced by 
the Payment Summary – Individual Non-Business and the ETP Group 
Certificate has been replaced by the ETP Payment Summary. In addition, 
there are three new payment summaries to cover additional situations 
under which tax must be withheld:

 Payment Summary – Voluntary Agreement

 Payment Summary – Labour Hire and Other Specified Payments

 Payment Summary – Withholding where ABN not quoted

For full descriptions, see Payment Summaries on page 300.

Printing Payment summaries
Payment Summaries must be printed and given to employees by 14 July 
after the end of the financial year. This applies to continuing employees 
and any employees who have left your employment during the year. 
However, you must issue a Payment Summary to a terminating employee 
within 14 days: 

 After an eligible termination payment is made, or 

 Where a terminating employee requests in writing that you issue them 
with a Payment Summary. 

In addition, you can also issue interim Payment Summaries at any time of 
year (except during the last 21 days of June) for staff that are still employed. 
For example, employees may require Payment Summary details to 
complete their quarterly Activity Statement. 

Interim Payment Summaries must only include amounts for the relevant 
period and not include amounts that may have appeared on a previous 
interim Payment Summary. The year-end or termination Payment 
Summary will still include amounts for the entire year (or for the period of 
employment during the year).
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To print Payment Summaries
1 Before you can start, you must choose whether you want to print on 

plain paper or on ATO stationery. There are additional requirements 
if you choose to print on plain paper. See Printing on plain paper or ATO 
stationery on page 104 for details.

When you select the Stationery preference, the Payment Summary 
report will appear onscreen with the lines and boxes that appear on 
the actual form. These are displayed to make the form easier to 
understand, but they are not actually printed. Only the text will be 
printed.

2 Choose Payment Summaries from the Report menu and then the type 
of summary you want to print. The Report Writer opens the selected 
Payment Summary report.

The Payment Summary report will appear onscreen with the lines and 
boxes that appear on the actual form. These are displayed to make the 
form easier to understand, but they are not actually printed. Only the 
text will be printed if you selected Stationery in Print Preferences.

Select Print Individual Non-Business Payment Summary to print the 
summary to be used for most of your employees.

3 The default period is Last Financial Year. If you are 
printing a summary for any other period, select 
the period covered from the Dates drop-down list.
Select Custom if the period you need is not on the 
list. This will allow you to change the date range.

4 The default is to print Payment Summaries for all of your employees. 
If you don’t want to print summaries for all employees, select which 
employees you want to print summaries for from the Employees 
drop-down list. To choose a single employee or range of employees, 
select Custom.

5 Click on the Print icon to print the Payment Summaries. 

Payment Summaries 
consist of two parts

In addition to providing 
your employees with a 
Payment Summary, you 
must also provide a 
Payment Summary 
Explanation, which can be 
printed separately, or on 
the reverse side of the 
summary. See page 104 for 
details.

Selecting Custom from the 
Employees drop-down list 
allows you to select a range of 
employees to print Payment 
Summaries for.
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Note Payment Summaries consist of two parts, the front which 
contains all of the details for the employee and the back part 
which explains all of the sections on the payment summary. You 
must supply employees with both parts (see step 6, below).

6 To print the back explanation section, choose Payment Summaries, 
from the Reports menu and then choose Print Payment Summary 
Explanation. Check the number of copies to print and then click Print.

The Payment Summary Explanation forms consist of the details 
that are printed on the back of the Payment Summary forms 
provided by the ATO. You must provide your employees with 
these details when you give them their Payment Summaries.

You can print the payment explanations either as a separate 
sheet, or on the back of the summaries you printed in Step 5.

Printing on plain paper or ATO stationery
Payment Summaries can be printed either on plain paper or the stationery 
provided by the ATO. Your printing choice is selected in Printing 
Preferences (see page 171).

Plain paper printing is convenient because it saves you having to mess 
around lining up forms on a dot matrix printer. However, if you want to 
print on plain paper, you must lodge the ATO copy electronically. The ATO 
requires electronic filing when you print on plain paper. To file 
electronically, you must create an EmpDupe file, which contains the ATO 
copy of your Payment Summaries. You will also need to print out a 
Magnetic Media form, fill it in and send it to the ATO along with the 
EmpDupe file.

For details, see Creating an EmpDupe (EFT) file for the ATO and the 
Magnetic Media Information form on page 303.
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Filing your Payments Summaries electronically
If you print your Payment Summaries on plain paper, you will be required 
to lodge the ATO copy electronically at the end of the financial year. To do 
this, you must create a file called the EmpDupe file, which contains an 
electronic version of all of your Payment Summaries. The EmpDupe file is 
then sent to the ATO along with the Magnetic Media Information form.

To create the EmpDupe file
1 Choose Payment Summaries>Create EmpDupe File for ATO from 

the Reports menu to display the Create EmpDupe File for ATO window.

Year End – Enter the end of year date for the Payment Summaries that 
you are printing.

Contact Name – If the Contact Name is blank, enter the name of the 
payroll administrator or contact person. Quicken Payroll will 
automatically enter the contact name that has been entered through 
Files preferences.

Branch Number – If your business has more than one branch, enter 
the number of the branch you are filing for.

Destination – Do not change the destination file name.  This name is 
required by the ATO.  You can however change the drive where it is 
placed.  If you use the Navigator and leave the destination path as 
the default, you can use the Navigator Copy EmpDupe File to Disk 
icon to move the file to a floppy disk.

Example To place the file on the A drive, enter A:\Empdupe.

EmpDupe file

The EmpDupe file is the file 
used to file your Payment 
Summaries electronically. It 
contains a summary data 
that is sent to the ATO.
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2 Click on the Supplier Sending Disks tab and check that the company 
details are correct.  Quicken Payroll will automatically fill these in 
using the company information.

3 Click OK.  Quicken Payroll will create the EmpDupe file and prompt 
you to print out the Magnetic Media Information form.

4 Send this file and the Magnetic Media Information form (which can be 
printed from the Reports-Payment Summaries menu) to the tape 
processing department of the ATO.
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The PAYG withholding system
Pay As You Go (PAYG) is the single integrated system for paying and tax 
and other withholding amounts. There are four situations where with-
holding applies:

 Withholding PAYG for employees – This is PAYG amounts you 
withhold from each paycheque.

 Labour Hire Arrangements – Payments to a contract worker from a 
labour hire firm for work performed for a client of the labour hire firm.

 Voluntary Agreements – Contractors working under the old PPS 
system will have a choice of paying their own PAYG instalments, or 
entering into an agreement to have you to withhold tax from 
payments.

 ABN not quoted – Payments between two businesses where the 
business being paid does not quote an ABN on an invoice. In these 
cases, the payer must withhold an amount from the payment and 
submit it to the ATO.

How do I report my PAYG withholdings?

Payment Summaries
The PAYG that you withhold is reported on Payment Summaries. There are five 
types of payment summaries:

 Summary – Individual Non-Business

 ETP Payment Summary

 Payment Summary – Voluntary Agreement

 Payment Summary – Labour Hire and Other Specified Payments

 Payment Summary – Withholding where ABN not quoted

For full descriptions, see Payment Summaries on page 300. Also see Printing 
and submitting your Payment Summaries on page 102.
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Business Activity Summaries
PAYG and withholding amounts are reported and paid using a single form 
called the Business Activity Statement (if you are registered for GST) or an 
Instalment Activity Statement (if you are not registered for GST). 

To provide you with the information you need to complete the statement, 
Quicken Payroll will provides a Business Activity Summary Report which 
will provide you with the payroll withholding information you will need 
to complete your Business Activity Statement. If you export your payroll 
data to QuickBooks, the data required for your activity statement will be 
transferred to QuickBooks along with your other payroll data.

How do I make my PAYG payments?
Businesses will normally have four quarterly due dates for their activity 
statements and for making PAYG instalments. Large withholders with 
annual withholding obligations of more than $1 million withholdings have 
to remit within 6 - 9 days of making the withholdings.

It is very important that you make your payments to the ATO on time and 
that you pay the correct amount. You can be subject to penalties if you 
don't deduct the right amount of tax instalments from your employee's 
pays, or if you don't pay all the tax instalments to the ATO by the due date.

In order to avoid penalties, it is important that you know how often you 
must make your payments and when the payment deadlines are. If you 
aren’t sure, refer to the ATO website for further information, or contact the 
ATO directly. See Making your payroll payments on page 93 for details.
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Voluntary Agreements
Contractors previously working under the old PPS system will have a 
choice of paying their own PAYG instalments, or entering into an 
agreement to have you to withhold tax from payments, much in the same 
way as was done previously under the PPS system. 

To set up a contractor under a voluntary agreement, select Voluntary 
Agreement from the tax scale drop-down list on the Employee Record – 
Taxation tab.

The ATO will determine the tax rate, referred to as the Commissioner's 
Instalment Rate (CIR). Until the CIR is known you should deduct tax at the 
rate of 20%. Quicken Payroll includes several voluntary agreement tax 
rates, but if the rate you need is not set up, you can easily modify an 
existing rate or create a new tax rate through the Tax Scales list. For details 
see Tax Scales List on page 258.

Payments under a Voluntary Agreement are reported on the Payment 
Summary – Voluntary Agreement, which can be filed electronically.

Note You cannot change an employee set up with Employee status to 
Contractor status. You must terminate the employee and then 
create a new employee record with Contractor status.
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Labour Hire workers
Labour hire payments are payments to a contract worker from a labour 
hire firm for work performed for a client of the labour hire firm. To set up 
a contractor as a Labour Hire worker, select Labour Hire Worker on the 
Employee Record – Taxation tab. Note that this option is available only for 
contractors. 

Labour Hire payments are reported on the Payment Summary – Labour Hire 
and Other Specified Payments, which can be filed electronically.

Withholding where ABN not quoted
Payments between two businesses where the business being paid does not 
quote an Australian Business Number (ABN) on an invoice. In these cases, 
the payer must withhold an amount from the payment and submit it to the 
ATO. Select No ABN No Supplied from the Tax Scale list.

Where withholdings have been made under this tax scale, you will have to 
print out and file the Payment Summary – Withholding where ABN not quoted. 
You cannot file the Payment Summary – Withholding where ABN not quoted 
electronically.
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Tax File Numbers (TFN)
If an employee does not provide a Tax File Number (TFN), you must 
deduct tax at the top marginal rate plus the Medicare levy, unless the 
employee is exempted from providing a TFN.  If an employee is required 
to provide a TFN, but does not, you must set the employee up with a Tax 
File Number Not Provided tax scale.

Exceptions – If an employee does not provide a TFN, but is in one of the 
following situations, do not select the Tax File Number Not Provided tax scale:

 Employees exempt from the requirement of providing a TFN

 - Children under 16 who do not earn enough to pay tax; and

 - Employees who receive a service pension from the Department of 
Social Security or Department of Veteran's Affairs.  This does not 
include Newstart, Sickness, Partner or Parenting Allowances; Job 
Search or Special Benefit.

 Employees in the process of getting a TFN

If the employee has lodged a TFN Application Enquiry form with the 
ATO, you must allow 28 days for them to give you their TFN.  During 
this 28-day period, you must treat their TFN declaration form as if a 
TFN has been supplied.  If the ATO issues the employee an  Interim 
Notice, you should continue to treat them as if a TFN has been 
supplied.

To apply a “Tax File Number Not Provided” tax scale.
1 From the Lists menu, choose Employees.

2 Click to select the employee and then click Edit.  The Edit Employee 
window is displayed.

3 Click the Taxation tab.

4 From the Tax Scale drop-down list, select the Tax File Number Not 
Provided tax rate.

5 Click OK.

If you are not advised of the employee's TFN within 28 days and there 
is no interim notice, you must deduct tax at the top marginal rate plus 
Medicare levy (as explained above) until you are provided with a TFN.
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Non-residents
If an employee is a non-resident you must apply the Non-resident tax 
rates. An employee is non-resident if he or she answered No to the 
question “Are you an Australian resident for tax purposes” on the TFN 
Declaration.

To apply the non-resident tax scale:
1 From the Lists menu, choose Employees.

2 Click to select the employee and then click Edit. The Edit Employee 
window is displayed.

3 Click the Taxation tab.

4 From the Tax Scale drop-down list, select Non Residents.

5 Click OK.

Horticulture industry
If an employee qualifies as a Person Seasonally Employed in the Horticultural 
Industry and is subject to the 15% flat tax rate, apply the tax scale as follows:

1 From the Lists menu, choose Employees.

2 Click to select the employee and then click Edit. The Edit Employee 
window is displayed.

3 Click the Taxation tab.

4 From the Tax Scale drop-down list, select Flat 15%.

5 Click OK.
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Workers Compensation and WorkCover
Quicken Payroll can track all Workers Compensation or WorkCover (SA 
and QLD) claims and payments made for each employee. The 
Compensation tab lists all of the claims and payments for the employee. 
Whenever a compensation pay is processed, it appears here, along with a 
description of what it was for. In addition, for South Australia and 
Queensland users, Quicken Payroll includes a list of current WorkCover 
rates and classifications and calculates the amount of WorkCover liable for 
each employee. 

Recording a payment or claim 
You can also enter compensation payments when processing a pay and 
you can enter payments and claims through the employee record.

Review or edit a payment or claim
Workers Compensation or WorkCover payments and claims for an 
individual employee are listed on the employee record. Payments and 
claims for all employees are listed on the Workers Compensation list. You 
can review or edit existing claims or add new payments or claims through 
these windows.

Reports
The Compensation Report shows a listing of Workers' Compensation or 
WorkCover (SA and QLD) payments to your employees and claims made 
against your Workers' Compensation insurance company. The WorkCover 
Report shows how much WorkCover your company must pay.

WorkCover Rates
Quicken Payroll includes a list of current WorkCover rates and 
classifications. It uses these to calculate the amount of WorkCover liable for 
each employee. 

To apply a WorkCover Rate to an employee 

The WorkCover rate for each employee is selected on the Employee record 
Taxation tab.
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Child Support Scheme
If you have employees with Child Support Scheme obligations, you may 
have to withhold a certain amount from their wages and send this money 
to the Child Support Agency (CSA). If this is that case, you will be 
contacted by the Child Support Agency. If you receive a Notice to Deduct 
Maintenance Payments from an Employee’s Salary or Wages you need to:

 Deduct the amount of child support specified at the same time you 
make instalment deductions;

 Send the deducted amounts to the CSA once a month with a payment 
advice slip by the 7th of the month following the month.

 Do not change the amount that CSA has asked you to deduct unless 
CSA advises you in writing, or unless protected earnings (see below) 
prevents you from deducting the full amount.

How much to deduct
The CSA will send you a letter stating the amount your employee is 
required to pay. You are legally required to deduct the specified amount of 
child support from payments to your employee as directed, unless 
protected earnings apply.

You can only change the amount of child support that is deducted if the 
CSA advises you in writing, or if protected earnings apply. You must not 
change this amount even if your employee, their solicitor or anyone else 
asks you to. If you are in doubt, contact the CSA.

The protected earnings amount

You must not deduct a child support payment that leaves an employee 
with a net pay (after tax and child support deductions) of less than the 
protected earnings amount.

The protected earnings amount is adjusted annually to allow for increases 
in the cost of living. The CSA will advise you each December of the new 
amount for the next calendar year. For details on the protected earnings 
amount, refer to your CSA documentation.

For full and up-to-date 
information on the Child 
Support Scheme and your 
obligations, contact the 
Child Support Agency or 
go to their website:
http://www.csa.gov.au
You should also obtain the 
Employer's handbook - Nat 
2466, also available on 
their website.
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Applying the protected earnings amount

Child support is deducted after tax and before other deductions such as 
superannuation, health fund and loan repayments.

1 Deduct the employee's income tax instalment. 

2 Set aside the protected earnings amount. 

3 Deduct the child support payment, or as much as can be paid.

4 The remaining pay and the protected earnings amount can be paid to 
the employee.

If the full amount cannot be deducted due to protected earnings, deduct 
the maximum amount possible. You will need to send this amount to the 
CSA with a Variations to Maintenance Deductions form. The CSA will send 
you this form on request or it can be down-loaded from their website at 
www.csa.gov.au. The employee has to make up the amount not deducted 
by paying it directly to the CSA, not through you.

To set up a child support deduction for an employee
1 From the Lists menu, choose Employees.

2 Click to select the employee and then click Edit.  The Edit Employee 
window is displayed.

3 On the Deductions tab, click on the Deduction List drop-down list 
arrow and then select Child Support.

If the Child Support deduction has not yet been set up, type in Child 
Support and then press TAB.  Click Setup on the Quick-Add window 
to add it to the Deductions list. 

4 Enter the amount in the Amount column.
Important: Make sure that you do not deduct a child support payment 
that leaves an employee with a net pay (after tax and child support 
deductions) of less than the protected earnings amount.

5 Click OK.

When the employee's pay is processed, the child support will be deducted. 
Note that Child support must be deducted from the advance payment of 
wages or salary, for example when an employee goes on leave and receives 
an advance payment.
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Rebates and Family Tax Assistance
Rebates reduce tax payable and are spread out over the year in weekly 
instalments.  Family Tax Assistance (FTA) allows families with dependent 
children to pay less tax by increasing the tax-free threshold.

If an employee claims FTA or a rebate in the Rebates and Family Tax 
Assistance question on the TFN Declaration, you must adjust the employee's 
payroll as follows:

1 Calculate the rebate or FTA amount the employee will receive each pay 
period.

2 From the Lists menu, choose Employees.

3 Click to select the employee and then click Edit.  The Edit Employee 
window is displayed.

4 Click the Taxation tab and enter the amount calculated in Step 1 as a 
negative figure in the Extra Tax Contribution or Rebate (-ve) box. 

Higher Education Contribution Scheme (HECS)
Individuals with a HECS debt may be required to have additional tax 
instalment deductions taken from their pay to cover their debt.  Use a 
HECS tax scale for an employee who has provided you with an TFN 
Declaration and the employee:

 Has answered Yes to the HECS;

 Has not crossed box A;

 Has weekly earnings exceeding the minimum threshold; and

 Has not claimed a HECS exemption or Medicare Levy Variation 
Declaration.

To apply a HECS tax scale 
1 On the Employees List, click to select the employee and then click Edit.  

The Edit Employee window is displayed.

2 On the Taxation tab select  HECS Employee and then select the 
employee’s normal tax scale. Quicken Payroll will apply the HECS tax 
tables and deduct the required HECS repayments.
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Student Financial Supplement Scheme
Students may obtain additional loans to cover educational expenses under 
a voluntary loan scheme for tertiary students to help cover their expenses 
while they study. These additional cost are called Financial Supplement 
debts and are separate from HECS debts. 

Five years after the loan is taken out, the ATO becomes responsible for 
collecting the outstanding loan and the loan becomes an accumulated 
Financial Supplement debt. Compulsory repayments of accumulated 
Financial Supplement debts are made through the tax system when the 
student’s taxable income reaches the minimum threshold.

From 31 July 2000, individuals with an accumulated Financial Supplement 
debt may need to have additional amounts withheld from their pay 
cheques under the PAYG withholding system.

When do I have to withhold the SFSS 
component?
You must withhold an SFSS component when a payee has provided you 
with a Withholding declaration; has answered Yes to the question 'Do you 
have an accumulated Financial Supplement debt?” (Question 7b); and has 
earnings of over the specified limit.

The SFSS component is to be withheld from all earnings, including taxable 
allowances, bonuses and commissions. Do not withhold any amount for 
SFSS from lump sum termination payments. Amounts withheld for SFSS 
are included on the payee's PAYG Payment Summary and in the PAYG 
withholding box on your Business Activity Statement. It is not shown 
separately.

To apply a SFSS tax scale 
1 On the Employees List, click to select the employee and then click Edit.  

The Edit Employee window is displayed.

2 Click the Taxation tab.

3 Select  SFSS Repayment and then select the employee’s normal tax 
scale. Quicken Payroll will apply the SFSS tax tables and deduct the 
required SFSS repayments.
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Court order for salary garnishee 
To set up garnishee payments for an employee so that 
the payments come out of each payroll
1 On the Employees list, click to select the employee you wish to apply 

the salary garnishee to.

2 Click Edit and then click the Deductions tab.

3 In the Deduction column, enter Garnishee.

4 In the ID column, enter the garnishee details.

5 In the Amount field, enter the garnishee amount.

6 In the Ex Tax field, select No.

7 Click OK. After the pay has been processed, the garnishee amount will 
show up as a deduction in the Deductions Report. 

Alternatively, if the garnishee is a one time only payment, you could enter 
it when you process pays, by editing the pay. 
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CDEP payments
The Community Development Employment Project (CDEP) administered 
by ATSIC, provides job opportunities in community organisations across 
Australia. Wages paid with funds from the CDEP program must be tracked 
and recorded on a separate line on the employee Payment Summary. 
When the  CDEP Funding option is selected, a CDEP pay rate will appear 
in the Employee Record – Pay Rates tab (see page 194).

To record CDEP payments
1 On the Employee record – Taxation tab (see page 200) select  CDEP 

Funding. This will allow you to select a CDEP pay rate.

2 Click on the Pay Rates tab. 

From the Pay Rates column, select CDEP Payment and then enter the 
payment details. If the CDEP payment is a one-time payment, you 
can record the payment when you prepare the pay, through the Pay 
Details window.

3 When you issue Payment Summaries, CDEP amounts will be shown 
separately.
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Chapter Contents
 Quicken Payroll‘s reports provide you with 
the information you need to manage your 
company’s payroll operations. 

Quicken Payroll provides you with a variety of preset reports 
designed to give you quick and easy access to your company’s 
payroll information. In addition, you can create your own versions 
of reports; changing both the look and scope of the information 
reported. You can also use the Quicken Payroll Report Writer to 
create new reports and to fully customise reports.
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Generating reports
You can generate reports from several convenient places in Quicken 
Payroll: 

 From the Reports menu – You can quickly access all of Quicken 
Payroll’s reports, including the memorised reports list from the 
Reports menu. See pages 290 to 307 for descriptions of all of Quicken 
Payroll’s reports.

 From the Reports List – The Reports list allows you to access all of 
Quicken Payroll’s reports, including all customised reports. The 
Reports list also provides quicker access to report functions such as 
printing, editing and deleting reports. See page 291 for details.
From the reports listing on the Quicken Payroll Navigator – The most 
commonly used reports for each section are displayed for your 
convenience. 

 From lists – You can print list reports from many of your lists, such as 
the Employee, Pays, Deductions, Allowances, Sundries, Workers 
Compensation and ATO EFT lists. 

 When you process your payroll – After you have just finished 
processing your payroll is the ideal time to print your Pay Slips and 
reports such as your Pays report, Banking report, PAYG report, Payroll 
tax and your Superannuation report. You simply choose the reports 
you want to print from the Print Pay Reports window that appears after 
your payroll has been processed.

 From the Report Wizard – The Report Wizard takes you step-by-step 
through the process of creating whatever kind of custom report you 
need.
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Report Dates
When you open a report, Quicken Payroll uses the date of the latest Pay 
Date processed. For example, if you process a pay with a fortnightly pay 
date of October 14 and a weekly pay date of October 15, the automatic 
report dates will be October 15. To change the dates, select Custom from the 
Dates drop-down list and then enter the From and To dates of the period 
you want to print a report for.

Reports List 
The Reports List displays all of the Quicken Payroll preset reports, as well 
as any reports that you have created, or customised and renamed.  From 
this window, you can access all of the report functions you need.

Any new reports that you add, or preset reports that you modify, will be 
listed in the User Defined tab.  These reports will also be displayed on the 
Memorised Reports list, but only if you select  the Add to memorised 
reports option in the Report Properties window.

Note Sort order and filter changes that you make to reports will only be 
available when you access the reports through the Report List or 
if you save the changes to the memorised report list. These 
changes will not be recognised when you access reports through 
the reports menu.

The Report list allows you to open, edit, add, delete, copy and print 
reports. You can start the Report Wizard from the Report list, or from the 
Wizard menu. For description of the functions available through the 
Report list, see Report List on page 291.

To open the Reports List choose Reports List from the Quicken Payroll 
Reports Menu.

To enter dates in the From and 
To fields, you must first select 
Custom.
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Memorised reports
When you create a new report, or edit an existing report, you have the 
option of adding the report to your Memorised Reports list.

Memorised reports are also displayed in the Reports List, on the User 
Defined tab.

Printing reports
You can print any report to a printer or save the report to a disk in one of 
the following file formats, suitable for use in a word processor, spreadsheet 
or accounting program. For details, see Exporting report data on page 153.

To print a report
1 Select the report you want to print from the Reports menu, the 

Navigator or the Report list. 

2 When the report is displayed, either click the Print Icon, or select Print 
from the File menu. The Select Records window is displayed.

3 Select the page(s) and number of copies you want to print and then 
click Print.

When you print a report, 
you can select the pages 
and the number of copies 
you want to print.
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Quicken Payroll’s preset reports
Although you can create your own custom reports, Quicken Payroll 
includes all the reports you are likely to need. These preset reports can be 
generated from several convenient places in Quicken Payroll: the Reports 
menu, the Report list, or the Navigator. Once a report has been opened, 
you can customise the report to present the appropriate presentation of 
your data. For details see Customising the look and contents of reports on page 
128.

Below is a listing of the most commonly used Quicken Payroll preset 
reports. For a complete listing of all of Quicken Payroll reports and for 
more details, refer to The Reports Menu on page 290.

Frequency Report Description
Every pay 
run

Pay Slips
(page 299)

Provides pay slips you can hand to your employees. You can 
print 1, 2 or 3 pay slips on a page.

Pays (Pay list)
(page 305)

Provides all of the pay details for the current pay run, including 
the gross pay, tax, deductions, allowances, hours and finally the 
net pay for each employee.

Banking reports 
(page294)

Provide the information you need to pay your employees, 
whether by cash, cheque, EFT or a combination of methods. 
Shows the amount to pay each employee and how to pay them, 
including employee bank account information. 

PAYG Tax (page 
300)

Shows how much PAYG you have to pay by employee and in 
total.

Payroll Tax 
(page 304)

Shows you how much payroll tax your company must pay, by 
employee and in total. Also shows the amount of super and any 
allowances excluded from payroll tax calculations.

Super 
(page 306)

Shows you how much superannuation you have to pay to each 
super fund and for which employees. It also informs the super 
fund when there is a new employee.

Deductions 
(page 297)

Shows you the deductions taken from employees’ wages and 
provides the information you need to pay out the deductions 
(for example—union fee deductions).

WorkCover 
(page 307)

Shows you how much WorkCover your company must pay, by 
employee and in total.
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No data on your reports?
If you open a report and it doesn't show any information, it is usually 
because:

 There is no payroll information for the date range that you specified. 
Try changing the dates to see if any payroll information appears on the 
report.

 The Filters you have specified do not match any payroll information. 
Try changing the filters to see if any payroll information appears on the 
report.

 The Sort Order you specified results in no payroll information being 
found. Try changing the Sort Order to see if any payroll information 
appears on the report.

Quarterly
or monthly

Activity Statement 
Details (page 293)

Provides you with the information you need to fill out your 
Business Activity Statement or Instalment Activity Statement. 

Annually Payment Summary 
reports
(page 300 to 303)

Prints your Payment Summaries, Payment Summary Deduction 
Report, Reconciliation Statement and ETP Payment Summaries.
In addition to providing your employees with a Payment 
Summary, you must also provide a Payment Summary 
Explanation, which can be printed separately, or on the reverse 
side of the summary. 

Reconciliation 
Statement 
(page 302)

Shows you how much PAYG should have been paid each 
month, so that you can make sure that the total payments you 
have made equal the total of the amounts shown on the 
Payment Summaries you have issued for the year.

Magnetic Media 
Info Form 
(page 303)

Provides is a copy of the form that must accompany your 
EmpDupe file to the ATO.  Make sure that all details have been 
filled out correctly.

As needed Audit Trail
(page 294)

This report provides you with a list of changes made to the 
company data file, who they were made by and when they were 
made. 

Frequency Report Description
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Creating a new report 

The Report Wizard
Quicken Payroll includes so many preset reports that you may never need 
to create a custom report.  You may find that the easiest way to get the 
reports you need is to modify a preset report.  However, there may be 
times when you want to create a new report from “scratch”.

The easiest method of generating a custom report is to use the Reports 
Wizard.  The Reports Wizard takes you through the process of adding a 
report step by step, ensuring that you complete every step.

1 From the Quicken Payroll Wizard menu, choose Create Reports.  
Quick Reports is opened and the Create a Report window is displayed.

2 To save the report to the Memorised Reports list, select the  Add to 
Memorised Reports option. If you do not select this option, the report 
will only be saved to the User Defined list in the Reports List.

3 For instructions on completing each section, press the F1 keyboard 
function key. This will bring up Quicken Payroll Help with 
instructions for that specific section. 

4 When you have completed all the sections, click Finish.  Quicken 
Payroll will now generate the report and allow you to make any 
additional changes before saving it. Click the Save icon on the toolbar 
to save your any additional changes.

To create a new report using 
the Report Wizard, simply 
follow the instructions for each 
step. For details on completing 
any of the steps, just press F1 
for onscreen Help related to 
that step.
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Customising the look and contents of reports
You can customise your reports so that you can have your payroll data 
presented in the most useful format. For example, you can:

 Change the type face (font)

 Adjust the width of a column

 Add or remove columns

 Change how numbers are displayed

 Create or change subtotal groupings

 Change the sort order

Report Writer – Edit Report window
In order to customise any report (other than sorting) you must be in Edit 
Mode. Simply click on the Edit Report toolbar icon to go into Edit Mode. 
Once in Edit Mode, the Properties, Sort, Filter, Add, Delete and Font icons 
will be enabled. 

The Report Writer Toolbar
The Report Writer toolbar provides access to various functions, most of 
which can also be accessed through the Report Writer menu.

Properties – Clicking on Properties opens the Report Properties window. 
The Report Properties window is where you name the report, set printing 
and page options, subtotalling and totalling and when a new page is 
started. For details see Setting report properties on page 131.

Sort – Clicking on Sort opens the Report Sort Order window. Setting a sort 
option affects the whole report and sets what fields Quicken Payroll will 
subtotal on. For details, see Sorting a report on page 139.

Most Report Writer 
functions are 
disabled until you 
click the Edit Report 
icon.
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Edit Report – Clicking on Edit puts you in Edit mode and allows you to 
preview and edit the report. The Filter, Add, Delete and Font icons are 
enabled only when you have clicked on Edit Report. To edit any field on 
the report, click to select the field and choose Edit Item from the Activities 
menu or click the right mouse button.

Filter – Clicking on Filter opens the Report Filter window. Filtering is a 
powerful report customising tool that allows you to specify exactly what 
appears on a report.  You can filter by date, by activity, by employee, or by 
any other criteria that you specify.  This allows you to create virtually any 
kind of report you want. For details see Filtering a report on page 136.

Add – Clicking on Add opens the Object Properties  window, which allows 
you to can add a column, a data field, a calculated field, text, an image, a 
box or a line. For details see Adding and changing fields or graphics on page 
140.

Delete – Clicking on Delete allows you to delete a selected item, field, 
image or other object on the report. For details see Deleting an item on page 
152.

Font – Clicking on Font allows you to change the font of any columns, 
heading and fields on a report. For details see Changing the font properties on 
page 140.

Previous/Next – Clicking on Previous displays the previous page of a 
multiple-page report. Clicking on Next displays the next page of a 
multiple-page report.

Zoom – You can zoom in on a report by clicking the zoom icon.  This allows 
you to select the viewing size.  Selecting 100% means you want to see the 
report at the same size as it will print out, 50% means you want to view the 
report at 50% of its actual size.

Print – Clicking on Print opens a print window that lets you choose which 
report pages and how many copies of the report to print and then prints 
the page(s).

Save – Clicking on Save allows you to save a new report, or save changes 
you have made.  If you are modifying a preset default report, before you 
save, the Report Properties window is opened, which allows you to save the 
report as a memorised report. 
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 To include the report in the Memorised Reports List, click Add to 
Memorised Reports.

 If you have made changes to a preset default report, when you click on 
Save, a message will ask you if you want to save the report as a 
memorised report. 

 To save the changes as a separate memorised report, click Yes. 
Memorised reports will be listed on the Quicken Payroll Reports menu 
under Memorised Reports and under the Reports List – User Defined tab. 

 If you want to change the preset report, click on No.  

Note Sort order and filter changes are not recognised in the default 
(preset) Quicken Payroll reports when they are run from the 
Quicken Payroll Reports menu.  However, the changes are 
recognised when the reports are opened from the Reports List. 

Basic Filtering
Basic filtering  is performed by selecting from the Dates, From, To and 
Custom drop-down lists under the Report Writer toolbar.  In order to 
change the From or To dates, you must first select Custom from the Dates 
drop-down list.  Refer to Filtering a report on page 136 for further details.
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Setting report properties
Report properties include the name of the report, printing and page 
options, totalling, subtotalling and when a new page is started. These 
properties are set on the Report Properties window.

Report Properties window
To open the Report Properties window, do one of the following:

 From the Report List, click on Add or Copy.

 From the Report Writer toolbar, click on the Properties icon on the 
toolbar. 

 From the Report Writer Activities menu, select Report Properties.

Complete the details on each tab according to the instructions below and 
click Save when you have completed all of the details.

General properties

Name – Enter a name for the report.

Paper size – Select the paper size for the report from the drop-down list.  
By default the paper size will be A4, portrait.

Add to memorised reports – Select if you want the report to appear on the 
list of memorised reports in Quicken Payroll.

Select Output to Export 
if you want to export the 
report data instead of 
printing the report.
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Output to – You can either print your report, or you can export it to be used 
with another program. For example, you might want to export a report to 
a word processing or spreadsheet program. You can also use this feature to 
export your payroll data to an accounting program if you know the 
required file format. For further details, see Exporting report data on page 
153.

To export the report to a file, select Export.  When you select Export, the 
Export tab will be displayed.

Export properties

Type – Select the type of file you want the report to print to from the drop-
down list. File types (with file extension in brackets)  include:

Basic (.bas) Tab Delimited (.tab)
Excel (.xls) QuickBooks (.iif)
Lotus (.xls) Text (.txt)
Other (.txt)

If the type of file does not exist, select Other.  Selecting Other will allow you 
to specify what character should separate each item and what character 
should separate each record. 

File Name – Enter a name for the export file. By default, the file will be 
saved to the C:\Program Files\QPRollv12\Reports folder. To save the file to 
a different location, type in the folder name as well as the file name. 

For example, to save a file named Allowance to a floppy disk, type in 
A:\allowance.xls (after you select the file Type).

Separator and Terminator – Separator and Terminator are only enabled 
when you select Other from the Type drop-down list. You will need to refer 
to the user guide of the program you are exporting to in order to determine 
the correct export settings. 

The Separator and 
Terminator can only be 
selected when you select 
Other as the file Type.
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 The separator is the ASCII character code of the character between 
fields.

 The terminator is the ASCII character at the end of a record.

Page alignment properties

Orientation – Select the orientation of the page—landscape or portrait.  
Use Landscape if your report has a lot of columns.

Set Printing Start Position – Specify the printing start position.  Do not 
change this unless you are having difficulties aligning Payment 
Summaries, pay slips or reports.

Across Page – Enter the distance in millimetres that Quicken Payroll 
should start printing from the left hand edge of the paper.

Down Page – Enter the distance in millimetres that Quicken Payroll should 
start printing from the top edge of the paper.

Print to Scale – Generally you should leave this unchanged. Do not change 
this unless you are having difficulties with Payment Summaries, pay slips 
or reports printing too far to the right or too far down the page.

Across Page – Enter the scale—percentage of normal size, that the report 
should print across the page.  By default it is 100% of normal size.  If a pay 
slip finished too far to the left, you can increase this percentage.

Down Page – Enter the scale—percentage of normal size, that the report 
should print down the page.  By default it is 100% of normal size.  If a pay 
slip printed too far down the page, you can reduce this percentage.  If a pay 
slip finished too far up the page, you can increase this percentage.
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Totals properties

Report Fields – Specify which fields are to be subtotalled and which fields 
are to be included in the Grand Total.  If the Report Properties window has 
been opened by clicking the Add toolbar icon, this tab will not display any 
fields as they have not been placed on the report yet.

S/T Clicking to place a Yes in this column will create a Subtotal in 
the field every time one, or both, of the sort fields change.

G/T Clicking to place a Yes in this column create a Grand Total in 
the field at the end of the report.

Print Totals Only – If you want the report to add up the figures for the 
period specified and then show a total for that period, place a tick next to 
Print Totals Only.

Reset Sub Totals When – Select from the drop-down list when the 
subtotals should be reset.  Selecting:

 1st Sort Field Changes – will change the subtotal fields only when the 
Sort By field changes.

 2nd Sort Field Changes – will change the subtotal fields only when the 
Then by field changes.

 Both Sort Fields Change – will change the subtotal fields only when 
the Sort By and the Then by fields change.
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Paging properties

Disable Auto Paging – Selecting Disable Auto Paging will cause Quicken 
Payroll to fill the current page before creating a new page.  Removing the 
tick will cause Quicken Payroll to start a new page each time one, or both, 
of the sort fields change.

Divide Page Into – If you are creating pay slips and you want more than 
one to print on a page, select the number of page divisions:

 1 Vertical Section – This will use the whole page.

 2 Vertical Sections – This will divide the selected page size into 2 equal 
sections.  Quicken Payroll uses this to define the 2 per page pay slips.

 3 Vertical Sections – This will divide the selected page size into 3 equal 
sections.  Quicken Payroll uses this to define the 3 per page pay slips.

Section Height – The default section height will be set based on the 
number of page divisions selected. This value can be changed, but you 
should only do so if there are alignment problems when printing the 
report.
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Filtering a report
Filtering is a powerful report customising tool that allows you to specify 
the scope of the information that displays on a report. For example, you 
might only want a report to display details for employees from a specific 
department, or for a specific period of time. There are two levels of 
filtering:

 Basic Filter – Basic filtering is performed by selecting from the Dates, 
From, To and Custom drop-down lists under the Report Writer toolbar. 

 Advanced Filter – The Report Filter window gives you more advanced 
filtering options.   To open the Report Filter window, click on the Filter 
icon on the toolbar, or choose Set Filter Options from the activities 
menu. 

Basic Filtering
The Edit Report window provides some simple report filters. These are 
located directly below the main toolbar.

Dates – Select the period covered by the report.  This can be anywhere 
from Today to Last Financial Year.  The From and To fields will be adjusted 
accordingly. For example, if you select This Financial Year, Quicken Payroll 

will use 1st July from the previous year to the 30th June for the current year.

Select Custom if you want to change the From and To dates.

From / To – These two dates are the beginning and ending date for the 
report, which are automatically entered based on what you selected from 
the Dates drop-down list. 

If you selected Custom from the Dates drop-down list, you can type in 
the dates directly, or you can click on the drop-down list button to the 
right to display the Q-Calendar window, which will allow you to select 
the date with your mouse.
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Custom Field – The Custom field is the drop-down list to the right of the 
To field. The title of the custom field changes depending on the report you 
are previewing.  For example, if you are previewing the PAYS report, this 
field will change to Employee and will contain the status list. The Custom 
field allows you to select an additional filter from the drop-down list, 
resulting in a report with a more limited scope.

Example If you were previewing the Allowances (By Allowances) report 
and wanted to only show Car Allowances you would:

1 Select Custom from the Allowances drop-down list.

2 Select Car Allowance in the From and to fields, as shown in 
the example above. Click OK.

Advanced filtering 
If you need more advanced filtering, you can use the Report Filter window 
for complete control over how the data on your report is filtered.

To open the Report Filter window, click on the Filter icon on the toolbar, or 
choose Set Filter Options from the activities menu. If the Filter icon is 
disabled, it is probably because the report is not in Edit mode. Your report 
must be in Edit mode before you can make any advance filtering changes. 
To switch to Edit mode, just click the Edit Report toolbar icon. 

Selecting Custom from the 
Custom field opens the 
Custom Report Filter 
window, which allows you 
to restrict the report to a 
range of values.

Click on the arrows to scroll 
up or down and view more 
lists.

As you build the filter, the filter 
description will appear here. 
You can enter the filter directly 
by typing, or you can build the 
filter options by clicking on 
items and operators.

Operator 
commands
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To set up advanced filtering for the report using the 
Report Filter window
1 Click the payroll item that you want to filter on the left side of the 

window.  Scroll up or down to display more payroll items.

2 In the Available Fields column, click to select the field to use as a filter.  
The field moves down to the Filter section below.

3 Select an operator command.

4 Enter a qualifier for the filter. For example, when you create a report 
showing employees paid more than $500, enter GROSS >500.  In this 
case, 500 is the qualifier.

5 If you want a more complex filter, select another operator and repeat 
the above steps.

6 Click Save.  The report will be generated using your filter options.

Operator Example
< Less than To have a report show employees paid less 

than $500, enter GROSS<500.
> Greater 

than
To have a report show employees paid more 
than $500, enter GROSS >500.

<= Less than 
or equal to

To have a report show employees paid $500 or 
less than $500, enter GROSS <=500.

>= Greater 
than or 
equal to

To have a report show employees paid $500 or 
more than $500, enter GROSS>=500

= Equal to To have a report showing only the Sales 
department, enter DEPARTMENT= Sales

~= Not
Equal To

Even though there isn't a button for Not Equal To, 
you can enter a Not Equal to code by typing ~= 
in the filter section.  For example, to have a report 
not show terminated employees enter 
EMPLOYEE STATUS ~= Terminated.

Or Alternative 
condition

To have a report showing only the Sales and 
Marketing departments, enter 
DEPARTMENT=Sales Or 
DEPARTMENT=Marketing

And Additional 
condition

To have a report showing Sales staff earning 
more than $500, enter DEPARTMENT=Sales 
AND Gross>500.

[ ] Brackets To have a report show the Sales and 
Marketing departments, enter 
DEPARTMENT=[Sales And Marketing]
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Sorting a report
Reports can be sorted based on any column on the report.  You can sort 
based on one or two columns.  For example, the Pays report by default is 
sorted by Employee number (first sort criterion) and then by date (second 
sort criterion). You could change the sort order for example, to sort by 
employee name and gross pay.

To set or change the sort options of a report, click on the Sort icon on the 
toolbar, or select Set Sort Order from the Activities menu. Set the sort order 
on the Report Sort Order window.

If the Sort icon is disabled, it is probably because the report is not in 
Edit mode. The report must be in Edit mode before you can make any 
changes to a report. To switch to Edit mode, just click the Edit Report 
toolbar icon.

Sort By This Field – Select the first field to sort the report by.  The fields 
available are the ones that have been placed on the report.

Then By This Field – If you want to sort by another field as well, select 
another field from the Then By This Field list. To sort by a third field, select 
a field from the last drop-list.

Setting a sort option affects the whole report and determines which fields 
Quicken Payroll will subtotal on.  For example, with employee number 
selected in the Sort By this Field list, Quicken Payroll will start a new 
subtotal each time the employee number changes.
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Changing the font properties
You can easily change report fonts in any report using the Report Writer. 
All columns and objects, can have their font changed once they have been 
placed on a report. A column can only have one set of font properties. You 
cannot change the font properties of a single field within a column.

To change the font of an item
1 Click on the column or object to select it.  A group of red dots will 

appear around an item when it is selected.

If you nothing happens when you click on the column or object, it is 
probably because the report is not in Edit mode. The report must be in 
Edit mode before you can make any changes to a report. To switch to 
Edit mode, just click the Edit Report toolbar icon.

2 Click on the Font icon on the toolbar. 

3 Select the desired font properties and then click OK.

Adding and changing fields or graphics 
You can add, delete, or modify fields or graphics on your report by using 
the Report Writer Object Properties window. The Object Properties window is 
displayed when you click the Add icon, right-mouse click on a field, or 
choose Edit Item from the Edit list.

If the Add or Delete icons are disabled, it is probably because the report is 
not in Edit mode. The report must be in Edit mode before you can make 
any changes to a report. To switch to Edit mode, just click the Edit Report 
toolbar icon.
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Object Properties window
The Object Properties window is where you set up the properties for objects 
on the reports.  An object can be a column, a data field, a calculated field, 
text, an image, a box or a line. 

Changing properties of an existing object 
on the report
To change properties for an object, right-mouse click on the object, or click 
to select the object and then choose Edit Item from the Edit menu.  The 
Object Properties window is displayed allowing you to edit the properties 
for that object. 

For instructions on completing each section, refer to the information 
below, or press F1 to display Quicken Payroll Help with instructions for 
that specific section. 

Adding a new object on the report
1 To add an object, click on the Add icon on the toolbar, or choose Add 

Item from the Activities menu. The Object Properties window is 
displayed, allowing you to create a new object. Select the properties 
for the text, data field or graphic.

For instructions on completing each section, refer to the information 
below, or press F1 to display Quicken Payroll Help with instructions 
for that specific section.

All of the available fields 
for the selected payroll 
item are listed in this 
window.

Select the type of 
object that you are 
editing or adding 
to the report.

Object

An object is anything you 
place on a report, including 
a column, a data field, a 
calculated field, text, an 
image, a box or a line.

G l o s s a r y T e r m
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2 Click Save to add the object. If you have selected Add Field To List, 
a new column will be added. If you have not selected Add Field To 
List, you will need to place the object on the report. Do this by 
positioning the object with your mouse and then clicking to place the 
object on the report.

Include Heading – Select  this option if you want the heading for the 
field displayed on the report.

Add Field To List – Select  this option if the field you are creating is a new 
column on the report. This will add a new column.

Object type – When you select the object type, the Object Properties 
window displays the options for that object type. The following object 
types are available:

Data Field  (see page 143) Image (see page 146)

Calculation Field (see page 144) Box (see page 147)

Custom Field (see page 144) Line (see page 147)

Text Field (see page 146) 

Advanced options 
When the advanced button is clicked on the Object Properties window, the 
tab will change to display various options that will vary depending on the 
object type.

When the advanced button is clicked on the Object Properties window, the 
tab will change to display various options.  These are:

Remove Cents From Result – Selecting this option will drop the cents from 
a numeric field.  No rounding is involved, the cents are simply lost.

Available advanced options 
will vary depending on the 
object type selected.
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Do Field Filtering After Total – This will force any calculated fields that 
have a filter on them to work only after a subtotal or grand total has been 
generated.

Field Justification – Specify how the field is displayed on the screen. For 
example, if Centre was selected, the field would be centred within the left 
and right margins of the field area displayed on the screen.

Number of Export Characters – If the report is to be exported to a file, you 
may need to specify that this field will never contain more than a specified 
number of characters.  This is only active when you are creating an export 
file—when you have selected Output to Export, in the Report Properties 
window. For details, see Exporting report data on page 153.

Position of Field on List – Each column on the report is assigned a number.  
This number can be changed  to change the position of a column. See also 
Changing the column order on page 149.

Adding a data field
A data field pulls information from your Quicken Payroll company file—
information that was entered previously. 

To add a data field to a report select the data field that you want to add to 
the report.  The tabs on the left indicate different areas within the Quicken 
Payroll data file. 
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Adding a calculated field
Use the Calculation Field  to create a simple calculated field.  If you need a 
more advanced calculation, create a custom field. 

Heading – Enter a name for the field header.

Calculation – Use this section to create a simple calculation.  

In the left hand drop-down list, select the first field to use in the 
calculation.  Select the desired operation.  There is a choice of multiply (X), 
divide (/), add (+) and subtract (-).  In the right hand drop-down list, select 
the second field to use in the calculation.

Adding a custom field
Use the Object Properties – Custom Field to create an advanced calculated 
field, where you can combine filtering and calculations.  For a simple 
calculation, you should create a calculated field.

Step 1 – Set up the calculation
Click the Calculation button and complete the calculation section.

Heading – Enter a name for the field.
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Calculation – In the left hand drop-down list, select the first field to use in 
the calculation.  Select the desired operation.  There is a choice of multiply 
(X), divide (/), add (+) and subtract (-).  In the right hand drop-down list, 
select the second field to use in the calculation.

Step 2 – Set up the filtering

Click the Filter button and complete the filtering details:

1 Click the payroll item that you want to filter, on the left side of the 
window.  Click the up or down arrows to display more payroll items.

2 In the Available Fields column, click to select the field to use as a filter.  
The field moves down to the Filter section below.

3 Select an operator command: 

4 Enter a qualifier for the filter. For example in the expression 
GROSS >500, 500 is the qualifier.

5 If you want a complex filter, select another operator and then repeat 
the above steps.

Example

To create a calculated field that multiplied an employee's YTD wage by 6% 
and only applied to employees with the surname Jones and who worked 
in the Sales department, you would do the following:

1 In the Heading box, enter the name, Projected Wage.

2 On the Pays tab, locate 'Gross' and double click on it.  'Gross' appears 
in the Calculation box.

3 Click on the multiplication (X) sign. 'X' appears in the Calculation box.

4 Using the numeric keypad, enter '1.06'.  This will provide us with an 
increased salary, not just percentage of the salary.

5 Click Filter.

< Less than ~= Not Equal to
> Greater than [ ] Brackets 
<= Less than or equal to Or Alternative condition
>= Greater than or equal to And Additional condition
= Equal to T Test
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6 On the Employees tab, locate 'Employee Number and double click on 
it. 'Employee Number' appears in the Filter box.

7 Click on the equals sign (=) sign. '=' appears in the Filter box.

8 Enter the employee number, 1

9 Click Save. Position the field on the report and click the mouse button.

Adding a text item
To add a line of text to a report, such as a heading.

Text Heading – Enter the text you want displayed in the text heading field.

Adding an image
You can easily add a graphic image, such as your company logo, to your 
reports or forms.

Image File – Enter the name of the graphic, or click Browse to find the 
image file.  Once the file has been located, double click on the file name.
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Adding a box
You can add a box for placing around a field or group of fields.

Click Save and position the graphic on the report by moving it with your 
mouse and then clicking the left mouse button to place the field on the 
report. Once the box is placed on the report, you can click on it again to 
resize it by doing the following:

1 Click on the item to select it.  A group of red dots will appear around 
an item when it is selected.

2 Place the mouse pointer on a dot. Click and hold the left mouse button 
down. Move the mouse to expand or contract  in the direction that the 
mouse is moved.

3 When you release the mouse button and the field will be resized.

.
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Adding a line

To add a line, first select Vertical or Horizontal and the Thickness of the 
line.

Click Save and position the line on the report by moving it with your 
mouse and then clicking the left mouse button to place the field on the 
report. Once the line is placed on the report, you can click on it again to 
resize it by doing the following:

1 Click on the item to select it.  A group of red dots will appear around 
an item when it is selected.

2 Place the mouse pointer on a dot. Click and hold the left mouse button 
down. Move the mouse to expand or contract  in the direction that the 
mouse is moved.

3 When you release the mouse button and the field will be resized.
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Reorganising your report
Once your report includes all the information you need, you can customise 
it further by reorganising the columns other items—data and text fields, 
boxes, lines and graphics. 

Note The report must be in Edit mode before you can reorganise a 
columns and other items on the report. To switch to Edit mode, 
just click the Edit Report toolbar icon.

Changing the column order
If you want to change the order of columns in your report, click to select 
the column you want to move. The column will be highlighted in blue.

Next hold down the SHIFT key and while it is held down press the left 
arrow key to move the field to the left, or press the right arrow key to move 
it to the right. This is the quickest and easiest way to change column order.

You can also change the position of a column using the Object Properties 
window. To do this:

1 Right mouse click to select the column you want to move to display the 
Object Properties window.
Alternatively you could click to select the column and then choose 
Edit Item from the Edit menu.

2 Click Advanced and then select or enter the position of the column in 
the Position of Field on List drop-down list.

Changing column width
To change the width of a column in a report, simply click on the column 
dividing line and drag the column to the desired width.

When you click on the column 
divider, your cursor will change 
into the double arrow. Drag the 
column to the desired width.
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Aligning fields
The Align Fields window allows you to line up data and text fields, boxes, 
lines and graphics, or make them all the same width, height, or font. This 
feature is particularly useful when you are adding new fields or items to a 
report.

1 Click on the first of the fields that you want to align. A group of red 
dots will appear around the selected field.

2 Hold down the Ctrl keyboard key and then click on the other fields s 
that you want to align. The selected fields or items will be indicated by 
blue dots.

3 Choose Edit Item from the Edit menu, or right-mouse click anywhere 
on the report. The Align Fields window will be displayed.

4 If you do not want to align any of the selected fields, click on the align 
column to change the align option to No.

5 Select the Align Options.

Top Align aligns the tops of the fields with the field selected in 
the Align Fields With drop-down list. Select this option for fields 
that are in a horizontal line.

Left Align aligns the left sides of the fields with the field selected 
in the Align Fields With drop-down list. Select this option for fields 
that are in a vertical line.

Right Align aligns the right sides of the fields with the field 
selected in the Align Fields With drop-down list. Select this option 
for fields that are in a vertical line.

No Align leaves the alignment of fields as is. Select this option 
when you only want to select one of the Other Options.
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6 Select the Other Options.

Make Same Width – changes all field widths to the same width as 
the field selected in the Align Fields With drop-down list.

Make Same Height – changes all field height to the same height 
as the field selected in the Align Fields With drop-down list.

Make Same Font – changes all fonts to the same font as the field 
selected in the Align Fields With drop-down list.

7 From the Align Fields With drop-down list, select the field that you 
want to align the rest of the fields with.

8 Click Align. The fields will be aligned or adjusted as indicated.

Resizing an object
All objects – data and text fields, boxes, lines and graphics can be resized 
once they have been placed on a report. To resize an object:

1 Click on the item to select it.  A group of red dots will appear around 
the object selected.

2 Place the mouse pointer on a dot. Click and hold the left mouse button 
down. Move the mouse to expand or contract  in the direction that the 
mouse is moved.

3 When you release the mouse button, the object will be resized.

Moving an object
All objects—data and text fields, boxes, lines and graphics, can be moved 
once they have been placed on a report.  To move an object:

1 Click on the object to select it.  A group of red dots will appear around 
the object selected.

2 Place the mouse pointer anywhere in the object. Click and hold the left 
mouse button down.

3 Move the mouse and the object will move in the same direction as the 
mouse pointer.

4 Release the mouse button and the field will be moved to where the 
mouse pointer location.
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Deleting an item
You can delete any items—columns, data and text fields, boxes, lines or 
graphics, from a report. To delete an item:

1 Click on the item to select it. A group of red dots will appear around an 
item when it is selected. If you select a column, the selected column 
will be highlighted in blue.

2 Click the Delete icon on the toolbar, or choose Delete Item from the 
Activities menu.

If the Delete icon is disabled, it is probably because the report is not in 
Edit mode. Click the Edit icon to open the report in Edit mode.

3 When the warning window appears, click Yes to delete the field.
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Exporting report data
If you want to export your payroll data to a spreadsheet or word 
processing program, or an accounting program other than Quicken or 
QuickBooks and you know the required file format, you can create a 
custom export file. This is done by creating a “report” that prints to a data 
file, instead of to your printer. 

Step 1 – Create a report
If you are exporting to a spreadsheet or word processing program, simply 
create the report with the details you want.

If you are exporting to an accounting program, create a report containing 
only the information specified by the program’s file format requirements. 

Step 2 – Set the Report Properties
In the Report Properties window – General Properties tab (see page 131), 
select the Output to Export option. This will enable the Export Properties 
tab.

File Name – Enter a name for the export file. By default, the file will be 
saved to the C:\Program Files\QPRollv12\Reports folder. To save the file to 
a different location, type in the folder name as well as the file name. 

For example, to save a file named Allowance to a floppy disk, type in 
A:\allowance.xls (after you select the file Type).

Type – Select the type of file you want the report to print to from the drop-
down list. If the type of file does not exist, select Other.  Selecting Other will 
allow you to specify what character should separate each item and what 
character should separate each record. 

The Separator and 
Terminator can only be 
selected when you select 
Other as the file Type.
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Separator and Terminator – Separator and Terminator are only enabled 
when you select Other from the Type drop-down list. You will need to refer 
to the user guide of the program you are exporting to in order to determine 
the correct export settings. 

 The separator is the ASCII character code of the character between 
fields.

 The terminator is the ASCII character at the end of a record.

Step 3 – Set the field lengths
Some programs may restrict the lengths of certain fields, for example an 
address field. To restrict the number of characters exported for a particular 
field, select number of characters on the Object Properties window – 
Advanced section.
To change field a field length, right-mouse click on the field, or click to 
select the object and then choose Edit Item from the Edit menu.  Click 
Advanced on the Object Properties window.

In the Number of Export Characters box, enter or click to select the 
maximum number of characters to be exported.

Step 4 – Create the file
To create the file, simply “print” the report by clicking on the Print toolbar 
icon, or by selecting Print from the File menu. By default, the file will be 
saved to the C:\Program Files\QPRollv12\Reports folder, or the folder you 
entered along with the file name in Step 2.

Available advanced 
options will vary 
depending on the object 
type selected.
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C H A P T E R  7

Using Quicken 
Payroll’s menu 
commands

How do I use 
Quicken Payroll ’s 
menu commands?

The File Menu  156 

The Lists Menu  180 

The Activities Menu  267 

The Navigator  288 

The Reports Menu  290 

The Help Menu  310 

Chapter Contents
 This part of the user guide covers each menu 
item, explaining in detail how to use each 
feature and how to enter your payroll details.

As you use Quicken Payroll, you may have some questions about 
what certain options and features do, how to complete the details 
on a window, or where to find a Quicken Payroll feature. 

When you need more information about a Quicken Payroll 
feature, you can refer to this chapter but don’t forget that onscreen 
help is there for you at the click of a button—the F1 key. The 
onscreen Help gives you the same information you would find in 
this chapter.
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The File Menu

Open Existing Company 
To open an existing file, choose Open Existing Company from the File 
menu. The Please Select Company File window will appear.  
In most cases, you will be able to simply select the company file you want 
and then click OK. 

If the company file you want to open is not displayed in the Please Select 
Company File window, you can locate the file as follows:

1 Click on the Look in drop-down list to select the drive and folder that 
the company file resides on.  This is usually the same drive that 
Quicken Payroll is running from.  If Quicken Payroll is registered as 
multi-user then the data file is probably on a network drive.

2 You should now see a list of QPW files (also called company files) that 
can be opened. Click to select the file that you wish to open.

3 Click OK. Quicken Payroll will open the selected company data file 
and return to the Quicken Payroll main screen.

If the company you are opening was created in a previous version of 
Quicken Payroll, see Upgrade using the Upgrade Wizard on page 32.

All of the current Quicken 
Payroll company files are listed 
in this window with the 
extension QPW.
To locate Quicken Payroll files 
created with a version of 
Quicken Payroll prior to v4, 
select Other QP Companies.
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Company Information
The Company Information menu option opens the Update This Company 
window for the currently open company. This is where you enter and edit 
all of your company information—the company name and address, phone 
and fax numbers, ACN and Australian Business Number (ABN), banking 
details and workers compensation insurer details. These details were 
originally entered when you created the company using the Company 
Wizard. 

You can also access the Update This Company window from the Companies 
list.

1 Select the company you want to edit details for and then click 
Companies>Edit.  The Update This Company window is displayed, 
allowing you to edit company details.

2 Choose Company Information from the File menu or choose 
Company Information from the Navigator Company tab. The Update 
this Company window is displayed.

For instructions on completing each section, press the F1 key. This will 
bring up Quicken Payroll Help with instructions for that specific section.  
For further details, see the Companies List on page 180.

If your company trades 
under a different name, enter 
the trading name here.
Quicken Payroll creates the 
Disk File name from the 
Company name. The file 
name cannot be changed.
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Backup Files
To prevent or minimise the risk of data loss, you should make regular 
backup copies of your Quicken Payroll company data. In the event of data 
loss, you will then be able to restore your data from a backup copy.

Make sure you have enough good quality blank, formatted floppy disks in 
good condition to backup your company file. If you do not format your 
floppy disks, or if you use cheap disks or disks in poor condition, you run 
the risk of backing up your company file onto a corrupt floppy disk that 
will then corrupt the company file and result in a loss of information. 

1 Choose Backup Files from the File menu to display the Backup Data 
window.

2 Check that the FROM path and file name are correct. By default this 
should be C:\PROGRAM FILES\QPRollv12\DATA\{filename}.QPW 
{filename} is the name of your company file.

3 Check that the location you are copying TO is correct.  By default the 
company file backup is created on floppy drive A.  You can change the 
default backup path and file name in File Preferences.  To change the 
backup destination, you can type in a new file path, or click Browse 
and locate the file path.

4 Click OK.  If there are already backup or other files on the disk, 
Quicken Payroll will ask if you want to remove (erase) those files.

5 Click Yes when prompted to back up your company files, tax scales 
and reports.

For further details on backing up and safeguarding your data, see 
CHAPTER 8 - Protecting your data on page 317 and Recommended backup 
procedures on page 319.

You can back up your 
company file to a floppy 
disk, your hard drive, or 
other storage device.
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Restore Files 
Use Restore Files to restore your company file, tax scales and reports from 
a backup copy—you cannot move or restore your company file manually 
using Windows Explorer or the command prompt. You will need to use the 
restore process if your company file becomes corrupted or if you are 
moving your company file to another computer. 

1 Choose Restore Files from the File menu to display the Please Select 
Backup File To Restore window.

2 Select the drive and folder where your company file backup resides. If 
you backed up your company file to a folder other than the one 
displayed, click on the Look In drop-down list.

3 A list of backup files (QPB files) that can be restored will be displayed. 

Warning – Do not restore a backup file created in a version of 
Quicken Payroll older than version 6—this could result in a 
corrupted data file. If your backup file was created in another 
version, restore it using that version and then upgrade the restored 
file to your current version of Quicken Payroll. See Upgrading from a 
previous version of Quicken Payroll on page 32.

4 Click to select the file that you wish to restore and then click Open. 
Alternatively, you can double-click to select the file that you wish to 
restore. The Restore Data Files window is displayed.

To select the folder that your 
backup file is located, click here.

To open the folder one level 
higher, click  here.

Click to select the backup file 
that you want to restore from.
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5 The Restore Data Files window allows you to check that the file you are 
restoring is correct and that the destination for the file is correct.  The 
FROM section should display the drive, path and file name of the 
company file you wish to restore. 

6 The TO section should display the current data path for Quicken 
Payroll, which by default is C:\Program Files\QPRoll\Data. If you 
wish to restore your company file to a different location, click Browse 
to locate the folder. 

7 Click OK. If the file already exists in the destination folder, a message 
will be displayed asking you if you want to overwrite the file. Click Yes 
if you want to continue.

8 The company file will be restored. Quicken Payroll will open the 
company file when the restoration is complete.

For further information about restoring your company file, restoring from 
an automatic backup and recovering a corrupt data file, see Restoring your 
company data on page 320.
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Setup Network Data Path 
Setup Network Data Path copies your existing data files, reports and tax 
scales to any folder on a network drive.  It is also used to direct other 
computers to that network location so that they can access the company 
files. This must be done so other computers on the network can access the 
company files. 

This command is only available if you have registered for use in a multi-
user environment.

Before you can set up the network data 
path, you need to:
1 Set up Quicken Payroll on each computer.

2 Obtain a multi-user licence and register all copies of Quicken Payroll 
for a multi-user environment. See Registering Quicken Payroll for a 
multi-user environment on page 26.

3 Create a folder on your network drive so Quicken Payroll can copy the 
files across.  If the folder does not exist, the Quicken Payroll files will 
be copied to the wrong location.

See Setting up Quicken Payroll on a network on page 20 for step by step details 
on using this menu option when installing Quicken Payroll on a network.
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Archive Data 
Archiving data reduces the size of your company file by allowing you to 
remove a range of pays and employees from your current file. Archiving 
information out of your current company file is a quick and easy way of 
speeding up Quicken Payroll.

Once removed, the pays and employees cannot be accessed in the current 
company file.  Archive files are always treated as separate company files. 
Remember though to keep the archive in a safe place, just in case the ATO 
decides to audit you or you need the information for some other reason.

To archive pays or employees from your company file 

We recommend that you only remove pays and employee records for 
terminated employees and that you only do this after the end of your 
financial year.

1 Choose Archive Data from the File menu to display the Archive Data 
window.

2 On the Archive Data tab, specify the ranges of information you wish 
to archive: 

From Emp – Enter the employee number to start at.  

To Emp – Enter the employee number to finish at.  
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From Pay Date – Enter the pay date to start at.  

To Pay Date – Enter the pay date to finish at.

3 In the Files section – From field, Quicken Payroll will display the drive, 
path and name of the file it will be archiving information from.  These 
details cannot be changed.

4 In the Files section – To field, Quicken Payroll will display the drive, 
path and name of the archive file. 

5 If you want the archive file to be placed on a different drive, in a 
different path or to be called a different name, click Browse.  If the 
drive, path and file name are correct go to the next step.

Note You should change the archive name so the last two letters, before 
the “.QPB” indicate the year the archive was created. For 
example, if archiving 2000 data, you would change a file named 
MyCompany.QPB to MyCompany00.QPB.

Under Drives, select the drive where you want the archive file to be 
placed.

In the Folders section, which is just above Drives, select the folder 
where the archive file should be placed.  If you do not want it to be 
copied to a folder, do not select a different folder. 

Click OK.

6 Click on the Advanced tab.

7 Data to be Copied to Archive File – Select the information that you 
want to include in the archive file.

Archive Terminated Employees And Their Pays – Select  this option 
if you want to remove only terminated staff from your company file.  
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Archive All Employees And Their Pays – Select  this option if you 
want Quicken Payroll to copy details for all employees to the archive 
file.

8 Data to be Removed From Currently Open Existing Company – Select 
the information that you want removed from the company file:

Remove Employees From Current Company – Select  this option if 
you want the employee details, such as name, address, or pay rates, to 
be removed from the company file. Any employees with a number 
falling between the numbers specified in From Emp and To Emp will 
have their details removed from the company file.

Remove Pays From Current Company – Select  this option if you 
want the employee's pays to be removed from the company file.  Any 
pays with a pay date falling between the dates specified in From Pay 
Date and To Pay Date will be removed from the company file.  By 
default, Quicken Payroll will set these dates for the previous financial 
year.

9 Click OK to archive the data, or cancel to exit without archiving.

10 Quicken Payroll will display a progress bar that shows how far along 
it is in removing the information from the current company file. When 
finished, the List Employees window will be displayed.
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Preferences
Preferences allow you to specify which features of Quicken Payroll you 
want to use and to set up certain default values.  Most of these settings 
were originally set up through the Configuration Wizard.

You can set your preferences for:

 General items, such as rounding and turning features on or off.

 Payroll Tax calculations.

 Superannuation items such as the superannuation threshold for your 
state and the type of employees this threshold applies to.

 Leave items relating to how leave is accrued and displayed.

 Printing items relating to the number of pay slips on a page and the 
type of Payment Summary to print.

 Export details relating to which account to use when the information 
is sent to QuickBooks and which QuickBooks file the payroll data is 
transferred to.

 File items relating to the creation of Electronic Funds Transfer files, 
EmpDupe files and backup files.

Changing preferences
To change preferences, open the Preferences window by doing one of the 
following:

 Click the Preferences toolbar icon; 

 Click Preferences on the Navigator Company Information tab; or

 Choose Preferences from the File menu. 

To view and edit preferences for each section, click the icon on the left-
hand side of the Preferences window.
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General preferences 

General preferences control which features are available within Quicken 
Payroll, the rounding applied to pays, the default commissions period and 
even lets you change Quicken Payroll’s window textures.

Select  any of these options to enable the feature.  If you don't want to 
use a particular feature, clear  the option and all references to the feature 
will disappear until you re-select the preference.

Enable Payroll Deductions – Select  this option if you want deductions 
to be available when you are setting up employees and awards, processing 
pays and printing reports. 

Enable Payroll Allowances – Select  this option if you want allowances 
to be available when you are setting up employees and awards, processing 
pays and printing reports. 

Enable Commission/Bonus Calculations – Select  this option if you want 
bonuses and commissions to be available when you are setting up 
employees, processing pays and printing reports. 

Enable Payroll Sundries – Select  this option if you want sundries to be 
available when you are setting up employees and processing pays. 

Enable Electronic Funds Transfer – Select  this option if you want to be 
able to transfer your employee's pays directly from the company's bank 
account to their bank account. 

Select the program 
features that you will be 
using.

Click on any of these icons to 
display that section of the 
Preferences.
166 CHAPTER 7 - Finding your way through Quicken Payroll’s menus



Enable Workers Compensation – Select  this option if you track workers 
compensation claims and payments. 

Enable Employees Notes – Select  this option if you need to enter 
information for each employee, such as performance review notes or 
official warning. 

Link to QuickBooks – Quicken Payroll can automatically transfer your 
employees' pay details to QuickBooks (v8 or v9). Select  this option if you 
want Quicken Payroll to automatically transfer your Quicken Payroll data. 
If not selected, Quicken Payroll creates an export file—an IIF (Intuit 
Interchange Format) file that you can easily import into QuickBooks.

Before you select this option, you must select the QuickBooks file on the 
Preferences > Files tab, and you must have installed and registered 
QuickBooks. 

Enable Next-of-Kin Details – Select  this option if you want to track the 
employee’s next of kin details.

Enable WorkCover – Select  this option if your state has the compulsory 
workers compensation fund WorkCover (currently SA and QLD only).  
Quicken Payroll will calculate WorkCover for each employee. 

Enable Spreadsheet Entry – Select  this option if you want to use 
Quicken Payroll's spreadsheet entry feature which allows you to enter the 
hours for a large number of employees on one easy-to-use spreadsheet -
style window. Use this method if you have a lot of employees whose hours 
vary each period, such as casual employees

Enable Timesheet Entry – Select  this option if you want to use Quicken 
Payroll's Timesheet entry feature, which allows you to enter employee 
hours by entering their shift start time and the finish time. Use this method 
if you have employees that are paid according the time they start and 
finish a work shift.

Enable Customer:Jobs / Classes – Select  this option if want to be able to 
cost your employees to a specific customer and job or class.

Enable Payroll Tax Calculation – Select  this option if want Quicken 
Payroll to calculate your payroll tax.
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Edit Past Pays – Editing past pays can result in gross and tax amounts for 
previous months differing from amounts originally reported. To help 
prevent inadvertent changes, you cannot edit a past pay unless the  Edit 
This Pay check box has been selected on Pay windows. The default setting 
can be selected here. See Editing a past pay on page 248.

Select  this option if you want to edit previous pays. To prevent previous 
pays from being edited, leave this check box blank.

Enable Custom Fields – Select  this option if want to include a custom 
fields tab on your employee records.

Use Textures On Windows – All of Quicken Payroll's windows come with 
a background graphic, referred to as a texture on them. You can remove the 
texture by clearing  this check box to turn the texture off, resulting in a 
grey background. 

Colour Scheme – Colour schemes add colour to Quicken Payroll. You can 
select any colour scheme you prefer, including the default scheme, 
Quicken or QuickBooks classic, windows standard, or one of any of the 
schemes listed. Try a few of them to see which you prefer—as you select 
each scheme, you can see the changes immediately on screen.

Round net pay by – If you prefer, Quicken Payroll lets you set the rounding 
value for net pay.  The default is to round net pay to the nearest 5 ¢, 
however, you can set net pay rounding to any amount you want. The 
PAYG tax amount is adjusted to round net pay to the specified amount. 

Commission Sales Period For Tax: – Set the default period to be used when 
calculating tax on bonus or commission payments. The commission period 
must be entered so that PAYG is calculated correctly.  When you pay 
commissions or bonuses, this default period will be entered, but if 
required, you can change the commission period when you pay the 
commission.
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Tax preferences 

Tax preferences controls how your payroll tax is calculated and whether 
payroll tax is paid on superannuation and WorkCover (SA and QLD only) 
calculations. 

Payroll Tax Paid In – To change the payroll tax thresholds and percentages, 
select your state from the drop-down list. 

Note  If you employ staff in other states or your company pays payroll 
tax as part of a group, Quicken Payroll will not calculate the 
payroll tax correctly.  It only calculates the correct amount of tax 
for the state you have selected.

Payroll Tax On Employer Super – In some states you must include all 
employer superannuation contributions in payroll tax calculations. 
Select  this option to include employer superannuation in the payroll tax.

Payroll Tax On WorkCover – Select  this option if your state requires you 
to include WorkCover in your Payroll Tax calculations.

GST Rate on WorkCover – If GST applies to WorkCover, enter the rate.

FBT Rate – You must record the value of fringe benefits provided to your 
employees. You may also need to report a value of benefits on the 
employees’ Payment Summaries. Quicken Payroll calculates the grossed-
up Reportable FBT Amount and reports it on the employee’s Payment 
Summary.

Low rate threshold – Enter the Low Rate Threshold for your state.
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Superannuation preferences 

Superannuation preferences control how superannuation is calculated for 
your employees. You can change the Employer SGC Percentage for 
individual employees, but the other preferences will apply to all 
employees.

Monthly Super Threshold On Permanent, Part Time or Casual employees 
Select  which employees the threshold will be applied to.

Calculate S.G.C. on Salary Sacrifice Amounts – When this option is 
selected , Superannuation Guarantee Contribution is calculated based on the 
employee’s gross wages before salary sacrifice. When unselected, SGC is 
calculated on the after-sacrifice gross wage amount.

Exclude Super from WorkCover Calculations – When this option is 
selected , WorkCover is calculated based on the employee’s gross wages 
plus employer superannuation contributions.

Pay Super If Monthly Gross More Than – Specifies that super will not be 
paid if the employee’s their gross pay is under this threshold. When an 
employee's monthly gross pay equals or exceeds the threshold amount, 
Quicken Payroll calculates super contributions on the full gross amount.

Employer S.G.C. Percentage – This is the minimum superannuation 
contribution that you must make on behalf of each employee. You can 
specify a default employer superannuation percentage that will apply to 
all employees. The S.G.C. applies to most employees. See S.G.C. exempt 
employees on page 203 for exemptions.

Select  which employees the 
super threshold applies to.

The super threshold is the 
amount that employees must 
earn before you have to pay 
employer super for them.

Enter the SGC percentage. 
SGC is the minimum 
superannuation contribution 
you must make on behalf of each 
employee.

S.G.C.

Superannuation Guarantee 
Contribution (SGC) is the 
minimum amount of super 
contribution that you must 
make on behalf of each 
employee

G l o s s a r y T e r m
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Leave preferences 

Leave preferences allow you to specify if special leave or rostered days off 
(RDO) should accrue when an employee takes leave.

Accrue During Annual Leave – Selecting  this option if you want  to 
accrue special leave or RDO while the employee is on annual leave.

Accrue During Sick Leave – Selecting  this option if you want  to accrue 
special leave or RDO while the employee is on sick leave.

Accrue During Unpaid Leave – Selecting  this option if you want to 
accrue special leave or RDO while the employee is on unpaid leave.

Printing preferences 

Printing preferences allow you to set default paper size for reports and 
control how Pay Slips and Payment Summaries are printed.

Selecting Plain Paper will 
change the Payment 
Summary Navigator, so that 
it shows all the steps 
involved in lodging your 
Payment Summary 
electronically.
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Default Paper When Creating Reports – If you create reports you can set 
the default paper size.  To set the paper size, select a paper size from the 
drop-down list.  The paper sizes listed are the ones that are available 
through the Windows default printer.  If a paper size does not exist in the 
drop-down list, your printer does not support that paper size.

Pay Slip Type – Specify how many pay slips print on a page.

1 Pay Slip Per Page – This pay slip can be folded to fit into a window 
envelope if you need to mail it to your employees.  This format prints 
on blank paper and does not require any pre-printed forms.

2 Pay Slips Per Page – This pay slip format is designed for the pre-
printed security envelope forms. These are useful if you wish to place 
money in them. You must have a dot matrix printer to print on the 
security envelope forms.  If you wish, these pay slips can be printed 
on plain paper. 

3 Pay Slips Per Page – This pay slip format is designed for the pre-
printed 3 per page forms.  You must have an InkJet or Laser printer to 
use these forms.  If you wish, these pay slips can be printed on plain 
paper.

Style – When printing pay slips, you can choose between Plain, Classic, 
Graphics format, or Security Payslip formats.

 Plain – This format meets the new legal requirement.

 Classic – To be used only if you have old pay slip forms,

 Graphics – The new format with a graphic background.

 Security Payslip – To be used with Laser or Security Pay slip forms, 
which provide a sealed pay slip and a paymaster copy.
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Payment Summary Type – Specify how your Payment Summaries print.  
This also affects how the Payment Summaries tab on the Navigator 
appears.

Selecting  Plain Paper will allow you to print your Payment Summaries 
on plain paper and will change the Payment Summaries tab on the 
Navigator to display all the steps required to lodge your Payment 
Summaries electronically. If you print your Payment Summaries on plain 
paper, you are required to lodge the ATO copy electronically. For details, 
see Create EmpDupe File for ATO on page 303.

Selecting  Stationery will change the Payment Summaries Navigator to 
display all the steps required to print your Payment Summaries on to the 
stationery supplied by the ATO.

Note When you select Stationery, the Payment Summary report will 
appear onscreen with the lines and boxes that appear on the 
actual form. These are displayed to make the form easier to 
understand, but they are not actually printed. Only the text will 
be printed.
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Export preferences 

Export preferences control the accounts that are used when you transfer 
your payroll information to QuickBooks. Export preferences are disabled 
until you have installed and registered QuickBooks.

Quicken Payroll has a default set of payroll asset, liability and expense 
accounts.  If you haven't yet set up payroll accounts in QuickBooks, 
Quicken Payroll will transfer the standard payroll accounts over to 
QuickBooks when you export the payroll data. In most cases, you won’t 
need to do anything on this window.

These are the QuickBooks accounts 
that Quicken Payroll will export 
payroll data to. To change the export 
account, select the account from the 
pull-down list.

If the QuickBooks accounts you want 
to export to are not listed, you can 
import your QuickBooks accounts by 
choosing Import QuickBooks lists 
from the Activities menu.
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Files preferences 

File preferences control the company file backup and QuickBooks data file 
paths.  If you plan to print your payment summaries on plain paper, you 
also need to enter a contact name.

Backup Details – When you exit Quicken Payroll, the backup window is 
displayed.  You can change the default backup drive and folder.  The 
default is to backup to your floppy disk drive A. To change the default 
backup path of your company files, you can do the following:

1 In Backup Drive, type in the drive letter of where you want your 
company files backed up to.  The drive letter defaults to A, this is your 
floppy disk drive. You should not backup to the same drive that your 
company file resides on. If the drive with your company file goes 
down, you will not have a backup to restore your company file from.

2 In Backup Name, type in the directory path where you would like 
your company file backed up to and the file name that you want the 
backup file to use. The default backup file is a:\{Filename}.QPB 

QuickBooks Data Files – If you selected  Link to QuickBooks in the 
General Preferences and you select a QuickBooks file from the Data File 
drop-down list on this window, Quicken Payroll will automatically send 
your payroll information across to QuickBooks. You can specify how the 
data is to be sent using the Export Payroll Data to QuickBooks command 
(see page 279). This feature is disabled until you have installed and 
registered QuickBooks.

To back up your company file to a 
drive other than the default drive 
(A:), enter the drive letter here.

Enter the QuickBooks file you 
want to export payroll data to.

If you are paying employees by 
EFT, contact your bank to find
out how to set these options.

If you print your Payment 
Summaries on plain paper, you 
must lodge the ATO copy 
electronically.
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Electronic Funds Transfer Options – When you send your EFT files (also 
known as ABA files) to your bank, you need to ensure that the Electronic 
Funds Transfer Options are set correctly for the bank.  Each bank uses a 
variation of the Australian Payments Clearing Association (APCA) 
specifications and only your bank will be able to tell you which of the four 
items are needed.

Depending on which banking institution you use, you may need to turn 
on, or off, certain fields within the EFT file.  The Electronic Funds Transfer 
(EFT) Options allow you to specify what sections should or shouldn't be in 
the EFT file.

Tip If you cannot contact your bank, see Changing the EFT options if 
your bank will not accept the EFT file you are sending them on page 
100.

If Sending Payment Summaries On Disk (EmpDupe) and printing on 
plain paper – If you have chosen to print your Payment Summaries on 
plain paper, you will be required to lodge the ATO copy electronically.

Supplier Number – You don’t need to enter a supplier number anymore 
ABN has replaced the supplier number. This field is for your own records 
only.

Contact Name – This is the name that will appear as the Authorised Person 
on the Payment Summaries and as the Contact Name in the EmpDupe file.
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Utilities – Rebuild Data Files  
Rebuild Data Files may be able to help you resolve some simple data 
corruption problems caused by a power failures, power surges, a locked-
up computer, computer crashes, or other such problems.

There are some forms of corruption, such as data restored from a damaged 
floppy disk, which require a more intensive recovery process.  In this 
situation you will need to send your data file to our Data Recovery 
department.  Please contact Technical Support for details.

To rebuild the company file
1 Make sure to explore all other avenues to resolve the problem and 

contact Technical Support before you rebuild your data files. 

2 Backup your company file.  Always make sure that you have a backup 
of your data file that has not been run through the rebuild process.  If 
your data is so corrupt that the rebuild process cannot fix it, we may 
be able to recover most of your data from a clean backup. For details 
see Backup Files on page 158.

3 Choose Utilities>Rebuild Data Files from the File menu.

4 Click Rebuild Data Files. You will be prompted to backup your 
company file.  Make sure you do so, on a different set of floppy disks 
to the backup you made in Step 2.

Contact Technical Support before you rebuild your files

Some options have the potential to irreversibly damage your data file.
Technical support will advise of which options to use and make sure
that you have explored all other data recover options first.
Always back up your company file before you rebuild!

The Rebuild utility can fix your data file, but in some cases it may make
it even worse, so please ensure you have a working backup of the
company before running this utility. 
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5 Once you have backed up your data, the File Maintenance window will 
appear.  Select the options advised by Technical Support and then click 
OK.

You should only select any of the following four options if Quicken 
Payroll Technical Support has advised you to.

Rebuild Record Positions and Keys – Every record in the 
database will be checked (pays, allowances, etc) to ensure that 
each record is associated correctly. If a record has an invalid key or 
record position Rebuild will attempt to change the key or record 
position to the correct value.

IMPORTANT – You should never use this option unless Quicken 
Payroll Technical Support has asked you to. Using this option on a 
badly corrupted data file is not recommended.  You may cause 
irreversible damage to the data file that even our Data Recovery 
Department won't be able to fix.

Fix Invalid Employee Records – Every employee record will be 
checked to ensure that it is not corrupt.  If the record is corrupt, 
Rebuild will attempt to fix the employee record.  This may or may 
not work, depending on the type of data corruption you have.

Fix Invalid Pay Records – This should only be used when file 
problems have occurred when upgrading from Quicken Payroll 
version 3 or earlier version.

Fix or Remove Invalid Other Records – All records (apart from 
employee records) will be checked to ensure they are correct.  If 
possible, Rebuild will attempt to correct corrupt records.  If it can't 
fix them they will be removed from the file.

Select options marked 
with an asterisk (*) only if 
you advised to do so by 
Quicken Payroll Technical 
support.
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IMPORTANT Always check your file after this has been run to 
find out what records, if any, have been removed from your data 
file.

6 The following options can be run without risk if your data has become 
corrupted.

Rebuild Super – This option recalculates superannuation and 
removes any invalid (blank) superannuation records.

Recalculate Super – This option recalculates superannuation for 
all pays.

Recalculate YTD Figures – Rebuild will go through all the pays 
for the current financial year and recalculate the year-to-date 
figures for the current financial year.

Recalculate Leave – Rebuild will go through every pay and 
employee and recalculate the amount of leave accrued.

Recalculate Banking – Rebuild will go through every employee 
and pay and adjust the banking details to match the employee 
record.

Recalculate Pay Allowances – Recalculates allowances for all 
pays.

7 Quicken Payroll will start the rebuild process.  When the rebuild has 
finished, you will be returned to the List Employees window.

8 You should now check the company details, employee details and 
especially pays to ensure that all records are correct, because the 
rebuild process is only as good as the data it has to work with. In cases 
of severe corruption, you may find that some employees and pays are 
mixed up.

If Rebuild does not solve the problem
If the rebuild utility does not fix your company file you should contact 
Technical Support again for assistance and to obtain details about the Data 
Recover Service. See Accredited Trainers on page 334 for the Technical 
Support phone numbers.
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The Lists Menu

Companies List  
The Companies list displays the companies currently set up within 
Quicken Payroll.  When you select a company from the list, it doesn't open 
the company file, but opens the Update This Company window which 
allows you to edit company details for that company.

Editing company details
1 You can edit company details by doing any one of the following:

Choose Company Information from the Navigator Company 
Information tab;

Choose Company Information from the File menu; or

Choose Companies from the Lists menu, select the company 
you want to edit details for and then click Companies>Edit.

2 Edit company details on the Update  This Company window.  Company 
details are entered through the following sections:

Name tab Company name, trading name, disk file name and 
address (see page 181).

Numbers tab Company phone and fax and ACN/Australian Busi-
ness Number (see page 182).

Banking tab Bank and account details (see page 183).

Insurer tab Workers Compensation or WorkCover Insurer details 
(see page 184).
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Name tab  
This section allows the modification of the company details that were 
entered using the Company Wizard. 

Company name – can be up to 76 characters in length.

Trading Name – can be up to 76 characters in length.  If you trade under a 
name other than the company name, enter it here.

Disk File Name – is your company name, up to 76 letters.  The file name 
cannot be changed: it is displayed so you can see where the file is located.
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Numbers tab  
If the telephone or fax numbe, ACN, or Australian Business Number (ABN) 
for your company needs adjusting, change them here.  This information 
must be entered so all printed documents contain the correct information.

Phone and Fax Numbers –  can be straight numbers, or can contain 
brackets, dashes, or spaces—for example (02) 5555 - 5555

 ABN (or Payer Withholding) number – The ABN is the identifying 
number you will use in dealing with the ATO on PAYG, GST and other 
elements of the tax system. You must have an ABN in order to claim GST 
or to add GST to an invoice. 

ACN number – The Australian Company Number (ACN) is supplied by 
the Australian Securities and Investments Commission when the company 
is listed as a Proprietary Limited (Pty Ltd) company.  If the company has 
an Australian Registered Business Number (ARBN), enter it in the ACN 
field. 
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Banking tab  
If you intend to pay your employees by having their wages deposited 
directly into their bank accounts using Electronic Funds Transfer (EFT), 
you must  complete your company's banking details. 

Code – Select the bank account that is used to pay your employees.  
Quicken Payroll includes all the bank codes available at the time of product 
release.  If your bank is not listed, add it through the Bank Codes list. 

Branch – Enter the name of the branch where your bank account is located.

BSB Number – Each branch of a bank has it's own ID number, called the 
BSB (Bank State Branch) Number. The BSB number is six digit number 
shown before the account number on a cheque.

Account Number – Enter the account number for the bank account that is 
used to pay your employees. The Australian Payment Clearing Association 
(APCA) specifies that the account number is a maximum of nine digits. 
Some small banking institutions, such as credit unions, have created their 
own file format specific to them.  Quicken Payroll only supports the 
Australian standard. This number can be up to nine characters long. 

Banking details MUST be entered if you want to pay wages by EFT.

APCA Number – Your company's Australia Payment Clearing Association 
(APCA) number is issued to your company by the bank.  It is used to 
identify your company when you send the EFT file to your bank.
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Insurer tab  
Enter your Workers Compensation Insurance company details.  In SA and 
QLD enter your WorkCover insurer details.  These details will automatically 
be copied to each new employee and used whenever a workers 
compensation or WorkCover claim or payment is entered.

Name and Address – Enter your insurance company's complete name and 
address.

Telephone and Fax numbers – can be straight numbers, or can contain 
brackets, dashes, or spaces, for example (02) 5555 - 5555.

Deleting a company file 
When you delete a company file, the company file and all of the data 
contained within the file are removed from the hard drive.  You will not be 
able to restore the company file unless you have made a backup file to 
restore from, so it is crucial that you always make a backup file before you 
delete your company file.

You can only delete the company file for any company other than the 
company currently open. Therefore, to delete one company, you must 
have a different company open; if you only have one company, you can 
open the sample company.

To delete a company and remove all of the data from the hard drive, click 
Companies>Delete.  The company that is open cannot be deleted.
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 Click OK to confirm you really do want to delete the company from 
your hard drive.

 You will be prompted to backup your company file.  If you wish to 
access the company information at a later date, be sure to backup the 
file.  Click Cancel at this point if you don't want to back the file up and 
you just want to delete it from your hard drive.  If you click OK to 
backup the file, Quicken Payroll will backup to your selected 
destination and then delete the company file.

Note Once the company data file has been deleted, you can only access 
the information by restoring the backup. 
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Employees List  
The Employees List displays all of the employee records for the currently 
open company. You can set up employee records from the Employees List, 
but we recommend that you use the Employee Wizard—not only is it 
quicker, but it will ensure that you enter all of the required information. 

Select this menu item, select Employees from any Navigator or click the 
Employees toolbar icon to display the List Employees window.

Sorting the Employees List
When you view the employee list, you will notice a blue arrow in one of 
the headings.  This arrow indicates which column the employees are being 
sorted by and what order they are being sorted by.

In the above example, when the Name column has the blue arrow in it, the 
list is sorted by employee name. With the arrow pointing up, the list is 
sorted in ascending order (A to Z).  With the arrow pointing down, the list 
is sorted in descending order (Z to A).

To change the sort column, click in the heading of the column you want to 
sort by.  By default Quicken Payroll will sort in ascending order.  To sort in 
descending order, click the column heading again.

Sort by clicking on a heading
Resize a column by dragging 
the column marker
Select an employee and then 
right-click, or select a function 
from the appropriate button 
below.
Click to display Edit 
functions, Activities, or 
Reports

Simply click any column to 
sort by that heading. Click 
again to reverse the sort order.
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Finding an employee 
You can find an employee by clicking on the column heading to sort by 
that column and then scrolling down. To help you locate a specific 
employee, you can also use the Scroll bar. When you click and hold the 
mouse button down on the button in the scroll bar, a window will appear 
displaying the position on the column selected for sorting. 

Viewing an employee's Pays
To view an employee's pays you can either right mouse click on the 
employee's name, or select the employee and click Activities>Show 
Employee Pays. The List Pays window is displayed.

Adding an employee record 
Before creating an employee we recommend that you set up awards.  This 
will speed up creating an employee's pay and leave details. 

You can add employees through the employee list, however, we 
recommend that you add them through the Employee Wizard, because it 
takes you step-by-step through the process of adding an employee and 
ensures that you complete all of the required details. 

As you scroll down on the list, the 
position on the column selected for 
sorting appears. This is a quick 
way to find a particular employee.

Right mouse click on an 
employee name, or select the 
employee name and click 
Show Employee Pays to 
display the pays for the 
employee.
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To add an employee record through the Employee list, click 
Employee>New to display the Add Employee window.   Starting with the 
Personal tab, complete each section of the employee record. Press F1 while 
the employee record is open for further information on each section, or see 
the sections below. 

Editing an employee record
To edit an employee record, double click on the employee name, or click to 
select the employee name and then click Employee>Edit.  When the Edit 
Employee window appears, click on the tab that you want to edit details in.

Deleting an employee record
If a pay has been processed for an employee, the Delete option will be 
disabled and you will not be able to delete the employee. To delete an 
employee record, click on employee name so it is highlighted, click 
Employee>Delete and then click OK to confirm that you want to delete 
the employee.

 Personal details page 189  Company details page 191

 Dates page 193  Pay Rates page 194

 Deductions page 196  Allowances page 198

 Taxation page 200  Superannuation page 202

 Banking page 204  Leave page 206

 Workers Comp. page 208  Compensation page 208

 Next-of-kin page 209  Notes page 210

 Fringe benefits page 211  History (YTD) page 212

 Custom fields page 212
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Personal details  
The employee's Personal details window requires you to enter the 
personal and contact details for the employee. If you intend to export your 
superannuation details (see page 285), you must enter all details.

Title and Gender – Title and gender are optional fields.

First Name and Surname – can be up to 25 characters in length.  These are 
required fields. The middle initial is optional.

Address – Enter all details, including city, state and postcode.

Home Telephone – Enter the employee's home telephone number, 
including the area code.  The area code is transferred to your 
superannuation company.

Date of Birth – Enter the employee's date of birth in the format ddmmyyyy 
or ddmmyy. For example, enter 150158 for 15 January, 1958. Alternatively, 
you can select a date by clicking on the date icon.

Pay Employee Using – Select the pay method you wish to use to pay the 
employee:

 Normal – Use this method for employee whose hours and pay details 
are usually the same each pay period. 

When you prepare the employee’s pay, the employee’s hours, pay 
rates, allowances, deductions and most other pay details will come 
direct from the employee record. You will only need to modify the pay 
if you need to adjust the hours for this pay period, or if you want to 
add leave taken, sundry items, commissions or bonuses.

For details, see The Normal Pay window on page 55.
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 Spreadsheet – Use this method if you have a lot of employees whose 
hours vary each period, such as casual employees. This method allows 
you to enter the hours for a large number of employees on one easy-
to-use spreadsheet -style window. 

The employee’s pay rates, allowances, deductions and most other pay 
details will come direct from the employee record. When you prepare 
the employee’s pay, you will also need to enter any leave taken, 
sundry items, commissions or bonuses for the current pay period.

For details, see The Spreadsheet Entry window on page 78.

 Timesheet – Use this method if you have employees that are paid 
according the time they start and finish a work shift. Once you have 
set up the award details, you only need to enter the start time and the 
finish time.  Quicken Payroll will calculate any breaks as well as the 
different rates (such as overtime rates) that apply between the times 
that you specify.

For the timesheet to work you need to have the employee's award set 
up correctly. 

Allowances, deductions and most other pay details will come direct 
from the employee record. When you prepare the employee’s pay, you 
will also need to enter any leave taken, sundry items, commissions or 
bonuses for the current pay period.

For details, see The Timesheet Entry window on page 71.

Employee Photo – If you have access to a scanner you can add a photo to 
each employee record.  To add a photo, click on the box under Employee 
Photo.  Then select Add, or Change Photo.  Locate the photograph graphic 
file, click on it and then click OK. The photo can be in bitmap, PCX or JPeg 
format. We recommend that you use JPEG format, because they use 
considerably less memory and hard drive space than bitmap or PCX 
format graphic files. For example, one of the photos used in the sample file 
was 16 times larger in bitmap format than in JPEG format.
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Company details  
The Company details relate to the employee’s position within the 
company.

Employee number – When you set up a new employee, Quicken Payroll 
automatically enters a sequential employee number. However, you can 
enter any unique number between 1 and 999,999. You can not change the 
employee number after you have saved the employee record.

Work Telephone – Be sure to enter the area code because this number is 
required by the employee's superannuation company.

Status – Select the status of the employee—Permanent, Part-Time or Casual. 

If the employee has been set up as a contractor, you cannot change the 
status employee, nor can you change the status of an employee to contractor.  
You must terminate the employee and then create a new employee record 
with an employee status of permanent, part-time or casual.

Pay Period – Select the pay period for the employee. For Weekly there are 
52 pay periods per year, 26 for Fortnightly, 24 for Bi-Monthly and 12 for 
Monthly.

Award – Select the award the employee works under.  If the award is not 
listed, just type in the name and the Adding a New Award window will be 
displayed. 
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When you select an award, you must also select a classification. Pay details 
will be carried over from the award, including pay rates, pay period, leave 
type, annual leave loading, allowances and superannuation calculation 
details.  

Quicken Payroll will ask you if you want it to enter the default pay rates, 
leave details, allowances, etc. If you want these details filled in for you, 
click Yes. For more details on awards, see Awards List on page 219.

To delete an award, click on the award name, press the keyboard Back 
Space key to delete the award name and then press TAB. 

Classification – To apply award rates, you must also select the 
classification the employee is under.  The classification is normally related 
to the employee's job title. If you selected an award, you must also select a 
classification.

Department – Select the department the employee works in. To create a 
new department, type in the name and then press TAB.  Click Setup on the 
Quick-Add window to add the name to the Departments list.

Position – Enter the name of the position this employee occupies within 
the company. To create a new position name, type in the name and then 
press TAB.  Click Yes on the Quick-Add window to add the name to your 
drop-down list. This is an optional field.

Reports to – Enter the position this employee reports to. If the name is not 
set up yet, type in the name and then press TAB.  Click Yes on the Quick-
Add window to add the name to your drop-down list. This is an optional 
field.
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Dates  
The Dates section tracks significant employment dates.  As a minimum, 
you must enter the Date Started date so Quicken Payroll can correctly 
calculate leave and termination pays.

Enter all dates in the format ddmmyyyy or ddmmyy. For example, enter 
150100 for 15 January, 2000. Alternatively, you can click on the date icon to 
select the date from a Q-Date window.

Date Started – You must enter the date that the employee started working 
for your company. If it is not entered, Quicken Payroll has no way of 
determining how long the employee has worked for the company.  This 
will cause leave to accrue incorrectly and termination pays will be 
incorrect, as the leave pay out will not be calculated properly.

Date Casual – Enter the date that the employee became a casual employee.   
If employee is not casual, leave it blank.  This date is sometimes the same 
date as the date they started working for the company.

Date Part-Time – Enter the date that the employee became a part-time 
employee. If employee is not part-time, leave it blank.  This date is 
sometimes the same date as the date the employee started working for the 
company.

Date Permanent – Enter the date that the employee became a permanent 
employee.  If the employee is not permanent, leave it blank.  This date is 
sometimes the same date as the date the employee started working for the 
company.

Termination Date – This field is only active if the employee has been 
terminated and the date is automatically entered when the employee is 
terminated using the Termination Wizard.
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Pay Rates  
The Pay Rates section specifies the pay rates that apply to the employee, 
the basis on which pay is calculated (per hour, year or item) and the default 
hours worked for the pay period. Any pay rates entered here will 
automatically appear in the employee's pay each pay period. For each 
employee, you must as a minimum enter the employee's “Normal Hours” 
pay rate details.

If you selected an award and classification on the Company Details window, 
the details for this window will be transferred from the award.

Use Award Pay Rates – If you select  this option, Quicken Payroll will use 
the award rates when calculating the employee's pays. If you clear  this 
check box, Quicken Payroll will use the rates that you set up in the Pay 
Rates section when calculating the employee's pays. In order to apply 
casual loading (page 223) to this employee, you must select this option.

If you enter amounts in the Hrs/Qty and Amount columns before you select 
the Use Awards Pay Rates option, when processing a pay, Quicken Payroll 
will use the hours from the first Normal Hours pay rate entered here.

Pay Rate – On the first line select the pay rate Normal Hours, or another rate 
designated as a Normal Hours rate. After you have entered a Normal Hours 
rate, you can enter as many additional pay rate types as required.  

Pay Rate Type – Select Hourly Rate for employees who are paid by the 
hour.  Select Salary for employees who are paid a fixed dollar amount for 
each pay period the employee works. Select Annual Salary for employees 
who are paid a fixed dollar amount for the year.

You must enter a Normal 
Hours pay rate on the first 
line.

Normal Hours pay rate

The term “Normal Hours” 
pay rate has special 
meaning in Quicken 
Payroll. The Normal Hours 
rate for an employee is the 
base rate of pay that other 
rates (such as double time) 
are based on. It is also used 
in awards in calculating 
leave accruals.

G l o s s a r y T e r m
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Note Annual Salary cannot be selected in the pay screen. It can only be 
selected in the award or here in the employee record.  When a 
pay is prepared for the employee, Quicken Payroll calculates the 
pay for the current pay period based on the annual salary and 
displays “Annual Salary” in the Pay Type column.

Hrs/Qty – Enter the standard number of hours worked per pay period. The 
hours entered here will automatically appear in the employee's pay each 
pay period.

 For employees paid a salary, including annual salary, you must enter 
the standard number of hours worked per pay period if leave is 
calculated based on the number of hour worked. 

 For employees paid under the Timesheet or Spreadsheet methods, you 
don't need to enter the hours because you will be entering the hours 
when you prepare and process the pays. Likewise, if the employee is 
paid by the Item and the number varies each pay period, you don't 
need to enter the hours here.

 If you set up overtime rates, rates such as Time & ½ and Double time, 
make sure that you don't enter any hours in the Hours column, 
otherwise, the employee will be paid that number of hours overtime 
each pay period.

Amount – Enter the amount, which will be an hourly, pay period, or 
annual amount, depending on the pay rate type.

Super – Select Yes if the pay rate is included in superannuation 
calculations.  Select No if the pay rate is excluded from superannuation 
calculations.

Customer:Job – To assign the pay rate to a customer or job, select or enter 
the Customer or job.

Classes – To assign wages paid under this pay rate to a specific class, select 
or enter the class. You can use classes to classify your payroll by 
department, business office or location, separate properties you own, or 
any other meaningful breakdown of your business. 

To add additional lines, TAB to the next line or click Insert.
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Deductions details  
Any deductions that are to be taken from the employee's pay each pay 
period should be entered here. Infrequent or one-time deductions can be 
entered when preparing the employee’s pay. Common examples of 
deductions include union fees, employee loan repayments and child 
support. Note that salary sacrifice deductions are not set up here. Set them 
up through the Super tab. 

Deduction – Select the deduction name.  If the deduction you want has not 
yet been set up, type in the name and then press TAB.  Click Setup on the 
Quick-Add window to add the deduction to the Deductions list.  When you 
select an existing deduction, Quicken Payroll will automatically enter the 
defaults for the deduction.

ID – Enter an identification number for the deduction for this particular 
employee.  That way when you run a report, you can identify which 
employee the deduction came from.

Reducing – If this is a Reducing Balance, select Yes and enter the total 
Balance. The amount that you enter in the Amount column will be 
deducted from each pay until the reducing balance is zero. The last 
payment may be less than the standard deduction in order to bring the 
balance to zero.

Balance – Enter a balance only for reducing balance deductions.

Amount – Enter the amount of the deduction. This amount will be 
deducted from each pay. In the case of Reducing Balance deductions, the 
amount will be deducted until the Reducing Balance has been reduced to 
zero.
196 CHAPTER 7 - Finding your way through Quicken Payroll’s menus



Ex Tax – If the deduction is tax-deductible for the employee—to be 
deducted from gross wages before tax is calculated, select Yes in the Ex Tax 
column.  If it is not tax-deductible—to be removed from the net after tax is 
calculated, select No. Most deductions are not tax-exempt. Make sure that 
any deductions you treat as tax-deductible are done so in accordance with 
ATO rules.

Union – If the deduction is a union fee, select Yes.  This will place the 
deduction in the correct place on the employee’s Payment Summary.  If it's 
another type of deduction, select No.

Note If you have an allowance that you pay both to contractors and to 
your normal staff, you will need to define two separate 
allowances—one for employees that displays the allowance on 
the Allowance section of the Payment Summary and another 
allowance for contractors the includes the allowance in the Gross 
section.
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Allowances details 
An allowance entered here will be added to the employee's pay each pay 
period. Infrequent or one-time allowances can be entered when preparing 
the employee’s pay. Common examples of allowances include items such 
as travel, uniform, tool or mileage allowances. 

Allowance – Select the allowance name.  If the allowance you want has not 
yet been set up, type in the name and then press TAB. Click Setup on the 
Quick-Add window to add the allowance to the Allowances list. 

The allowance calculation involves three columns:

 % or Units – Enter a percentage or a dollar amount per unit.  Use % 
when the allowance is calculated based on a percentage of wages or a 
specific pay rate, such as Normal Hours.

 Based on – Select what the allowance is a percentage of from the drop-
down list.   For example, if you select Wages, the allowance dollar value 
will be a percentage of the total wages for that particular pay. For 
details, see What are the Based On items? in the Quicken Payroll Help 
(choose Search for Help On.. from the Help menu and then type Based 
on into the Index tab).

 Amount – If you selected an allowance based on a percentage of a pay 
item, this field will be calculated and will display the calculated 
amount of the allowance. 

If the allowance is a set amount per pay, or based on a unit such as 
kilometres, enter the number of units, or amount.  The allowance will 
be calculated as the % or Units column X the Amount column.  The 
allowance will be calculated when you prepare the payroll.

You can set up the 
allowance’s PAYG tax or 
superannuation status 
here, but if the allowance is 
Payroll Tax exempt or 
WorkCover exempt, you 
must set that up through 
the Allowances list.
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Examples

Mileage allowance of 35 cents per km – Enter 0 in the % or Units 
column, select Km in the Based On column and then enter 0.35 in the 
Amount column. When you process the pay, enter the number of 
kilometres by editing the pay and entering them in the Allowance tab.

Allowance based on 2% of wages – Enter 2.0 in the % or Units column, 
select Wages in the Based On column and leave the Amt. column blank.

Allowance of $25 per pay – Enter 1 in the % or Units column, select Pay 
in the Based On column and then enter 25 in the Amount column.

Allowance based on hours worked – Enter 0 in the % or Units column 
and select a pay rate from the Based On column, the allowance will be 
calculated as the number of hours worked for that pay rate times the 
amount entered in the Amount column. This will be calculated when 
you process the pay. For details, see How do I pay an allowance based on 
the number of hours worked? on page 62.

Super – Select Yes if the allowance is included in superannuation 
calculations.  Select No if the allowance is excluded from super calculations.

Ex tax – Select  this option if the allowance is not subject to PAYG.  Most 
allowances are not tax-exempt. Notable exceptions include:

 Cents per kilometre car expense payments using ATO rates up to 5000 
business kilometres.

 Award transport payments for deductible transport expenses.

 Overtime meal allowances up to a reasonable amount (as determined by 
the ATO).

 Laundry (not dry cleaning) allowance for deductible clothing up to a 
reasonable amount  (currently $150, but subject to change).

 Travel allowance involving overnight absence from payee’s ordinary 
place of residence up to a reasonable amount (as determined by the 
ATO). An allowance for overseas accommodation is not tax-exempt.

For further details, contact the ATO. Refer also to the Quicken Payroll Help. 
Choose Search for Help On.. from the Help menu and then type “Taxation 
of allowances”.

Customer:Job / Class – You can use Customer:jobs and Classes to allocate 
allowance costs to a particular job, client, or class. 

For the up-to-date details on 
taxation of allowances, 
contact the ATO and obtain 
the following publications:

 PAYE Bulletin No. 8 
Taxing of allowances for the 
1998/1999 and future years

 Taxation Ruling TR 
2000/13: Reasonable 
allowances amounts . 

Taxation of allowances
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Taxation details  
Enter the employee's Taxation numbers and other tax details.  These details 
must be set up before a pay run is commenced.  If you change these details 
after a pay run, the previous pays will not be affected.

Tax File Number – You must enter the employee's Tax File Number. If an 
employee does not have a TFN you must select the Tax File Number Not 
Provided tax scale. Tax will then be deducted at the top marginal rate plus 
the Medicare levy. Some employees are exempt from the requirement to 
supply a TFN. For details, see Tax File Numbers (TFN) on page 112.

ABN number – Enter an Australian Business Number for contractors. You 
must withhold PAYG at the top marginal rate plus the Medicare levy from 
payments made to a contractor that doesn’t supply you with a valid ABN.

Tax Scale – Select the tax scale the employee is to be taxed under.  This tax 
scale will vary depending upon their TFN declaration (previously called an 
“Employment Declaration”).  If you need to enter a custom tax scale, add it 
through the tax scales list. Custom tax scales can be used for sub-contractors 
or employees who have received a special scale from the ATO.

WorkCover – If you are in South Australia or Queensland, select the 
WorkCover rate the employee is under. You can add additional WorkCover 
rates through the WorkCover list.

Payment Summary – This displays the Payment Summary type for this 
employee, based on the type of employee and the tax scale.

Exclude Pays From Payroll Tax – Select  this option to exclude wages 
from payroll tax.  If the employee is an apprentice, their wages may need 
to be excluded from your state's payroll tax. 

For contractors, you need to 
enter an Australian 
Business Number (ABN). 
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Exclude Pays From Payment Summary – Select  this option if you do not 
need to prepare a Payment Summary for this employee. 

CDEP Funding – Wages paid with funds from Community Development 
Employment Projects must be tracked and recorded on a separate line on 
the employee Payment Summary. When this option is  selected, a CDEP 
pay rate will appear in the Employee Record – Pay Rates tab (see page 194).

HECS Debt – Individuals with a HECS debt may be required to have 
additional tax instalment deductions taken from their pay to cover their 
debt. See Higher Education Contribution Scheme (HECS) on page 117 for the 
conditions under which you must withhold HECS payments.

If you must withhold HECS payments, select  HECS Debt to apply 
HECS calculations to the employee’s tax scale. Quicken Payroll will apply 
the HECS tax tables and deduct the required HECS repayments.

SFSS Repayment – Students may obtain additional loans to cover 
educational expenses. These additional cost are called Financial 
Supplement debts and are separate from HECS debts. See Student Financial 
Supplement Scheme on page 118 for the conditions under which you must 
withhold SFSS payments.

If you must withhold SFSS payments, select  SFSS Repayment to apply 
SFSS calculations to the employee’s tax scale. Quicken Payroll will apply 
the SFSS tax tables and deduct the required SFSS repayments.

Labour Hire – Select this option if you are in the business of contracting 
workers out to other organisations. If you  select this option, the 
contractor’s earnings will be reported on a Payment Summary – Labour Hire 
and Specified Payments. 
If this option is not selected for a contractor, the contractor’s earnings will 
be reported on a Payment Summary – Voluntary Agreement. In a Voluntary 
Agreement, the contractor agrees to have you withhold tax payments in 
much the same way as was done under the previous PPS system.

Extra Tax Contribution or Rebate (-ve) – If the employee needs or wants to 
pay extra tax to the ATO, enter it as a positive figure.
If the employee receives a rebate, such as a zone rebate or family 
allowance, you will need to calculate the rebate amount the employee will 
receive each pay period and then enter the rebate as a negative figure in 
Extra Tax Contribution or Rebate (-ve).

Voluntary Agreement

a written agreement 
between a business and a 
worker to bring work 
payments into the PAYG 
withholding system.

G l o s s a r y T e r m
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Superannuation details  
Most employees are entitled to employer-paid superannuation. The 
Superannuation Details window allows you to specify any of the various 
types of superannuation an employee may use. Superannuation can be 
paid a set dollar amount, or an amount calculated as a percentage of pay.

Type – Select the type of superannuation contribution you wish to set up. 

 Employer S.G.C. (Superannuation Guarantee Contribution)
As an employer, you are required to either make the minimum level of 
superannuation contributions (S.G.C.) to a superannuation fund for 
each employees, or pay the Superannuation Guarantee Charge. The 
S.G.C. applies to most employees. See S.G.C. exempt employees on page 
203 for exemptions.

 Employer Optional – Additional contributions the employer may make 
on behalf of the employee.

 Spouse Contribution – Contributions from the employee's net pay to 
their spouse's superannuation fund.

 Salary Sacrifice – An arrangement under which the employee foregoes 
part of their salary and in return has the employer's contributions to 
their superannuation fund increased. It reduces the employee's gross 
wage, tax and SGC is calculated on the reduced gross (depending on 
Super Preferences selected).

 Employer Negative – Allows employers who have made an 
overpayment to receive part of the overpayment back.  Please check 
with your superannuation fund for specific details.

 Employee Negative – As above, it allows the employee to receive part 
of an overpayment made by them.
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 Employee Optional – These contributions are from the employee's net 
pay—after tax has been paid.

Fund Name – Select the fund that the contribution is going to. These funds 
are set up in the Company Information section (see page 157). To add a 
new fund, enter the fund name and then press TAB. When you are 
prompted to add the fund to your lists, click Yes. 

Member Account Number – Enter the employee's member account 
number.  When an employee joins a fund they are given a unique ID 
number for that fund.  This number is required for all superannuation 
reports and for electronic lodgment of superannuation contributions.

Date Joined – Enter the date the employee joined the fund.  This date is 
required for electronic lodgment of superannuation contributions.

Amount – Enter the dollar or percentage amount of the contribution.  For 
example, if the superannuation is 10% of gross is subject to 
superannuation, enter 10.00.

$ or % – Select whether the amount is a Dollar amount or a Percentage of 
the employee's gross wages.

S.G.C. exempt employees
The Superannuation Guarantee applies to all employers. However, you 
won't have to provide superannuation support for an employee who is:

 paid less than $450 in a month;

 70 years of age or over;

 under 18 years of age and working 30 hours a week or less;

 a resident employee being paid for work done outside Australia for a 
non-resident employer;

 a foreign executive who holds a Class 413 [executive (overseas)] entry 
permit or visa granted under the Migration (1993) Regulations;

 paid to do work of a domestic or private nature for 30 hours a week or 
less; or

 a non-resident for work done outside Australia.

Payments made under the Community Development Employment 
Program Scheme are also exempt.
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Banking details  
Quicken Payroll gives you three methods to pay wages to an employee. 
You can pay by cheque, by bank (electronic funds transfer) or by cash. In 
the banking details section, you can allocate how the employee’s wages are 
to be paid—by cash, by EFT, by cash, or a combination of these methods. 

The banking details must be entered before a pay is processed.  Entering 
the details afterwards will not update previous pays.

Split – Select the split type Use Bank for transfers to bank accounts, Cash for 
payments to be made in cash and Cheque for payments made via cheque. 
Quicken Payroll does not limit the number of cash, cheque or bank 
transactions that can be entered. 

If you select cash or cheque, you only need to enter the split, amount and 
type.

Bank details – All of the employee's bank account details MUST be 
entered for the wages to be transferred to the correct account. You can split 
an employee's wage between up to15 different bank accounts, if you 
choose.

Bank – Select the bank code for the employee's bank account. This code is 
used to sort the banking reports. If the code you want has not yet been set 
up you can create it in the Bank Codes list and then modify the employee's 
record afterwards. 

Branch – Enter the branch name where the employee's bank account is 
located.

All banking details must end 
with a split line that has a 
type of R. 
This ensures that all the 
employee's wages are paid to 
them, by allocating the any 
remaining amounts after the 
preceding splits.
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BSB Number – Enter the BSB (Bank State Branch) number for the 
employee's bank account. The BSB number is six digit number shown 
before the account number on a cheque.

Account Number – The Australian Payment Clearing Association (APCA) 
specifies that the account number is a maximum of nine digits. Some small 
banking institutions, such as credit unions, have created their own file 
format specific to them.  Quicken Payroll only supports the Australian 
standard. Account numbers can be a number (123456789), a number and 
letters (12345678s) or a combination (123456-s1).

Amount – Enter the amount of the split.  This can be either a dollar or a 
percentage value.  If you are entering a percentage, enter it as a whole 
number.

Type – Select $ to enter a dollar amount.  Select % to calculate a percentage 
of the employee's net wage and transfer that amount as a dollar value. 
Select R to transfer all remaining net wages to the split. All banking details 
must end with a split line that has a type of R.  This ensures that all the 
employee's wages are paid to them, by allocating the any remaining 
amounts after the preceding splits.
Employees List 205



Leave details  
For each employee, you must enter leave types, how leave accrues and 
when it should start to accrue in the leave section.  Quicken Payroll comes 
with four of it's own leave types that must be used to track and pay those 
types of leave. The annual leave loading will be automatically calculated 
and the employee’s hourly rate will be adjusted when on annual leave. 
You can enter as many leave items as you need. 

Leave Type – Select the leave type. If the leave name you want has not yet 
been set up, type in the name and then press TAB. Click Setup on the 
Quick-Add window to add the leave type to the Pay Rates list.  When you 
select an existing leave type, Quicken Payroll will automatically enter the 
defaults for that leave type.

 Annual leave – You can enter default settings for each pay rate in the 
Pay Rate details.

 Special leave – In Leave Preferences you can choose Special Leave if 
leave is calculated while the employee is on annual, sick, or unpaid 
leave.

Start Accruing After – Specify when leave should start accruing.  If you 
leave this section blank, Quicken Payroll will start accruing the leave 
immediately.  Alternatively, you can enter how long Quicken Payroll 
should wait before it starts accruing leave.

 Number – Enter the number of periods before leave starts to accrue. 

 Period – Select a period from the drop-down list.   A period can be the 
number of Pays, Weeks, Months or Years before it starts accruing. 
Select Birthdays if you want leave to begin to accrue on the 
employee’s birthday.
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Accrual Details – Enter how often the leave accrues by selecting the period 
from the Every column. 

 Period – The accrual can be based on total hours worked, Normal Hours 
(see page 249), pays, weeks, months, years, or even birthdays.

 Accrue Hours – Enter how many hours should be accrued per hour, or 
per period, as selected above. 

Hours Accrued to Date – If you are setting up Quicken Payroll part way 
through the year, enter the number of hours the employee has accrued to 
date for each leave type. 

Employee Annual Leave Loading – If the employee is entitled to annual 
leave loading, enter the percentage. Quicken Payroll will add leave loading 
to the employee's pay when you pay them  Annual Leave. If the employee 
is eligible for leave loading, the hourly amount will be grossed up by the 
leave loading percentage.  For example, if the normal hourly rate is $10 per 
hour and the employee is eligible for 17.5% leave loading, Quicken Payroll 
will enter $11.75 ($10 + 17.5%) in the amount column. 

If the employee is eligible to receive leave loading, the following rules 
apply:

 The first $320 of the leave loading is tax-free.

 The leave loading is not subject to superannuation.

 A maximum of $320 is tax-free in a year.  This is automatically taken into 
account when you use the Annual Leave pay rate.  If you do not use 
this rate you will need to calculate the amounts manually.

It is important to set up leave loading correctly so that the $320 tax-free 
threshold is taken into account.  Leave Loading is ONLY calculated when 
the Annual Leave pay rate is used to record leave. 

Why does leave accrue when I have specified that it 
shouldn't?  

Generally, leave will begin to accrue for employees on the day that you 
employ them.  However, some employers don’t begin to accrue leave until 
the employee has been with the company for a specified amount of time.

To make leave accrual commence after a certain period of time, make sure 
that you have specified when you want leave to start accruing. 
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Workers Compensation insurer details  
By default, Quicken Payroll copies these details from the company 
information window.  If these details are not filled in, or are different than 
the default information, edit the details here.  

Injury – If an employee is currently being paid Workers Compensation or 
WorkCover, enter their last injury.  That way when you process pays the 
injury will be automatically assigned to any compensation pay items.

Phone and Fax – Enter the insurance company's Telephone and Fax 
numbers.  These numbers can be a straight number, or can include 
brackets, dashes, etc. For example, (02) 5555 - 5555

Compensation claims and payments  
Quicken Payroll can track all Workers Compensation or WorkCover (SA 
and QLD) claims and payments made for each employee.  The 
Compensation tab lists all of the claims and payments for the employee.  
Whenever a compensation pay is processed, it appears here, along with a 
description of what it was for.
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Entering a compensation claim or payment
You can track compensation claims or payments by entering the details 
here. You can also enter compensation payments when processing a pay 
(see page 84 for details) and you can enter payments and claims through 
the Workers Compensation list (see page 264).

Date – Enter the date the claim was lodged, or the payment was received.

Injury / Claim Payment Details – Enter a description of the injury or claim.  
A maximum of 20 characters can be entered for the description.

Amount – Enter the amount of the claim or payment.

Claim or Payment – Select whether the amount is a claim or payment.

Next-of-Kin details 
Enter the employee's Next of Kin details.  This will give you easy access in 
case of an emergency.

Next of Kin – The contact name can be up to 30 characters in length. The 
address can be up to 60 characters in length. 

Relationship – Enter a description of the relationship between the 
employee and the Next of Kin.
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Notes  
Use the Notes window to enter any comments or note about the employee. 
These notes are only viewable in Quicken Payroll. 

This window can hold over 4000 characters (including spaces) of 
information and can be used to track information such as:

Salary increases or decreases,

Reprimands,

Performance review note, or

Any other kind of information.

You can also enter additional information using Custom Fields. For details 
see page 212.
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Fringe Benefits  
You must record the value of fringe benefits provided to your employees. 
You may also need to report a value of benefits on the employees' Payment 
Summaries. To track fringe benefits provided to an employee, enter details 
on the employee record – FBT tab.  The Reportable FBT amount will be 
reported on the employee's Payment Summary.

Note that Quicken Payroll does not calculate Fringe Benefit Tax. 

Adding an FBT record
1 Click Insert.

2 Year Ending – Enter the Year that the payment applies to.

3 Comment – Enter a description of the benefit.  You may find it most 
useful to enter the name of the FBT category. Press F1 while the FBT 
tab is displayed for a listing of FBT categories.

4 Amount – Enter the actual amount of the benefit. Press TAB.

5 Reportable FBT – The grossed up Reportable FBT amount for the 
employee is calculated and entered automatically, using the following 
formula:

Total value of benefits
         (1–FBT rate) = Reportable FBT

For example, if the total value of benefits provided to the 
employee is $1500. If the rate of tax is 48.5%, then reportable 
fringe benefits amount is calculated as follows: 

 1500 
(1–.485)  = $2,912.62

If the FBT rate changes, you can change it in Tax Preferences.

6 To add another line, either press the TAB on your keyboard, or click 
Insert.
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Custom Fields
Custom fields allow you to track additional custom information on your 
employees. Not only will this allow you to record additional information, 
but you will also be able to access these details when you create custom 
reports.

Change Headings – Click Change Headings and then TAB down to 
change any of the headings. Important note – any changes to headings will 
be changed for ALL employees.

History  
If you have started using Quicken Payroll part way through the year, you 
will need to enter the employee's year-to-date (YTD) figures.  The YTD pay 
details must be entered before you start processing the employee’s pays 
with Quicken Payroll. The history window also displays a summary of all 
the pays for the current year. 

Current year-to-date pay 
figures are displayed here. 
column. 
Click here to select the pay item 
displayed in the Amount 
column. 
The default is Gross Pay.
All pays for this employee are 
listed here, including those 
entered by clicking Insert 
YTD, as well as processed 
pays.
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The History section displays the current YTD figures in the Pay Totals and 
a running total of the employee's pays on the right-hand side.  The YTD 
figures will automatically roll over at the end of the financial year— which 
is why Quicken Payroll doesn't provide any end of year procedures.

Note You can only add one YTD pay per employee through the history 
section. If you want to enter previous pays individually, you must 
set up and process the previous pays through the Pays Summary 
window.

Adding a YTD pay:
1 Click Insert YTD.  The Add A Year-to-Date Pay window appears.

2 Complete the Enter Detail section.

Pay Periods – Leave the pay periods at “1”.  If you change the number 
of pay periods, Quicken Payroll will automatically place the 
employee on annual leave.  This means that when you process all 
pays, the employee will be skipped.

Pay Date and Date Paid – Typically, these dates correspond to the last 
pay processed outside Quicken Payroll. You can right click on the 
date fields to select the date from the Q-Date window.

3 Enter the year-to-date details.  Press F1 on while each window is open, 
or refer to Entering Year-to-Date Details below for more information.

4 When you have completed the above details, OK.  Note that you will 
not be able to save the details unless you have entered a Pay Date.  The 
Edit Employee -History window displays the totals for the YTD pay that 
you have just entered.

5 Since you are entering YTD figures for pays that have already been 
paid out, you need to enter the actual tax amount deducted, rather 
than re-calculate the tax.
Enter the year-to-date tax paid in Tax field on the right-hand side of 
the Total Paid section. 
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Entering year-to-date details

Year-to-Date Pay Details
Pay rate – Select the pay rate Normal Hours. 

Note You cannot select a Leave pay rate when entering year-to-date 
pay. This is because when you set up your employee record, you 
should have already entered the vacation hours accrued to date 
in the employee record – Leave section. The leave accrued to date 
amount is entered later in the Leave Details section.

Type – Select Salary.  This indicates that you are entering a total figure.

Hours – Entering an hours amount is optional. 

Amount – Enter the total gross amount of the ordinary time earnings to 
date for the employee.

Super – Select Yes under the Super column if superannuation applies.

Customer:Job and Class – You can assign the hours to a customer or job 
and Class.

Year-to-Date Deductions Details
Deduction – Select the deduction that was taken from the employee's pay.  
If the deduction you want has not yet been set up, type in the name and 
then press TAB. Click Setup on the Quick-Add window to add the 
deduction to the Deductions list.  When you select an existing deduction, 
Quicken Payroll will automatically enter the defaults for the deduction.

ID – Enter the ID for this employee's deduction.  By entering an ID, it 
becomes easier to identify the deduction for a particular employee on a 
report.

Amount – Enter the year-to-date amount of the deduction.

Ex Tax – Since you are manually entering the tax amount, you don’t need 
to change this.

Union – If the deduction was a union fee, select Yes.  This will result in the 
deduction appearing in the correct place on the employee's Payment 
Summary.  If it was an ordinary deduction, select No.
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Year-to-Date Allowances Details
Allowance – Select allowance name.  If the allowance you want has not yet 
been set up, type in the name and then press TAB. Click Setup on the 
Quick-Add window to add the allowance to the Allowances list.  When you 
select an existing allowance, Quicken Payroll will automatically enter the 
defaults for the allowance.

% or Units – Enter 1, because you are entering only a total year-to-date 
amount.

Based On – Select Pays.

Amount – Enter the total year-to-date amount of the allowance.

Super – Select Yes if the allowance was included in superannuation 
calculations.  Select No if the allowance wasn't included in superannuation 
calculations.

Ex tax – Since you are manually entering the tax amount, you don’t need 
to change this.

Customer:Job – You can specify that the allowance should be billed to a 
particular customer or job.  Either select the customer and job from the 
drop-down list, or type in a new one.

Class – You can assign each allowance to a class.  If no class exists, type in 
the class name and then press TAB.  When you are prompted to add the 
class to your lists, click Yes.
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Year-to-Date Sundry Details
Sundries and Adjustments – Select the sundry item that were taken from 
the employee's pay. Quicken Payroll includes the following preset sundry 
items:

 Back Pay <= to 12mths – Select this for back payments of salary or 
wages that accrued twelve months or less ago. This amount will be 
included as part of Gross on the employee's Payment Summary.

 Back Pay > 12mths –  Select this for back payments of salary or wages 
that accrued more than twelve months ago.  This amount will be 
included  in Lump Sum E on the employee's Payment Summary.

 Reimburse Expense – Select Reimburse Expense for items that include 
GST. To pay a sundry that does not include GST, either create a new 
sundry item of the Normal Sundry sundry type, or else just override the 
GST amount. See Sundries List on page 256 for details.

Note The sundry type selected will determine how any GST included 
in the reimbursement is reported on the Activity Statement 
Details report and how the GST amounts are exported to 
QuickBooks.

 Invoice with ABN and Invoice without ABN – If you are paying an 
invoice and you are exporting your payroll data to QuickBooks, select 
one of these options. This will result in the payment being reflected in 
one of the “G” (acquisition) fields in the Activity Statement produced 
through QuickBooks. 

Payments entered through the Hours tab will be included in the “W1” 
(wages) field on the QuickBooks Activity statement.

To create a new sundry item, type in the name and then press TAB. Click 
Setup on the Quick-Add window to add the item to the Sundries list.  When 
you select an existing sundry, Quicken Payroll will automatically enter the 
defaults for the sundry.

Amount – Enter the sundry amount, entering any sundry deductions as a 
negative ( - ) number. Enter the amount including GST, if applicable. For 
example, on a $11 expense, including $1 GST, enter $11. Note that GST is 
only calculated for sundries of the Reimburse Expense Item type.
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GST Amount – Quicken Payroll calculates the GST amount based on the 
sundry type and the amount entered in the Amount column. Edit the 
amount if necessary.

Super – Select Yes if the sundry or adjustment was included in 
superannuation calculations.  Select No if the sundry or adjustment was 
not included in superannuation calculations.

Ex Tax – Since you are manually entering the tax amount, you don’t need 
to change this.

Customer:Job – You can specify that the sundry or adjustment was billed 
to a particular customer or job.  Either select the customer:job from the 
drop-down list, or type in a new one.

Class – You can assign each sundry item to a class. 

Year-to-Date Commission/Bonus Details 
Commission – Enter the commission/bonus name, or select it from the 
drop-down list.  If the commission you want has not yet been set up, type 
in the name and then press TAB.  When you are prompted, click Yes to add 
it to your drop-down list. 

Gross – Enter the total gross sales for the employee.  This field is optional—
if you prefer, you can simply enter the Net amount.

% Comm – Enter the percentage amount that the employee receives from 
their gross sales. This field is optional—if you prefer, you can simply enter 
the Net amount.

Net – Quicken Payroll calculates the net amount based on the amounts in 
the Gross and %Comm columns. 

Period – Select the period for which the commission was being paid. 

Super – Select Yes if the commission was included in superannuation 
calculations.  Select No if the commission wasn't included in the 
calculations.

Ex Tax – Since you are manually entering the tax amount, you don’t need 
to change this.
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Year-to-Date Superannuation Details
Enter year-to-date superannuation payments in the Superannuation 
section of the Add a Year-to-Date Pay window.

Type – Select the type of superannuation payments that were made.

Fund Name – Select the superannuation fund that the contribution was 
made to.  If the fund name you want has not yet been set up, you can type 
in the name and then press TAB.  When you are prompted, click Yes to add 
it to your superannuation list.  

Member A/C – Enter the employee's account or ID number for the 
superannuation fund you have selected.

Joined – Enter the date the employee joined the fund.  This is usually the 
day the employee joined the company.

Amount – Enter the amount of superannuation that was paid to the fund.  
Enter the amount as a fixed dollar amount.

% $ – Select $, because you are entering historical data, rather than a 
percentage on which superannuation will be calculated.

Amt Paid – Quicken Payroll will enter the amount entered under Amount 
into this column.
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Awards List  
If you want to speed up the process of adding new employees, or if your 
employees come under a federal award, you need to set up awards. 
Awards enable you to enter the full details of any federal award, or to 
create a set of default pay and leave details. Then when you are setting up 
a new employee record, rather than re-enter all of the pay details, you can 
select an award and all of the award pay details will be added to the new 
employee record.

It might appear time consuming setting them up now, but it saves you 
from having to re-enter all of the details each time you hire another 
employee with the same details.  Also, when you make changes, the 
changes update all the employees under that award.  

If you have employees that are paid according to the time of day they start 
and finish and you intend to pay them using the Timesheet method, you 
must set up awards with shift details for those employees.

Adding or editing an award
To create a new award, click Award>New.  The Adding a New Award 
window will be displayed.  To edit an existing award, select the award and 
click Awards>Edit.  The Editing Award window will be displayed.

Complete the award details on the three tabs:

 Standard Details tab – see below

 Payments Detail tab – see page 222

 Timesheet Payments tab – see page 225
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Standard Details tab  
Name the award and enter the default department, pay period and 
superannuation details on the Standard Details tab.

Award Name – Enter the award name, which can be up to 20 characters in 
length. If you are creating a federal award, use the name of that award. 
Otherwise, enter any award name that is meaningful to you.

Department Name – Enter the department name, which can be up to 20 
characters in length. If the department you want has not yet been created, 
type in the name and then press TAB. Click Setup on the Quick-Add 
window to add the name to the Department list.

Pay Period – Select how often employees under this award are paid. 
Weekly employees have 52 pay periods in a year.  Fortnightly employees 
have 26 pay periods in a year.  Bi-Monthly employees have 24 pay periods 
in a year.  Monthly employees have 12 pay periods a year.

Super Type – Most employees are entitled to employer-paid 
superannuation. Select how superannuation is calculated under this 
award.  If the superannuation is calculated as a percentage of the 
employee’s gross wages, select Percentage.  If you have agreed to pay a 
certain dollar amount each pay period, select Amount.

For a complete listing of superannuation types, see Superannuation details 
on page 202.
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Percentage – If you selected Percentage, enter the percentage value.  For 
example, to enter 9%, enter 9.  If you selected amount, enter the dollar 
amount.  Most employees are entitled to employer-paid superannuation.

Leave Type – Select the leave type. If the leave type you need has not yet 
been set up, type in the name and then press TAB. Click Setup on the 
Quick-Add window to add the leave type to the Pay Rates list.  When you 
select an existing leave type, Quicken Payroll will automatically enter the 
defaults for that leave type.

Start Accruing After – Specify how long the employee must be employed 
before leave starts to accrue.  If you leave this section blank, Quicken 
Payroll will start accruing the leave immediately.  Alternatively, you can 
enter how long Quicken Payroll should wait before it starts accruing leave.

 Number – Enter the number of periods before leave starts to accrue.

 Period – Select a period from the drop-down list.   A period can be the 
number of Pays, Weeks, Months or Years before it starts accruing. 
Select Birthdays if you want leave to begin to accrue on the 
employee’s birthday.

Accrual Details – Enter how often the leave accrues by selecting the period 
from the Every column. 

 Period – Select how often leave should accrue.

 Accrue Hours – Enter how many hours should be accrued each pay.

Leave Loading – If the employees under this award are entitled to annual 
leave loading, enter the percentage. Quicken Payroll will add leave loading 
to the employee's pay when you pay them Annual Leave.
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Award Payment Details tab  
You can set up the pay rates for employees under this award on the Award 
Payment Details section. For each classification (or level) within the award, 
you can specify different remuneration amounts for permanent, part-time, 
or casual staff.

Classification – Enter the name of the classifications, within this award.  
Quicken Payroll defaults to Standard, but you could enter any 
classification name. If this award is for timesheet employees, Quicken 
Payroll only uses the first classification line.

A classification is a way of identifying an employee's pay rate within a 
single award. 
For example, an award for chef's may be called a Chef's Award.  However, 
there might be several levels within this award, such as Apprentice Chef—
Year 1, Apprentice Chef – Year 2, Chef – Level 1, and Chef – Level 2.

Classification rates –  Employees will be paid according to the rate for their 
classification and status (permanent, part-time, or casual). The employee’s 
Classification and Status are set up in the employee record Company Details 
window. 

The classification rates entered here will be used as the Normal Hours pay 
rate for employees under this award. This means that for employees under 
this award, when you select Normal Hours as the pay rate in the Employee 
Record – Pay Rates section, Quicken Payroll will use the classification rates 
entered here. 

Select  Advanced to 
display the Classification 
Extra Pay Rates section.
The Classification Extra 
Pay Rates section is used 
when you want to specify the 
exact rate for a pay rate. 

Each classification can have 
its own allowances. This list 
will only show allowances 
that have been set up for the 
classification highlighted.

Classification

A level or sub-category 
within an award. 
A classification is a way 
of identifying an 
employee's pay rate 
within a single award.

G l o s s a r y T e r m
222 CHAPTER 7 - Finding your way through Quicken Payroll’s menus



Other pay rates (such as Time & 1/2 or Double time) will then be calculated 
based on this normal rate. See the Pay Rates List on page 249 for more details 
on how pay rates are calculated.

Type – Select how often employees under this award are paid.  For 
employees on an hourly rate, select Hourly.  For employees who receive a 
fixed amount each pay period, select Weekly or Monthly.  For employees 
who receive a fixed amount each year, select Annual Salary.  If you employ 
staff such as fruit pickers or casual labour and you pay them based on the 
number of buckets, boxes, or other piece meal basis, select Items.

Note Annual Salary cannot be selected in the pay screen. It can only be 
selected in the award or employee record. 

Employment Status – Permanent, Part-time and Casual – You can enter 
three different rates of pay for each classification—one for Permanent 
employees, one for Part-Time employees and one for Casual employees.

Casual Loading Percentage – Some casual employees are entitled to a 
Casual Loading Percentage on top of their normal rate of pay.  This is to 
compensate them for not being entitled to annual and sick leave. Unlike 
leave loading, casual loading does not have a tax-free threshold. If casual 
employees under this award are entitled to this loading, enter the 
percentage. 

Casual loading will be applied only if you assign an award to the employee 
and then select  Use Award Pay Rates in the Employee record – Pay Rates 
tab (page 194).

Advance – Select when employees under this award should advance to the 
next classification level.  

 Manual – Use this option when you don’t want employees advanced 
automatically – you will advance them yourself when it is required. If 
there is only one classification under this award, select Manual. 

Advance items such as 1 Year means that after 1 year the employee is 
advanced to the next classification level.

Advance items such as 21 Years Old means that when the employee is 
21 years old, he or she is advanced to the next classification level.

 Yearly means that each year the employee is advanced to the next 
classification level.
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Classification Allowances – Each classification can have it’s own set of 
allowances. These allowances only apply to the classification currently 
highlighted. To add an allowance to a different classification, click on the 
classification name and then enter the allowances that apply to that 
classification.

1 Click in the Name column to get a list of all allowances that have been 
set up. Select the allowance name and press TAB.  If the allowance 
you want has not yet been set up, type the name of the allowance in 
and press TAB. Click Yes when you are asked if you want to add the 
allowance to your lists.

2 Enter the dollar Amount that applies to this allowance. 

3 Select what the allowance should be Based On. For example, if you 
want the allowance to be 10% of an employee's wages, you must select 
Pays.

Advanced – In addition to the Normal Hours pay rate that you enter in the 
classification section, each classification can also have it’s own set of default 
rates for overtime and other rates of pay. These amounts will override the 
rates that would otherwise be calculated. 

For example if your classification Normal Hours rate is $10 per hour, 
double time would normally be calculated as $20 per hour. If you pay 
double time at $21 an hour, then you can specify that here.  All 
employees under this award and classification will then receive $21 an 
hour for overtime.

To set up additional pay rates specific to employees under this award, 
select  Advanced to enable a second pay rate list – Classification Extra 
Pay Rates.  You can then enter the additional pay rates that apply to this 
classification and specify the hourly rate amounts. 
If you are entering overtime pay rates, leave the hours Worked column as 
zero, otherwise the employee will be paid overtime in each pay based on 
the hours entered in this column.

If you  enter a Normal hours rate in the Classification Extra Pay Rates
section, this will override the rates entered in the Classification section
and all employees will be paid the amount entered regardless of
whether they are  permanent, part-time or casual employees.
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Timesheet Payments tab  
If you have employees that are paid according the time they start and 
finish a work shift and you want to pay them using the Timesheet method 
(see page 71), you must complete this section. 

Under the timesheet method, when you prepare your payroll, you only 
need to enter the start and finish times for each day the employee works. 
Quicken Payroll calculates any breaks as well as the different rates (such as 
overtime rates) that apply between the times that you specify, based on the 
information entered on the Timesheet Payments tab.

On the Timesheet Payments section you need to set up the start and finish 
times of each shift covered by the award. For each shift, complete a 
separate line on the Timesheet Payments tab. It is important that you don’t 
forget to allow for and set up unpaid meal and rest breaks (see page 227). 

You will only be able to pay an employee under the timesheet method for 
days and hours that have been defined in the timesheet payments tab. 
Therefore, make sure that you define shifts covering all days that 
employees might work under this award. 

For example, if you have only defined shifts for Monday to Friday and you 
then try to pay the employee for weekend work, you will get an error 
message and you will not be able to save the shift details entered in the pay 
details window.

Shift Pay Rate – Select the shift pay rate that will apply between the hours 
and date(s) you are going to specify.  The first line is usually Normal 
Hours.

 If you need to create a new pay rate, simply type the name and then 
press TAB. Click Setup on the Quick-Add window to add the rate to the 
Pay Rates list.

It is very important to select the 
correct option for how Super is 
applied to the shift and to 
overtime pay.
Enter shift details starting with 
Sunday, otherwise you will 
receive errors if you try to enter 
a shift that spans 2 days.
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 You can create a pay rate called Meal Break (or something similar) that 
allows Quicken Payroll to track unpaid breaks and know not to pay 
the employee during the meal break. See Setting up an unpaid break on 
page 227 for instructions on setting up an unpaid break.

Shift Start and End – Select the day, or range of days, that the start and 
finish time should apply to. M-F can be used to tell Quicken Payroll that 
this rate and time applies Monday through to Friday.  Selecting All means 
that the rate and time apply to all days of the week.

Note When entering times you can enter them in 24-hour format 
(17:00) or using 12-hour format (5 PM) AM and PM. 
Also note that you must enter the details starting from Sunday.  If 
you don’t start the details from Sunday, you will receive errors 
when you try to enter shifts over 2 days.

Overtime – If any overtime applies to this shift pay rate, enter the number 
of hours that must be worked before overtime is applicable.  You also need 
to specify the overtime pay rate. You can specify two overtime rates per 
time period.

Example An employee normally works 8 hours a day, 9:00 AM to 5:00 
PM. In the Overtime Rate 1 column you would enter 8 hours 
and select the overtime pay rate.   Quicken Payroll will then 
calculate pay for the first eight hours at the normal rate of pay 
and apply the overtime rate for time in excess of eight hours.

Note If you have set up an unpaid meal break, the After Hours number 
in the overtime column includes the break period. See Setting up an 
unpaid break on page 227 for details.

Superannuation – Specify how superannuation is calculated for regular 
hours and overtime for this shift.  The options are as follows:

Yes – All pay rates are subject to superannuation.

No – None of the pay rates are subject to superannuation.

Shift – Only the shift pay rate is subject to superannuation.

Shift + OT1 – Only the shift pay rate and the first overtime rate are 
subject to superannuation.

Shift + OT2 – Only the shift pay rate and the second overtime rate 
are subject to superannuation.

Overtime – Only the overtime rates are subject to superannuation.
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Deleting an award 
The Delete option is disabled and you will not be able to delete it until you 
remove the award from any employee records or a pays that use it. To 
delete an award, click on the name of the award so it is highlighted, click 
Awards>Delete and then click OK to confirm that you want to delete the 
award.

Setting up an unpaid break
You can set up an unpaid break so that all you have to do is enter the start 
and finish times and then Quicken Payroll will exclude the unpaid break. 
For example, if you have set up a one hour meal break and then enter a 
start time of 8 am and a finish time of 5 pm, Quicken Payroll will calculate 
the paid hours as 8 hours, automatically excluding the unpaid break.

Step 1 – Set up a pay rate for the unpaid break.

If you haven't set up a Pay Rate for meal breaks, do the following:

1 In the Shift Pay Rate Column, type Meal Break (or similar description). 
Press TAB.

2 A Quick-Add window will ask if you want to add Meal Break to your 
drop down list.  Click Setup.

3 The Add a Pay Rate window is displayed. Enter 0 (zero) in the 
Multiplier box. Click OK.

Step 2 – Enter the shift details, including the unpaid 
break

To enter an unpaid break, you must split the shift into the period before 
and after the break and then specify the break period. 

When setting up an unpaid 
break for a shift, enter the 
Overtime Rates only on the 
last line of the shift. The After 
Hours amount must include 
the break
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When splitting up a shift and entering an unpaid break, you just set up the 
shift details as follows:

1 You must have a separate line for the unpaid break and a separate line 
for each period before and after the break. 

For example, in the example above, the first line covers the period 
before the break – 8 am to 12pm, the second line covers the break 
from 12 to 1 am and the last line covers the period after the break – 1 
pm to 11 pm.

2 Overtime rates are ONLY entered on the last line of each shift. If you 
enter overtime rates on any of the other lines, the unpaid break will 
not be calculated correctly. 

3 The After Hours number in the overtime column includes the break 
period. For example, if the employee is paid overtime after 8 hours of 
work and the shift includes a 1 hour unpaid break, enter 9 hours in the 
After Hours column.

Step 3 – Entering shift hours when processing the pay

When you process the pay and enter the hours worked, you only need to 
enter the start and End time. Quicken Payroll will automatically calculate 
the unpaid period, as shown in the example below. 
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Allowances List 
Allowances are payments made to employees to compensate them for 
expenses they have had while doing their job—such as mileage 
allowances, meal allowances or tool money. When you set up an 
allowance, make sure you understand whether or not it is subject to 
superannuation, fringe benefits and tax. 

Adding an allowance 
To add an allowance, click Allowances>New.  The Add a New Allowance 
window is displayed. 

General tab

Allowance Name – Enter a name for the allowance.

Calculate Super on Allowance – Select  this option if the allowance is to 
be included in superannuation calculations.

Tax Exempt Allowance – Select  this option if the allowance is not subject 
to PAYG.  Most allowances are not tax-exempt. Notable exceptions include:

 Cents per kilometre car expense payments using ATO rates up to 5000 
business kilometres.

 Award transport payments for deductible transport expenses.

Allowance options determine 
how the allowance affects 
superannuation, tax, payroll tax 
and WorkCover calculations, as 
well as how the allowance is 
displayed on the Payment 
Summary.
You can ONLY select these 
options here—you cannot select 
them when setting up pay 
details in the employee record or 
pay details window.

Select where (and 
if) the allowance 
amount is 
displayed on the 
Payment 
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 Overtime meal allowances up to a reasonable amount (as determined 
by the ATO).

 Laundry (not dry cleaning) allowance for deductible clothing up to a 
reasonable amount (currently $150, but subject to change).

 Travel allowance involving overnight absence from payee’s ordinary 
place of residence up to a reasonable amount (as determined by the 
ATO). An allowance for overseas accommodation is not tax-exempt.

For full details, contact the ATO. Refer also to the Quicken Payroll Help. 
Choose Search for Help On.. from the Help menu and then type “Taxation 
of allowances”.

Selecting  Tax Exempt Allowance will add the allowance to the employee's 
net pay, after tax has been calculated. Leaving it blank  will add the 
allowance to the employee's gross pay and tax will be calculated on it.

Payroll Tax Exempt Allowance – Select  this option if the allowance is 
payroll tax-exempt. Most allowances are included, or at least partially 
included in Payroll tax calculations.

WorkCover Exempt Allowance – Select  this option if the allowance is 
exempt from WorkCover.

Where to display in Payment Summaries –Select where the allowance 
amount is to be displayed in Payment Summaries—in the Gross wage 
section, the Allowance section, or not displayed at all.

If you only want the allowance to display in Payment Summaries when 
over a specified amount, then enter that amount on the Threshold tab (see 
next page) and select Payment Summaries (Apply threshold to Payment 
Summaries).

To determine where the allowance should be displayed on the payment 
summary, refer to the Quicken Payroll Help. Choose Search for Help On.. 
from the Help menu and then type “Taxation of allowances”.

Note If you have an allowance that you pay both to contractors and to 
your normal staff, you will need to define two separate 
allowances—one for employees that displays the allowance on 
the Allowance section of the Payment Summary and another 
allowance for contractors the includes the allowance in the Gross 
section.
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Amount tab

Fixed Amount  – If the allowance is a fixed dollar value, select  Fixed 
Amount and enter the dollar value.

Percentage – If the allowance is based on a percentage, select  Percentage 
and enter the percentage amount.  

Based on – Select what the allowance is a percentage of from the drop-
down list.   For example, if you select Wages, the allowance dollar value will 
be a percentage of the total wages for that particular pay. For details, see 
What are the Based On items? in the Quicken Payroll Help (choose Search for 
Help On.. from the Help menu and then type Based on into the Index tab).

Allowance based on hours worked – Enter 0 in the % or Units column 
and select a pay rate from the Based On column, the allowance will be 
calculated as the number of hours worked for that pay rate times the 
amount entered in the Amount column. For details, see How do I pay an 
allowance based on the number of hours worked? on page 62. 
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Threshold tab
The threshold value is the maximum allowance amount that can be paid 
before being subject to Payroll Tax or WorkCover, or being displayed on 
Payment Summaries. 

Calculate When Greater Than – Enter the threshold amount.  Depending 
on the options selected below, allowances under the threshold amount will 
not be displayed on Payment Summaries, or will not be subject to Payroll 
Tax or WorkCover.

Payroll Tax – Select  this option if Payroll Tax does not apple to 
allowances under the threshold amount.

WorkCover – Select  this option WorkCover does not apply to 
allowances under the threshold amount

Payment Summaries – Select  this option if you only want the allowance 
to display in Payment Summaries when over the threshold amount. When 
this option is selected, any allowances under the threshold amount will not 
be included in the Gross Payments or Allowances section of the payment 
summary. Note that this only affects how the allowance is displayed, not 
whether it is taxable or not.

For more detailed examples of creating awards, see the following sections 
in the Quicken Payroll Help (choose Search for Help On.. from the Help 
menu and then type the following into the Index tab):

 Creating an Award – Example 

 Setting up a Timesheet Award – Example 
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Editing an allowance 
To edit an allowance, select the allowance you wish to change and then 
click Allowances>Edit. Make any required changes on the Update 
Allowance window. 

When you make changes to an allowance, Quicken Payroll will ask if you 
want to also make these changes to any employee records and awards that 
use the allowance. Previous pays using the allowance will not be affected.

Deleting an allowance
The Delete option is disabled and you will not be able to delete the 
allowance, unless you first remove the allowance from any employee 
records or pays that use the allowance.

To delete an allowance, select the allowance, click Allowances>Delete and 
then click OK to confirm that you want to delete the allowance.

When you change an 
allowance you can apply 
those changes to the 
employee records and awards 
that use the allowance.
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ATO Electronic Funds Transfer List
If you are using electronic funds transfers (EFT) to pay your employees, 
you will probably want to make your Australian Tax Office (ATO) 
payments electronically as well. Not only can you pay your PAYG, FBT, 
child support and other payroll related liabilities, but you can also use 
electronic funds transfers to pay items not tracked by Quicken Payroll, 
such as penalties, sales tax and company tax.

To make your ATO payments directly from your bank account, Quicken 
Payroll creates an electronic funds transfer (EFT) file that you can use with 
the EFT software provided by your bank.

Each time you create an ATO electronic fund transfer file, the details are 
listed on the ATO Electronic Funds Transfer list. You can create a new ATO 
EFT transfer file either by clicking ATOEFT>New, or by clicking Create 
Tax Payment on the Navigator Tax Payments tab.
234 CHAPTER 7 - Finding your way through Quicken Payroll’s menus



Creating an ATO EFT payment file
Before you create the EFT file you need to ensure that the electronic funds 
transfer options are set correctly for the bank. EFT preference settings are 
set up through Files Preferences (see page 175 for details).

To add an EFT transaction, click ATOEFT>New on the Electronic Funds 
Transfer list, or click Create Tax Payments on the Navigator Tax Payments 
tab. The ATO Electronic Funds Transfer window is displayed.

Export Date – This date should always be the current date, otherwise your 
banking program may refuse to send the EFT file.

EFT Code – This code, identifies you as the payer and the payment you are 
making. The code is printed just above the barcode on the payment advice 
related to this payment. The code may also have been sent to you 
separately.

Payment Amount – Enter the total payment amount being sent to the ATO.

Export Filename – If you want the EFT file to be exported to a different 
location, right click on the Export Filename to specify the new location.  If 
you just want to change the name of the file, click on the field and change 
the file name.

When you have entered all of the details, click OK. Quicken Payroll creates 
a file in your QPRoll\DATA folder (by default named ATO.ABA) that is 
used by your banking software.

The EFT code identifies you as 
the payer and provides 
information about the 
payment you are making. You 
can obtain the EFT code from 
correspondence sent to you 
from the ATO. It is also 
located just above the barcode 
on your payment advice.
ATO Electronic Funds Transfer List 235



Editing ATO tax payments
To edit an EFT transaction, select the transaction on the Electronic Funds 
Transfer list you wish to change and then click Edit. Make changes on the 
ATO Electronic Funds Transfer window.

Note that unless you change the Export Filename, this will overwrite any 
existing EFT transaction file.

Deleting an ATO electronic funds transfer item
You should only delete an ATO electronic funds transfer item if you have 
not sent it to the ATO.  Once it has been sent you must keep it on record in 
case you are audited.

To delete an ATO Electronic Funds Transfer payment, highlight the 
payment on the ATO EFT list, click ATOEFT>Delete and then click OK to 
confirm that you want to delete the payment.

Making an ATO electronic funds transfer payment
Once you have created the ATO EFT file, you can make the payment 
directly from your bank account using the EFT software provided by your 
bank. For details, see PAYG and withholdings on page 107.
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Bank Codes List  
Bank codes are used whenever you need to enter banking details for your 
company, employees, or superannuation funds. They are also when 
generating banking reports. In most cases, the bank codes you need will 
already be included in the list, but you can add additional bank codes or 
edit bank codes if you need to. 

Adding or editing a bank code
If you are certain that the bank you are looking for is not listed, you can 
add it.  If you discover later on that you actually entered the wrong code 
or name for a bank, you can change it.   Note that this will not update the 
company information, or any employee records that use the bank code.  
You will need to manually update these records to reflect the change.

Clicking ATOEFT>New or Edit will open the Add New Bank or Update Bank 
window.

Bank Code – Enter the bank’s three-letter abbreviation into the Bank Code 
field.  To make it easy to find later on, be sure to enter the bank’s actual code 
and not one you have created.

Bank Name –  Enter the name of the bank into the Bank Name field.  
Again, be sure to enter the correct name of the bank.

Deleting a bank code
To delete a bank code, select the code, click Bank Codes >Delete and then 
click OK to confirm that you want to delete the code.
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Classes List 
You can assign classes to your payroll transactions. Then, when class 
tracking is enabled in the Preferences window, Quicken Payroll adds a Class 
column to windows where you enter payroll transactions, such as the 
employee record and the pays window. 

You can use classes to classify your payroll by department, business office 
or location, separate properties you own, or any other meaningful 
breakdown of your business activities. 

For example, you might classify all payroll as relating to either wholesale 
or retail sales.  At the end of an accounting period, you could create 
separate reports for the wholesale and retail parts of the business.

Adding or editing a class
When you edit or delete a class, it will not update any employee records or 
pays that use the class.  You will need to update these records to reflect the 
change.

Class

Anything in your business 
(other than a customer or 
job) for which you need to 
track both income and 
expenses.
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To add a class, click Classes>New.  The Add Class window is displayed.
To edit a class, select the class you wish to change and then click 
Classes>Edit.  The Update Class window is displayed.

Class Name – The class name may be up to 30 characters in length.

Sub Class – Select  this option if the class is a sub class and then select the 
parent class.  You can enter up to five levels of classes.

Deleting a class
The Delete option is disabled and you will not be able to delete it until you 
remove the class from any employee records or a pays that use it. To delete 
a class, select the class, click Classes>Delete and then click OK to confirm.
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Customer:Jobs List   
You can assign customers or jobs to your payroll transactions, which will 
allow you to track the payroll costs of a particular customer or job and 
include customer and job details on your payroll reports. Customer and 
jobs are completely optional.

If you assign customer:jobs to payroll transactions, you can:

 Export your payroll costs by customer:job to QuickBooks

 Print customer:job reports

 Add customer:job information to your reports

If you wish to apply a markup value to the customer:job you can do so at 
the time you place the expense items on to the invoice in QuickBooks.

Adding or editing a Customer:Job
When you edit or delete a customer or job, it will not update any employee 
records or pays that use it.  You will need to manually update these records 
to reflect the change. 

Customer

Any person, business, or 
group that buys or pays for 
the services or products 
that your business or 
organisation sells or 
provides.

Job

A project done for a 
particular customer.
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To add a customer:job, click Jobs>New.  The Add Customer:Job window is 
displayed.  To edit a customer:job, select the customer:job you wish to 
change and then click Jobs>Edit.  The Update Customer:Job window is 
displayed.

Job Name – The customer:job name may be up to 40 characters in length.

Sub Job – Select  this option if the customer:job is a sub job and then 
select the job that it is a sub job of.  You can enter up to five levels of 
customer:jobs.

The colon (:) between Customer and Job on the name on this list is a 
reminder that QuickBooks displays a colon between the name of your 
customer and the associated job in any field for a customer and job name. 
For a more in depth discussion of customers and jobs, refer to your 
QuickBooks User Guide.

Deleting a customer:job 
The Delete option is disabled and you will not be able to delete it until you 
remove the customer:job from any employee records or a pays that use it. 
To delete a customer job, select the it, click Jobs>Delete and then click OK 
to confirm that you want to delete the customer:job.
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Deductions List  
Deductions can be taxable or non-taxable, may be for union fees, and they 
may or may not be displayed on Payment summaries. These attributes can 
only be set up through the Deductions list.

Adding a deduction
To add a Deduction, click Deductions>New. The Add a Deduction window 
is displayed.

General tab – Enter the deduction name.

Option tab.

Tax Exempt Deduction – This option is used to indicate if the deduction is 
tax exempt or not. Note that most deductions are not tax exempt.

 Leaving this check box blank  will mean the deduction is taken from 
the net amount of an employee's pay, after tax is calculated.
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 Selecting  this option will take the deduction out of the employee's 
gross before tax is calculated for the pay.  For example, if the pay is 
$1000 and the deductions amount is $200, PAYG will be calculated 
based on $800.

Omit Deduction From Payment Summary – Select this option to exclude a 
tax exempt deduction from being reported on a Payment Summary.

This Deduction Is For A Trade Union – If the deduction is for union dues, 
select  this option.  Any contributions made using this deduction will 
appear in the Union Fees section of the employee’s Payment Summary.

Editing a deduction
To edit a deduction, select the deduction you wish to change and then click 
Deductions>Edit.  Make any required changes on the Update Deduction 
window.

When you make changes to a deduction, Quicken Payroll will ask if you 
want to also make these changes to any employee records that use the 
deduction. Previous pays using the deduction will not be affected.

Deleting a deduction
The Delete option is disabled and you will not be able to delete it until you 
remove the deduction from any employee records or a pays that use it. To 
delete a deduction, select the deduction, click Deductions>Delete and 
then click OK to confirm that you want to delete the deduction.

When you change an 
deduction you can apply 
those changes to the 
employee records that use the 
deduction.
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Departments List 
Adding or editing a department
Click Departments>New or select a department and click 
Departments>Edit. The Update Department window will be displayed.

Deleting a department
To delete a department, select the department click Departments>Delete 
and then click OK to confirm that you want to delete the department.

Departments are another way 
to group your employees 
together Enter the department 
name. The name may be up to 
20 characters in length.
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Payroll Tax Scales  
Payroll Tax applies if the  total annual wages bill from all sites (if part of a 
group of companies, from all members of that group) throughout Australia 
exceeds the threshold for the state. Selecting this command will display a 
list of the payroll tax thresholds for each state. In most cases, you will only 
need to change the Payroll Tax Scale if the state threshold or rate changes. 

Quicken Payroll includes the most recent Payroll Tax scales available at 
time of product release. However, since Payroll Tax scales may change over 
time, you will need to periodically update your Payroll Tax scales.  There 
are three ways to update the tax scales:

 Using a file sent to you on floppy disk (page 309);

 Internet update (page 309); or

 through the Payroll Tax Scales list.
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Editing a Payroll Tax scale
Click to select the payroll tax scale you want to change and then click 
Payroll Tax>Edit.  The Update Payroll Tax Scale window will be displayed.

Last Update – If you are making changes, enter the current date so you 
know when this scale was last updated. 

Threshold – Enter the total gross wages for the year.  For example, if you 
enter 456000, Quicken Payroll won’t calculate payroll tax until the wages 
exceed the $456,000 threshold.  Quicken Payroll calculates the monthly 
threshold based on the yearly total.

Multiplier –  Enter the percentage of total gross wages that should be paid 
to State Revenue.

Note Quicken Payroll works on a daily basis.  This means that some 
months the payroll tax payable will match the same manually 
calculated figure.  Other months it will be slightly more or slightly 
less. At the end of the year you will have paid the exact amount 
due.

Enter the payroll threshold 
amounts and the rate that 
applies to each threshold. 

In this example payroll tax is 
payable on total annual 
wages bill above $600,000 at 
the rate of 6.85%.
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Pays List  
The Pays list displays all processed pays for the current pay run, the 
current month, the current financial year or a date range that you specify. 
From the Pays listing created after you select which pays you want to list, 
you can edit or delete selected pays.

Displaying pays for the current pay period
1 Select the type of employees that you wish to view, from the Pay Type 

drop-down list.

For example, if you just want weekly employees to appear, select 
Weekly.

Note – The drop-down list will only show the types of pay that match 
employees.  For example, if the company has weekly and monthly 
employees, the drop-down list will only show Weekly and Monthly.

2 Click to select the date range that you want to view pays for the 
current period, this year, the current month, or for a selected date 
range.

Select the pay period that 
you want to view. Use 
Selected Date Range to 
specify a custom date range.

Select the pay type you want 
to view pays for.

Type in the dates or right 
mouse click to bring up the 
Quicken Payroll Q-Date 
calendar window. Select the 
date and then click Enter to 
enter the date.
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3 The List Pays window displays all pays of the selected Pay Type for the 
date range selected.  From this window, you can print a pays report, 
or you can edit or delete individual pays. 

4 To print a report click Reports and then choose a report. The Report 
Writer opens and creates the Pays List Report for the pay type and 
date range selected.  Click the Printer icon at the top of the page to 
print the report. 

To return to the List Pays and to Quicken Payroll, click the Quicken 
Payroll tab on your Windows taskbar, or press ALT+TAB.

Editing a past pay
Editing past pays can result in gross and tax amounts for previous months 
differing from amounts originally reported. To help prevent inadvertent 
changes, you cannot edit a past pay unless the  Edit This Pay check box 
has been selected. This option can selected by default in the General 
Preferences. You also cannot edit a past pay if you have been set up as a 
user without the rights to edit a past pay.

To edit a pay, select the pay and then click Edit.  Edit details on the pay 
window displayed.  Press F1 while the pay window is open for further 
information on each section. This will bring up Quicken Payroll Help with 
instructions for that specific section. 

Deleting a pay
To delete a pay, select the pay, right-click and choose Delete. Click OK to 
confirm that you want to delete the pay.

Sort the list by clicking on 
any of the column header 
names.
Double click on any line to 
edit the pay.
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Pay Rates List  
The Pay Rates List displays all pay rates currently available. Most of the 
pay rates you need are probably already included in the Pay Rates list, but 
you may need to add some additional rates. Some pay rates, such as 
Annual Leave, are system defaults and should not be deleted.  If you do so, 
pays and possibly leave will be incorrect.

Normal Hours pay rates
The term “Normal Hours” pay rate has special meaning in Quicken Payroll. 
The “Normal Hours” rate for an employee is the base rate of pay that other 
rates (such as double time) are based on. It is also used in awards in 
calculating leave accruals.

In most cases you can simply use the default Normal Hours pay rate, but if 
you require a Normal Hours pay rate with a different name or with different 
leave accrual setting, you can set up an additional pay rate designated as 
Normal Hours rate. An example of this might be where your employees are 
paid on some basis other than by the hour and the term Normal Hours 
would cause confusion. In this case you could create a more descriptive 
pay rate and designate it as a Normal Hours rate.

You can set up as many Normal Hours rates as you need in the company, 
but each employee should only be assigned one “Normal Hours” pay rate.

Adding a pay rate
To add a pay rate, click Pay Rates>New. The Add a Pay Rate displays.  

If you are creating a new leave 
type, select  this option. 
This will enable the Leave 
Accrual Details tab.

Select  this option to use 
this pay rate on the 
Spreadsheet Entry window.
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Pay rate tab
Pay Rate – Enter a descriptive Pay Rate name, up to 20 characters long.

Multiplier – Enter the multiplier, which is used to calculate the pay 
amount.  The multiplier is used in conjunction with the employee’s Normal 
Hours pay rate.  Quicken Payroll multiplies the employee's Normal Hours 
pay rate by the multiplier you enter. Note that the employee’s Normal 
Hours rate may be either the default pay rate named Normal Hours, or a pay 
rate that you set up and designated to be used as a Normal Hours pay rate.

Enable Leave Accrual – If this pay rate is a leave rate, you can set the 
defaults for leave accrual.  To set the defaults, select  this option.

Use as Normal Hours Pay Rate – Select  this option if you want this rate 
to be used as a normal pay rate.  This means that where the program 
requires a normal pay rate, such as in the employee record, this rate can be 
used.

Use pay rate for Spreadsheet Entry – Select  this option if you want this 
pay rate to appear on the Spreadsheet Entry window.

Payroll tax exempt – Select  this option if Payroll Tax doesn’t apply to this 
Pay Rate.

Leave accrual details tab
If this is a leave rate, you can set the defaults for leave accrual.  To set up a 
leave rate, click Enable Leave Accrual and then click on the Leave Accrual 
Details tab. 

If this is a leave rate, 
specify the default value 
for when the leave should 
start to accrue.

Also specify how the leave 
accrual is calculated.
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Start Accruing After – specify how long Quicken Payroll should wait 
before it starts to accrue leave.  For example, to specify that leave should 
only accrue after the employee has worked for three months, enter 3 under 
Number and select Months under Period.

Accrual Details – enter how often leave should accrue and how much 
should accrue.  For example, to accrue three hours leave every pay period 
enter 1 under Every, select Pays from Period and then enter 3 under 
Accrue Hrs.

Editing a pay rate
To edit a pay rate, select the pay rate you wish to change and then click Pay 
Rates>Edit.  Make any required changes on the Update Pay Rates window.

When you make changes to a pay rate, Quicken Payroll will ask if you want 
to also make these changes to any employee records or awards that use the 
pay rate. Previous pays using the pay rate will not be affected.

Deleting a pay rate 
The Delete option is disabled and you will not be able to delete it until you 
remove the pay rate from any employee records or a pays that use it. To 
delete a pay rate, select the pay rate, click Pay Rates>Delete and then click 
OK to confirm that you want to delete the pay rate.

When you change an pay 
rate, you can apply those 
changes to the employee 
records and awards that use 
the pay rate.
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Reminders List  
Reminders are an easy way of reminding you when a task needs to be 
completed. Quicken Payroll comes with three default reminders so that 
you don't forget important things—like checking if the tax scales are up-to-
date.  You can use Reminders to remind you of anything you like.  Quicken 
Payroll's reminders will only appear at the time and date that you have 
specified and only while Quicken Payroll is running.

At the date and time specified in the Reminders list, a reminder will appear 
on your screen. The Reminders list displays all of the reminders that will 
appear at a later date.

Adding or editing a reminder 
To add a reminder, click Reminders>New. The Add a Reminder window is 
displayed.  To edit a reminder, select the reminder you wish to change and 
then click Reminders>Edit. The Update Reminder window is displayed. 

Date – Enter the date that you first want the reminder to appear.

Time –  Enter the time that you first want the reminder to appear. Time can 
be entered in 24-hour format, or in 12 hour format using A or P to specify 
am or pm. You must press TAB after entering the time.

The Reminders list displays 
the full details of reminders; 
the time, date, frequency and 
the reminder message.
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Frequency –  Select the frequency from the drop-down list to determine 
how often the reminder should appear. 

 If you select Once, the reminder will disappear from the Reminders list 
after it is displayed.

 If you select Weekly, Fortnightly, Monthly or Annually, the date will be 
rolled forward. In the example above, the date on the list will be rolled 
forward to 5/07/1999 after the reminder has been displayed.

Reminder – Enter a description of the reminder. The description can be up 
to 150 characters long.

Deleting a reminder 
If a reminder is no longer used you can delete it.  To delete a reminder, click 
to select the reminder you want to delete, click Reminders>Delete and 
then click OK to confirm that you want to delete the reminder.
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Superannuation Funds List
All of your superannuation funds are set up and edited on the 
Superannuation list. When you are setting up employee details you must 
assign a superannuation fund from a drop-down list that displays all of the 
superannuation funds displayed here.  

Adding or editing a superannuation fund.
Click Super Funds>New, or select an existing fund and click Super 
Funds>Edit. The Update Super Fund window is displayed.

Fund Name – Enter the superannuation fund name. Note that when you 
change the superannuation fund name, you will need to update any 
employee records or pays that use the fund.
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Banking information – If your superannuation fund manager accepts 
contributions and the associated details electronically, enter all of the 
banking information. You will also need to contact your superannuation 
fund manager to find out if they will accept the information electronically.  
The superannuation export file format is included in the Quicken Payroll 
Help. 

Fund Account Number – Enter the super fund This number can be up to 
nine characters long. If you are unsure, please contact your fund to check 
the account number.

Bank Code – Select the code for the superannuation bank account. 
Quicken Payroll includes all the bank codes available at time of product 
release.  If your bank is not listed, add it through the Bank Codes list.  You 
will also need to update the Company Information when you add the 
bank code.

Branch – Enter the name of the branch where the superannuation bank 
account is located.

BSB Number – Enter the BSB (Bank State Branch) number for the 
superannuation bank account. The BSB number is six digit number shown 
before the account number on a cheque.

Account Number – Enter the number for the bank account that you will be 
depositing the superannuation contributions into.  This number can be up 
to nine characters long. If you are unsure, please contact your fund to 
check the account number.

Email Address – Enter the superannuation fund’s email address, if 
applicable.

Note – enter any notes about the fund on the Notes tab.
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Sundries List  
Sundry items include non-recurring adjustments, back pay and expense 
reimbursements that apply to a single pay. Unlike deductions, a sundry 
item cannot be added to the Employee record, because they only apply to 
a single pay.  A sundry item must be added through the Pay Details – 
Sundries window when the pay is being processed.

Adding or editing a sundry item
To add a Sundry, click Sundries>New. The Add a New Sundry window is 
displayed.  To edit a Sundry, select the sundry you wish to change and then 
click Sundries>Edit. The Update Sundry window is displayed.

Name – Enter or edit the Sundry name, up to 20 characters long.

Sundry Type – Select the sundry type:

 Reimburse Expense Item – Use this for reimbursing sundries that 
include GST. Quicken Payroll will calculate GST when you calculate 
the pay on the Pay Details window – Sundries tab.

 Normal sundry – Use this for reimbursing sundry items that do not 
include GST and for adjustments and items other than back pay.

To track GST paid on 
expense reimbursements, 
select the Reimburse 
Expense Item sundry type. 
For reimbursements NOT 
including GST, select 
Normal Sundry.
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 Back Pay <= to 12mths – Select this for back payments of salary or 
wages that accrued twelve months or less ago. This amount will be 
included as part of Gross on the employee's Payment Summary.

 Back Pay > 12mths –  Select this for back payments of salary or wages 
that accrued more than twelve months ago.  This amount will be 
included  in Lump Sum E on the employee's Payment Summary.

Due to the complexity and number of factors to consider when paying 
back pay, Quicken Payroll does not calculate the tax on back pay. For 
details see Calculating tax on back pay on page 66.

Deleting a sundry item
The Delete option is disabled and you will not be able to delete it until you 
remove the sundry item from any pays that use it. You also cannot delete 
the default sundry items - Reimburse Expense Item,  Back Pay <= 12 
months or Back Pay > 12 months.

To delete a sundry item, select the item, click Sundries>Delete and then 
click OK to confirm that you want to delete the item.
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Tax Scales List  
Quicken Payroll includes the most recent PAYG tax scales available at time 
of product release. However, since tax scales change over time, you will 
need to periodically update your tax scales.  There are three ways to 
update the tax scales:

 Using a file sent to you on floppy disk (page 309);

 Internet update (page 309); or

 Through the Tax Scales list.

Adding or editing a tax scale 
If an employee has such a special tax scale from the ATO that is not 
included in the tax scale list, you may need to create a new tax scale. 

To add a Tax Scale, click Tax Scales>New.   To edit a Tax Scale, select tax 
scale you wish to change and then click Tax Scales>Edit. 
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Tax Rate – Enter a number for the tax scale.  If you enter a number that is 
already in use, you will be prompted to enter a different number.

Last Update – Enter the current date.  This will let you know the last time 
that the tax scale was changed.

Description –  Enter a short description for the tax scale. 

Threshold – Enter the thresholds and the multipliers that will apply to 
each threshold. 

Multiplier –  Enter the percentage that the gross should be multiplied by. 
For example, if the tax rate for this scale is 15%, enter 0.15.  Press TAB to 
move to the next column.

Subtract –  Enter any rebate amount that is given to the employee.  
Quicken Payroll subtracts this figure, from the tax calculation to give the 
final tax payable.  For example, for a tax scale with no rebate, enter 0.  If the 
rebate were $100, then you would enter 100.  Press TAB to move to the next 
line. 
Continue entering details for each threshold until all the levels of the tax 
scale have been entered. 

Deleting a tax scale
The Delete option is disabled and you will not be able to delete it until you 
remove the tax scale from any employee records or a pays that use it. To 
delete a tax scale, select the scale click Tax Scales>Delete and then click 
OK to confirm that you want to delete the tax scale.
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Users List 
The Users List displays a list of all people who have been given password 
access to Quicken Payroll. You can set up passwords to prevent 
unauthorised access to your company file and limit particular activities 
within the file, on a user by user, list by list, and function by function basis.  
This gives you total flexibility to customise user access rights. 

Even if you are the only user using Quicken Payroll, you may still want to 
consider setting up more than one user with different rights. For example, 
you could set up one user without rights to edit pays, and then log in as 
this user when you don’t want to inadvertently change any past pays.

Adding or editing a user
The first time that you open the Users List, Quicken Payroll creates a user 
called “ADMIN”. This is the Quicken Payroll Administrator for the 
company file. The Quicken Payroll Administrator has unlimited access to 
all data in the company file and is the only person who can add additional 
users or has access to the User list. 

The Administrator has access to all program functions.  You can delete the 
Administrator, but only if you remove ALL users by clicking 
Users>Remove All.

When you set up users, you will not be able to access Quicken Payroll
without a valid user name and password. When you create a user—
including the Quicken Payroll Administrator, Quicken Payroll prompts
you for a login when you open the company file. 
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To add a User, click Users>New.  To edit a User, select the User you wish to 
change and then click Users>Edit.  The Update User Names and Passwords 
window is displayed.

User Name –  Be sure this is entered precisely as specified by the user, 
including spacing.  If it is incorrect Quicken Payroll will reject their 
password.

Password –  Enter the password carefully—when a user has been set up 
with a password, you will not be able to access Quicken Payroll without the 
correct user name and password. Ideally, the password should be a 
combination of letters and numbers.  This type of combination makes it 
more difficult for unauthorised people to gain access.

Note Passwords and User names are NOT case sensitive.

Verify Password – Click OK. Re-enter the password in the Verify Password 
window and then click OK.

Clear All sets all 
permissions to No.
Set All sets all 
permissions to Yes.

To change a permission, 
double-click.
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Permissions – In the Permissions section, you set up exactly which 
functions each type of user has access to.

 Yes/No – Change access by double clicking to change a Yes to a No, or 
a No to a Yes.

 Clear All – Click to change all permissions to No.

 Set All – Click to change all permissions to Yes.

List column – Yes allows the user to open and view lists.

Add column – Yes allows the user to open and view lists and add 
items to lists. 

Edit column – Yes allows the user to open and view lists and edit 
items on lists.

Delete column – Yes allows the user to open and view lists and delete 
items from lists.

Deleting a user 
To delete a user, select the user name, click Users>Delete and then click 
OK to confirm that you want to delete the user. 

Note You cannot delete the Administrator without removing all users. 
To delete all users and passwords, click Users>Remove All.  This 
will eliminate opening the log-in window when you log into 
Quicken Payroll.  

I’ve forgotten my password, how do I remove it?  
If you have forgotten your ADMIN password, you will need to:

1 Contact Technical Support at 1300 360 641 for details on the password 
removal service.

2 Copy your {Company Name}.QPW file and the QCompany.TPS onto 
a blank disk.  If the file is bigger than one disk, use WinZip. Do not use 
any other backup program. Mail this disk to Technical support as per 
their instructions.
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WorkCover Rates 
WorkCover is compulsory workers compensation that currently applies to 
South Australia and Queensland. Quicken Payroll includes a list of current 
WorkCover rates and classifications.  It uses these to calculate the amount 
of WorkCover liable for each employee. 

Adding or editing a WorkCover rate 
To add a WorkCover Rate, click WorkCover>New. The Add WorkCover 
window is displayed. To edit a WorkCover Rate, select the WorkCover Rate 
you wish to change and then click WorkCover>Edit. The Update 
WorkCover window is displayed.

WorkCover Classification Number – Enter the six-digit WorkCover 
Classification Number.

Description –  Enter a description of the WorkCover rate.  This is usually 
the name of the WorkCover rate.

WorkCover Amount – Enter the amount of WorkCover per dollar.  This 
rate needs to be entered as a percentage (cents per dollar) rate. For 
example, if you are entering 3% enter 3.0000.
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Applying a WorkCover rate 
To apply WorkCover to an employee’s wages, select the WorkCover rate on 
the Employee record – Taxation tab. 

To apply WorkCover to an allowance, you select the option through the 
Allowances list. 

Deleting a WorkCover rate 
To delete a WorkCover rate, select the rate, click WorkCover>Delete and 
then click OK to confirm that you want to delete the rate.

Workers Compensation – Payments and Claims  
Selecting this menu item will display a list of all Workers Compensation or 
WorkCover (SA and QLD) claims and payments made in the currently 
open company.

You can also enter compensation payments when processing a pay and 
you can enter payments and claims through the employee record.
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Adding or editing a Workers Compensation/ WorkCover 
claim or payment 

To add a compensation Item, click Compensation>New.  The Add a 
Compensation Record window is displayed.  To edit a compensation Item, 
select the workers compensation item you wish to change and then click 
Compensation>Edit.  The Update Compensation window is displayed.

On the Employee tab, enter the employee number of the employee for 
whom you are recording a claim or payment. When you enter the number 
and TAB to another field, the employee's first and last names will be 
automatically entered.

On the Insurer tab, the default Insurer details from the Company 
Information-Insurer tab are entered.  You can change the insurer for this 
claim/payment by editing the details on the Insurer tab. 
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On the Injury tab, the current date should already be entered for you.  If 
the injury, or payment, is to be entered for another date, right click on the 
Date and select the correct date.

Injury – Enter a description of the injury.  You can enter a maximum of 30 
characters for the description.

Amount – Enter the amount of the claim, or payment.

Payment or Claim – Click to indicate  if the workers compensation item
is a  Payment or a  Claim.

Deleting a compensation item 
To delete a compensation item, select the item, click 
Compensation>Delete and then click OK to confirm that you want to 
delete the item. If you remove a compensation item, it will be reflected in 
the employee's record, Workers Compensation record and audit trail 
report.
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The Activities Menu

Prepare Pays 
The Prepare Pays command is where preparation and processing of your 
payroll starts.  When you choose Prepare Pays, the Pays Summary window 
is displayed.  The Pays Summary window controls the processing of all 
pays.  All your employees' pays are displayed, allowing you to see exactly 
what each employee will be paid before you process the pays.

The Pays Summary window 
is where you select the 
employees you want to pay, 
preview pays and make any 
adjustments required.

Double click on an employee’s 
name to edit their pay.

Click Activities>Process 
Pays to process the pay when 
you entered hours and any 
adjustments.

For full details on preparing and processing your payroll, see 
CHAPTER 4 – Preparing and processing your payroll on page 47.
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Terminate Employee – The Termination Wizard 
When an employee leaves or is terminated, the Termination Wizard makes 
it very easy to calculate the termination pay.  It will automatically calculate 
any leave owing and the tax due on any Eligible Termination Payments (ETP). 
Quicken Payroll's termination pay is calculated in line with the ATO's 
example as provided on the weekly tax coefficient sheet.

Terminating an employee 
You can select the employee you want to terminate and start the 
Termination Wizard in one of three ways:

 Click Terminate an Employee on the Process Pays Navigator, and then 
select the name of the employee you want to delete from the Name 
drop-down list;

 Choose Terminate Employee from the Activities menu and then select 
the name of the employee you want to delete from the Name drop-
down list; or

 Select the employee from the Employees list and then choose 
Terminate Employee from the Activities menu. If you have a lot of 
employees, this is probably the quickest way to find the employee 
name.

When the Termination Wizard appears, enter the requested information 
and click Next after each step is completed.  Press F1 while the Termination 
Wizard is open for further information on each step. This will bring up 
Quicken Payroll Help with instructions for that specific section.
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Reason for Termination – Select a reason for termination from the drop-
down list and select the reason you are terminating the employee. 

Quicken Payroll will calculate the tax differently, depending on which 
option is selected. If you select Redundancy as the reason for terminating 
an employee, the following rules apply: 

 PRE 18-August-1993 and POST 17-August-1993 Annual Leave is placed 
in Lump Sum A in the employee’s Payment Summary.

 PRE 16-August-1978 Long Service Leave is placed in Lump Sum B.

 POST 16-August-1978 and POST 17-August-1993 Long Service Leave is 
placed in Lump Sum A.

 Any leave loading applicable will have up to $320 tax-free.

Hours Normally Worked In A Pay Period –  Check that the hours are 
correct.  If they are wrong then the leave pay out will be incorrect. 

Outstanding Pay – If the employee has any outstanding pay periods, such 
as a pay for their last week of work, select  Yes, Pay The Employee and 
click Next. If the employee has no outstanding payments for work done, 
select  No, Do Not Pay The Employee and then click Next.

If you select  Yes, Pay The Employee, the Add a Termination Pay window 
will be displayed, allowing you to enter the final pay. Enter the final pay 
details and then click OK. 
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Outstanding Long Service Leave – If the employee had any Outstanding 
long service leave, check that the calculated figures are correct. 

This window shows you the dollar value of long service leave and what 
period it applies to.  When working out how much leave is applicable for 
each payroll period, Quicken Payroll factors in the number of hours a week 
the employee normally works and what their leave entitlement is.

Outstanding Annual Leave – Check that the annual leave and leave 
loading are correct. 

These values are based on the employee's Normal Hour settings in their 
employee record.  The number of hours in a pay period comes from this 
pay rate. Quicken Payroll also uses the employee’s start date to calculate 
how much should go into each period. 
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Eligible Termination Payments (ETP) If this pay includes any ETP, click 
Yes.  If not, click No. 

ETP payments include lump sum payments made upon resignation, 
retirement, death, that part of approved early retirement payments in 
excess of the tax-free limits, that part of bona fide redundancy payments in 
excess of the tax-free limits and invalidity payments. 

If you select Yes, enter the ETP details, including the amount taxable and 
the employee's tax-free threshold. Quicken Payroll will calculate the tax 
according to the figures you enter.  At the end of the year, the employee 
will receive two Payment Summaries, one for Lump sums A, B, D and E.  
Lump sum C is for ETP payments – these will be placed on their own 
separate ETP Payment Summary. 

Termination Wizard Completed – Enter the date the termination pay is 
being processed for and then check that the calculated figures are correct. 

 Gross – All outstanding pay amounts are placed into the Gross box of 
the termination pay.

 Lump Sums – Any lump sums that you may want to pay the employee 
on top of their termination pay.

Eligible Termination 
Payments (ETP)

ETPs are lump sum 
payments in consequence 
of termination of 
employment. 

G l o s s a r y T e r m
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If you wish to pay an employee any extra amounts, such as a “golden 
handshake”, enter the figure into Lump Sum D.

Example If you decide that you want to pay your employee an extra 
$5000 because they have worked for the company for 10 
years, you would enter the figure into Lump Sum D.  This 
figure would then appear in the L Sums field to the right.

Click Finish and then click Yes to confirm that you want to terminate the 
employee. Quicken Payroll then prints the ETP Payment Summary.

Lump sum descriptions 
The amount at Lump Sum A was paid:

 for unused long service leave that accrued after 15 August 1978 but 
before 18 August 1993; or

 for unused holiday pay and other leave related payments that accrued 
before 18 August 1993; or

 for unused long service leave, unused annual leave and other leave 
related payments that accrued after 16 August 1978, or unused holiday 
pay or related payments, where the amount was paid because the 
employee ceased employment, under an approved early retirement 
scheme, because of invalidity or because of bona fide redundancy.

All of this amount is taxable, but the maximum rate of tax is 30% plus the 
applicable Medicare Levy rate

The amount at Lump Sum B was paid – for unused long service leave 
which accrued before 16 August 1978.  Only 5% of this amount is taxable.

The amount at Lump Sum C represents – Eligible Termination Payments.  
If the employee is being made redundant then a portion of this amount is 
tax-free. These amounts are reported on the ETP payment summary.

The amount at Lump Sum D represents – tax-free bona fide redundancy 
payments or approved early-retirement scheme payments.

The amount at Lump Sum E was paid – for back payment of salary or 
wages which accrued more than 12 months ago.  All of this amount is 
taxable, but an offset may be available.
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Reinstate Employee
If you have accidentally terminated the wrong employee, or an employee 
has previously left the company and is returning, you should use this 
wizard to reinstate them.

To reinstate an employee:

1 Choose Employees from the Lists menu or click Employees on the 
toolbar.

2 Click on the Display Terminated Employees check box.

3 Click to select the employee you wish to reinstate.

4 Choose Reinstate Employee from the Wizards menu.

5 Enter the requested information in Reinstate Wizard and then click 
Next after each step is completed.  Press F1 while the Reinstate Wizard 
is open for further information on each step.

Employee Name – Check that the box next to Employee Name contains 
the correct name.  If it doesn't, click on the box and select the correct name.

Reason – Click to indicate the reason for reinstatement:

Accidental Termination – Use this option ONLY if you terminated 
the wrong employee by mistake.  When you select this option the 
employee's termination date will be reset and all their leave and other 
details will be restored.

Returning to Company – Use this option ONLY if you are reinstating 
an employee who has previously left the company.  When you select 
this option the employee personal details will be restored but 
previous information such as leave accrued and their termination 
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date will be kept in the termination section.  Employees reinstated 
using this method will be assigned a new employee number.  This 
allows Quicken Payroll to print multiple Payment Summaries for the 
employee at the end of the financial year.

To reinstate the employee, click Finish and then click Yes to confirm that 
you want to reinstate the employee.

Import Timesheet Data  
This feature allows you to import pay details from various bundy (time) 
clocks.

Setting Employees up for timesheet import
Before importing timesheets, certain items need to be set up in Quicken 
Payroll for each employee:

1 Choose Awards from the  Lists menu. Ensure that for every award in 
the timesheet import file, there is an award set up with the same name 
Quicken Payroll.

2 For each award, click on the Timesheet tab and then ensure that shifts 
have been set up to cover every hour of every day.

3 Ensure that each employee for which a timesheet will be imported has 
been set up for being paid using the timesheet method.  To do this, 
select Employees from the Lists menu. On the Personal Details tab, 
select  Timesheet in the Pay Employee Using section.

4 For each employee for which a timesheet will be imported select an 
award and classification on the employee record – Company tab.

5 For each employee for which a timesheet will be imported, ensure that 
the employee has their Normal Hours pay rate set up as an Hourly Rate 
or  Use Award Pay Rates is selected on the employee record – Pay 
Rates tab. 

For a Normal Hours pay rate to be set up as an hourly rate, the Use as 
Normal Hours Pay Rate option must be selected for the pay rate on 
the Pay Rates List. 
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Importing a timesheet
1 Choose Import >Timesheet Data from the Activities menu to display 

the Import Timesheet Data window.

2 If the timesheet data file displayed (the default file is Ts.txt) is not the 
file you want to import, click Browse and to locate the timesheet data 
file. 

3 Click to select the timesheet import file and then click Open. 
Alternatively, you can double-click on the timesheet import file.

4 Click Import File to import.  When the import is completed, the 
Employee List will be displayed.  The pay details imported will not be 
displayed yet, because the pay has not been processed.

5 After the import is completed, click the Pay Run icon from either the 
toolbar or the navigator and you will find that the relevant details 
have been imported to the pay. After details are checked, you will 
need to click Process Pays to actually create the pays.

Troubleshooting.
If you have tried importing and nothing seems to have imported, you 
should check the following:

 Ensure that the employee and award details are set up correctly as 
explained above.  

 Check to ensure that the employee actually has a timesheet record in 
the timesheet import file.  You can do this by locating the import file 
using Windows Explorer and then clicking on the file to open the file 
with Notepad.  To display all the details in Notepad, choose WordWrap 
from the Notepad Edit menu.

 Ensure that the Pay Date and date paid match the pay being processed.
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 Ensure that the timesheet file format is correct. The correct format is 
comma delimited, with a carriage return line feed after each record. 
This means that after each field there is a comma and after each 
timesheet record there is a carriage return and line feed characters. 

See Quicken Payroll help for the import file format (choose Search for 
Help On.. from the Help menu and then type Timesheet Data File Format 
into the Index tab). 

If you want to create an external program that collects payroll data and 
imports it into Quicken Payroll, you should inquire about the Quicken 
Payroll  developers kit, available at a later date.  See the Quicken website 
for further information. 
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Import MYOB PowerPayTM 
The Import MYOB PowerPayTM function imports your employee and 
payroll details from MYOB PowerPay v5 into Quicken Payroll. You can 
only import MYOB details into a new Quicken Payroll company.

The Employee list and details are imported, as well as your Pays list and 
details. Because not all of your lists are imported, you will still have to enter 
some details, but the most important details will have been imported.

The import procedure is essentially a two step procedure:

Step 1 – Export details from MYOB PowerPayTM

1 Open MYOB PowerPayTM. 

2 Choose Export Data from the MYOB File menu.

3 Change the list at the top to “Payments Full Details”.

4 Make sure that the Include Headings box is not ticked.

5 Change the date range so that it includes all of the dates that you have 
Power data for. For example, to be sure to include all data, you could 
enter 01/01/1990 to 31/12/2002.

6 Click OK twice, then Select the folder that you want to save the file to. 
You may want to note where you save this file to.

7 Repeat the above steps four more times, replacing Payments Full 
Details in step 2 with Payments Summary, Employees, Departments and 
finally Payments Full Details. 

This will create a total of five export files, containing all of the data and 
details that will then be imported into Quicken Payroll.

Step 2 – Import the MYOB PowerPayTM files into 
Quicken Payroll
1 Select Import> MYOB PowerPay TM from the Activities menu, to open 

the MYOB Import Wizard.

2 The Wizard will take you through the PowerPay export steps, as 
explained above, but you may find it easier just to refer to Step 1 
above.
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3 In the files section, either type in or locate the MYOB export files. To 
locate the files, click on Browse.

To import MYOB PowerPay employee and payroll details, you must 
export five files using MYOB and then import those five files using 
Quicken Payroll.

4 Click Import. When the import is completed, click Finish. You should 
then review your company file and complete the details that are not 
imported, such as company information, awards, etc.
278 CHAPTER 7 - Finding your way through Quicken Payroll’s menus



Export Payroll Data to QuickBooks 
The QuickBooks Export feature allows you to transfer your payroll 
information, including employee names and pay data, to QuickBooks. 

You can transfer data to QuickBooks in the way that works best for you. 
You can transfer pays for all employees, or for a single employee; you can 
transfer all of the payroll data, or you can choose to only transfer a single 
amount to be deducted from QuickBooks payroll bank account. 

Transferring payroll data to QuickBooks 
The method of payroll data transfer depends on whether or not you select 

 Link to QuickBooks in the General preferences.

1 Choose Export >To QuickBooks from the Activities menu to display 
the Export Payroll Data window.

2 On the Standard Options tab, complete the following sections.

Pay Date  – Check the pay date of the pay to be transferred.  The most 
recent pay date is displayed by detault.  If you want to export a pay 
other than the pay displayed, change the date.

Export File – The export file name and location are displayed for 
information purposes only and cannot be changed.

3 On the Advanced Options tab, complete the following sections:

Employee to Export – If you want to export pay details for only one 
employee, select the employee from the drop-down list.

Use Minimum Number of Accounts – Select this option if you want 
all deductions and allowances to be exported into a single 
QuickBooks account. If this option is not selected, each deduction 
and allowance will have its own separate account in QuickBooks.

IIF File

An Intuit Interchange 
format (IIF) file is a 
specially formatted file 
used to import and export 
transactions into or from 
QuickBooks.

.
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Only Export Totals – Select his option if you only want to export the 
total amount of payroll expense to be deducted from the QuickBooks 
payroll bank account, rather than all of the payroll details.

Export Jobs and classes – If this option is selected, the Customer:Job 
is exported into the Name field in QPExport.IIF. If not selected, the 
employee name is exported into the Name field in QPExport.IIF.

This option should only be checked when you capture Customer:Job 
information within Quicken Payroll and you want to transfer the 
data electronically into QuickBooks.

For further details, refer to the on-screen help.

Employee Leave Liability – Click to select  whether you want to 
transfer the total leave liability, just the liability for this pay, or not 
transfer the leave liability at all. The dollar value of accrued leave is 
exported, calculated as the employee's Normal Hours rate (or another 
rate designated as a normal pay rate) times the number of hours 
accrued.

4 Click Export. A message will inform you of the pay date of the payroll 
you are about to export and then ask if you want to continue. 

Check the date again. If you export a pay that has already been 
exported, the pay will be duplicated in QuickBooks.

5 Click Yes to confirm that you want to transfer the payroll information 
for the pay date specified to QuickBooks. 

6 Quicken Payroll creates an export file—an IIF (Intuit Interchange 
Format) file that you can easily import into QuickBooks. The file will 
be saved to the folder that you normally use for importing IIF files into 
QuickBooks.

In QuickBooks, you can import the file by selecting 
Utilities>Import>Import> Import IIF from the QuickBooks File 
menu. 

If you have selected  Link to QuickBooks in General Preferences, 
Quicken Payroll opens the QuickBooks file that you selected in 
preferences and transfers the payroll data. 

7 After the pay has been exported, the List Employees window will be 
displayed. 
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What happens in QuickBooks?
1 Quicken Payroll sets up payroll accounts, employees list, cust:job list 

and class list in QuickBooks. 

In QuickBooks, you must ensure that the employee names are an 
exact match, including the middle initial. If a name differs even 
by one letter, the name will be duplicated in Quicken Payroll, or 
an error message will arise and the pay for that employee will 
not export. 

If you have been using QuickBooks payroll accounts that differ 
from the default accounts in the Export Preferences window, 
Quicken Payroll will post the transactions to the accounts set up 
in Export Preferences.

2 For employees paid by cheque, Quicken Payroll creates a cheque in 
QuickBooks, ready to be printed.

3 For employees paid by cash or EFT, Quicken Payroll creates a non-
printable cheque in QuickBooks.

4 All other payroll transactions are imported into QuickBooks as general 
journal entries.

5 Wages that have been assigned to a customer:job are imported into 
QuickBooks as billable expense items, which can be added to a 
QuickBooks invoice by clicking the Expenses button when you create 
the invoice.
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Export Payroll Data to Quicken
Selecting this menu item will display the Export Payroll Data window.  This 
will allow you to create a QIF file (Quicken Interchange File) for 
transferring your payroll information to Quicken for Windows. To create 
the QPExport.QIF file:

1 Choose Export>Payroll Data to Quicken from the Activities menu to 
display the Export Payroll Data window.

2 Enter the Pay Date of the pay information that you want transferred 
to Quicken.

3 Enter the Quicken Account Name that the payroll expense is to be 
exported to and select the current date format that your Quicken file 
uses.

4 Click Browse and then select the Drive and folder where you want the 
QPExport.QIF file to be placed. Click on the Save In drop-down list to 
select a different folder. To open the folder one level higher, click  
on the toolbar.

Click OK after you have selected the location for the export file.

5 Click Export and then click Yes to confirm that you want to export the 
payroll information for the pay date specified.

6 Open Quicken and import the QPExport.QIF file.  Please refer to your 
Quicken user guide for additional information on importing files.

QIF File

A Quicken Interchange 
format (QIF) file is a 
specially formatted file 
used to import and export 
transactions into or from a 
Quicken account register.

QIF is one of the formats 
that Quicken can export 
data to and it is the only 
format that Quicken can 
import data from.
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Exporting data to other software programs
When you export data from Quicken Payroll, your payroll data is exported 
in Quicken Interchange format (see above). You can then import the QIF 
file into other financial software applications. Check the documentation 
that came with your specific financial software application to see if it 
recognises QIF files. To create a QIF file, refer to Export Payroll Data to 
Quicken (above).

If you cannot use a QIF file to export your data to another program, you 
can create your own custom export file format. To do this, you will require 
the file format your other program requires. 

For details see Exporting report data on page 153.

Export Payroll Data to EFT  
Selecting this menu item will display the Export Payroll Data window.  
This will allow you to create an EFT file for transferring wages from the 
company's bank account to your employee's bank accounts.  

Before you create the EFT file you should check that your preference 
settings match your banking software.

Creating an EFT file
1 Choose Export>Payroll Data to EFT (for banking) from the Activities 

menu.

2 Pay Date – Enter the pay date of the data you wish to transfer.
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3 EFT Date – The EFT date for the EFT file should be the current date or 
a future date. Using a date in the past usually results in your banking 
program producing an error message and refusing to send the file.

4 If you want to change the export file location, click Browse. Select the 
folder where you want to place the EFT file.  

5 Click Export and then click Yes to confirm that you want to export the 
wages for the pay date specified.

6 Open your banking software and use the QPExport.ABA file to 
transfer funds to your employee's bank accounts.

If your bank will not accept the EFT file you are sending, you probably 
need to change your Electronic Funds Transfer options in Files Preferences 
(see page 175). See Changing the EFT options if your bank will not accept the 
EFT file you are sending them on page 100.

Use ATO Electronic Funds Transfer (see page 234) from the Lists menu to 
make EFT payments to the ATO. 
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Export Superannuation 
You can create two files for transferring superannuation contribution 
details to the relevant superannuation fund. It also creates a third file—an 
EFT file that you can use to pay the superannuation funds electronically.

Before transferring any data, be sure to speak with your fund manager to 
see if they support this method of transferring the payroll information. 

Creating the Superannuation export files 
1 Choose Export>Super Contributions from the Activities menu to 

display the Export Superannuation Data window. 

Start and End Date – Enter the date range for the superannuation 
contributions details to be included in the export file.

Employee Details and Super Details – These are the files that you will 
send to your superannuation fund, either on a floppy disk, or by
email. Click Browse to see where these files will be saved to. 

By default, these files and the EFT file will be saved to C:\Program 
Files\QPRollv12\Data. If you want to change the location of the file, 
select the folder where you want the file to be placed and then click 
OK.
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The superannuation information file names will be based on your 
company name and the pay date. For example, for a company named 
Company Pty Ltd, the employee information and contribution 
information files for the May 2000 would be respectively named 
Company Pty Ltd (E) 052000.txt  and Company Pty Ltd (P) 052000.txt.

EFT Details – This is the file that you use with your banking software 
to pay the superannuation funds electronically. Click Browse to see 
where the superannuation EFT file—QPSuper.ABA will be saved to. If 
you want to change the location of the file, select the folder where you 
want the file to be placed and then click OK.

File Format – Select a file format from the drop-down list.  You can find 
out from your fund manager which format to use.

EFT Summary Only – Select  this option.  This will cause the EFT file 
to only contain the total amount due to the superannuation fund.  
If you leave this check box  cleared, Quicken Payroll will transfer the 
contribution amounts for each employee separately—resulting in the 
bank charging you for each individual transaction.

2 If your super funds are at different superannuation companies you 
will need to create a file for each individual fund.  To create a file with 
just one super company's funds, double click on the funds that should 
not be included so that a NO appears in the Include column.

3 Click Export and then click Yes to confirm that you are exporting the 
correct superannuation contributions.

4 You will be asked if you want to print the super report. Click Yes to 
create a report for each fund.  This report includes new employees and 
allows the payroll administrator to enter the contact details should the 
fund manager have any questions.  
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5 If you click No, or after your super report is printed, you will be asked 
next if you want to email your export files to your superannuation 
provider. If the superannuation fund supports emailing the files, click 
Yes to display the Send Super Export Files window.

Enter the superannuation provider’s email address or click on the 
button on the right to open your email program’s address book. 
When you click Send, an email message with your superannuation 
files attached will be saved to your email programs outbox.

6 If you can’t send the files by email, copy the two information files onto 
a floppy disk and then mail the disk to your superannuation fund, 
along with your payment.

7 To make the payment electronically, open your banking software and 
use the QPExport.ABA file to transfer funds directly into the 
superannuation fund bank accounts. For further details, see Paying 
your superannuation funds by Electronic Funds Transfer on page 98.

What is the Superannuation export file format? 
Superannuation export creates three separate files:

1 The EFT file – Use this file along with your banking software to 
electronically transfer the super funds directly from your bank 
account.

2 The Employee information file – This file provides your Super fund 
with employee details.

3 The Super contribution information file – This file provides your 
Super fund with superannuation contribution details (see below).

Contact your super fund manager to find out if the two information files 
conforms to their standards for EFT files. For details on the export file 
format, see Quicken Payroll help (choose Search for Help On.. from the 
Help menu and type Superannuation Export File Format into the Index tab).

Click here to open your email 
program’s address book and 
select the address you want to 
send the superannuation 
information files to.
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End of Year Process  
Quicken Payroll does not require you to do anything at the end of the 
financial year.  It automatically resets the employees' YTD figures when 
you process the first pay in the new financial year.

If you have a large number of employees you may wish to archive (select 
Archive Data from the File menu) the previous financial year’s pays and 
terminated employees to another file.  This will ensure that Quicken 
Payroll will operate as fast as possible.

When archiving information out of your file, be sure to keep multiple 
backup copies. You will need them if the ATO decides to audit you. For 
details, see Archive Data on page 162.

The Navigator
Quicken Payroll's Navigator is designed to show you how to access and 
use the most features of the program.  To start the Navigator, click Start 
Navigator at the top of the screen.  If you don't need to use the Navigator, 
click Close Navigator.

Each Navigator section represents a major payroll function and displays a 
related group of list and activities.

Click here to close the 
Navigator windows.

Select a Navigator section 
or an open window from 
the panel on the left.

The most commonly used 
reports for this area are 
displayed for your 
convenience. Just click to 
create and display the 
report.
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To close the Navigator, click on the close button at the top of the panel on 
the left. To open the Navigator windows, choose Open Window List from 
the View menu.

The Navigator windows
Setup Company – Provides all the steps necessary to get a company file 
quickly set up and running. Create your company files, employee records 
and awards.

Company – Edit company details, update tax scales, set up users and 
passwords and update Quicken Payroll.

Process Pays – Process pays for your employees, print their pay slips and 
print selected reports. 

Payment Summaries –  Shows you the steps involved in preparing your 
summaries at the end of the year, depending on your Printing Preferences 
(see page 171). 

Super Payments – Shows you how to lodge your superannuation 
contributions electronically with your fund manager. 

Tax Payments – Shows you the steps involved in making an EFT payment 
to the ATO. 

How Do I?
How Do I? is a great way to quickly find out how to do something in 
Quicken Payroll.  Instead of searching though the user guide or the 
Quicken Payroll Help, you can quickly bring up the most relevant help 
topic simply by clicking on a topic displayed in the How Do I? list.

Click on the How Do I? icon to display the list of instructional help topics 
related to the currently open Navigator. 
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The Reports Menu

Quicken Payroll Reports  
Quicken Payroll reports, including forms such as pay slips and Payment 
Summaries are created, viewed, edited and printed using the Quicken 
Payroll Report Writer.  When you choose a report from the Reports menu, 
the Report Writer is opened up in a separate window and a separate 
program button appears on the Windows taskbar. You can use these 
buttons to quickly switch between the Quicken Payroll and the Report 
Writer.

You can generate reports from several convenient places in Quicken 
Payroll: 

 From the Reports menu,

 From the Reports List,

 From the reports listing on the Quicken Payroll Navigator,

 From most Lists,

 From the Print Pay Reports window when you process your payroll, 
and

 From the Report Wizard.

For details on generating reports, customising reports and creating new 
reports, see CHAPTER 6 - Using reports to manage your payroll on page 121.

Report Dates
When you open a report, Quicken Payroll uses the date of the latest Pay 
Date processed. For example, if you process a pay with a fortnightly pay 
date of October 14 and a weekly pay date of October 15, the automatic 
report dates will be October 15. To change the dates, select Custom from the 
Dates drop-down list and then enter the From and To dates of the period 
you want to print a report for.
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Report List 
You can access Quicken Payroll's preset default reports and custom reports 
through the Reports menu, or through the Report list. 

The Reports list displays all of the Quicken Payroll preset reports, as well 
as any reports that you have created, or customised and renamed.  From 
this window, you can access all of the report functions you need.

Any new reports that you add, or preset reports that you modify, will be 
listed in the User Defined tab.  These reports will  also be displayed on the 
Memorised Reports list, but only if you select  the Add to memorised 
reports option in the Report Properties window.

Note Sort order and filter changes that you make to reports will only be 
available when you access the reports through the Report List or 
if you save the changes to the memorised report list. These 
changes will not be recognised when you access reports through 
the reports menu.

User Defined tab – When you customise a preset report and then save it, 
the default name will be Custom {report name}.  This report will then be 
listed in the Reports List under the User Defined tab.

Wizard – Opens the Report Wizard.
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Add – Opens the Report Properties window. To create a new report, click 
Add on the Reports List.  Doing so will display the Report Properties window, 
where you name the report, set printing and page options, sub-totalling 
and totalling and when a new page is started.

Edit – Opens the Report Properties window, where you can edit, print and 
save the report. Alternatively, you can just double click on the selected 
report name. 

Delete – Deletes the report. To delete a report, click to select the report you 
want to delete and then click Delete. 

Copy – Opens the Report Properties window and creates a copy of the 
selected report named Copy of {original report name}.  
For example, if you selected the Pays Report and then clicked Copy, the 
Report window will open with a report name of Copy of Pays Report.

Print – Opens the report, so that you can review the report, make any 
changes required and then print the report.

Close – Closes the Report List.

Memorised Reports
When you create a new report, or edit an existing report, you have the 
option of adding the report to your Memorised Reports list.  Memorised 
reports are also displayed in the Reports List, on the User Defined tab.

In the Report Writer:
1 Click Report Properties from the Activities menu.

2 Select  the Add to memorised reports option.

3 Click Save.

4 Choose Save Report from the File menu.

In Quicken Payroll:
1 Choose Memorised Reports from the Report menu.

2 Select the memorised report from the list.  The Report Writer opens 
and displays the report.
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For further details, see CHAPTER 6 – Using reports to manage your payroll on 
page 121.

Activity Statement Details 
Under the New Tax System most of your tax obligations and entitlements 
are now reported on a new single form—the Business Activity Statement 
(if you are registered for GST) or the Instalment Activity Statement (if you 
are not registered for GST). 

If you use QuickBooks, or another accounting program that you can export 
payroll data to, you can export your PAYG and GST information to your 
accounting program and produce your Business Activity Statement or 
Instalment Activity Statement in QuickBooks. 

If you are not exporting your payroll data to an accounting program, the 
Quicken Payroll Activity Statement Details report provides you with the 
information you need to manually fill out your Activity Statement. The 
report will provide you with:

 Reimbursements and GST on reimbursements

 Contractor wages subject to withholding rates and amounts withheld

 Contractor wages subject to No ABN Withholding rates and amounts 
withheld

 Total PAYG Salary, Wages and Other Payments and amounts withheld

Allowances Report  
This report will show you a list of allowances paid to your employees.  The 
report will provide you with:

 The allowance name.

 The total amount of allowances paid.

 The employee's name.

 Whether the allowance was included in superannuation calculations.

 Whether the allowance was included in tax calculations.
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By allowance –  Allowances report sorted by allowance name for the 
current pay period, for the current month, or for the current financial year.

By employee –  Allowances report for the current month, sorted by 
employee number, name order, or department order.

By pay date –  Allowances report sorted by pay date for the current pay 
period, current month, or current financial year.

Return to default – Reverts the reports back to their default settings.   

Audit Trail Report  
This report provides you with a list of changes made to the company data 
file, who they were made by and when they were made.  It has the 
following details:

 The date and time the change was made.

 The name of the user who made the change.  This will only appear if 
the user logged in using a user name and password.

 The name of the employee the change was made to.

 Details of what was changed.

Banking Reports  
The banking reports provide you with several reports for your banking 
needs.  Each report will have the following details:

 The type of bank split (for example, Cash, Cheque or EFT).

 The date of the pay (for example, Pay Date).

 The employee's name and number.

 The employee's bank account details (if applicable).

 The amount to be paid to cash, cheque or EFT.

 The account number for your company's bank account (if applicable).

Print Cash – Cash payable report that shows you each employee who is 
being paid a cash amount and the amount to pay them. 
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Print Cheque – Cheque payable report that shows you each employee 
who is being paid an amount by cheque and the amount to pay them.  

Print EFT Direct Debit –  EFT report that shows you each employee who 
is being paid via a transfer to their bank account and the amount to pay 
them.  

Print All – Report that combines all of the above information.  The cash 
transactions are shown first, followed by cheque transactions and finally 
by any EFT transactions.

Cash Breakup – Cash breakup report that shows you how much to pay 
each employee, broken down by the number of each denomination 
required per employee.  It also provides the total number of each 
denomination so that when you obtain the cash, you will have the correct 
cash to pay each employee.  

This report will only list employees that are set up for payments by cash in 
the employee record – Banking tab. To exclude denominations not needed, 
click on the Edit Report button, select the column not required and then 
click Delete.

Return To Default – Reverts the reports back to their default settings.  

Class Reports  
This report will show you a list of salary and wages paid, categorised by 
class. 

You can print the report for the current pay, month-to-date, or year-to-
date. Return To Default reverts the reports back to their default settings.   
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Compensation Report  
This report will show you a listing of Workers' Compensation or 
WorkCover (SA and QLD) payments to your employees and claims made 
against your Workers' Compensation insurance company.  The report will 
provide you with:

 The employee's name.

 The date the payment or claim was made.

 The injury the payment or claim was for.

 The amount of the payment or claim.

By employee – Compensation report for the current month, sorted by 
employee number, name order, or department order.

By pay date – Compensation report sorted by pay date for the current pay 
period, current month, or current financial year.

Customer:Jobs Report  
This report will show you a list of your customer:jobs and how much you 
have billed them.  The report will provide you with:

 The name of the client/department billed.

 The date they were billed (for example, Pay Date).

 The name of the employee(s) who did the work for the 
client/department.

 The part of the employee's pay that was billed to the client/department.

 How much it cost you for the employee's time.

 How much you charged your client/department for the employee's 
time.

You can print the report for the current pay, month-to-date, or year-to-
date. Return To Default reverts the reports back to their default settings.   
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Deductions Report  
This report will show you a list of deductions taken from employees’ 
wages.  The report will provide you with:

 The deduction name and total amount of deductions payable.

 The pay date of the pay that the deductions were taken from.

 The employee's name and an identification number (such as a union 
membership number).

 The amount of each deduction.

By Deduction – Deductions report sorted by deduction name for the 
current pay period, month, or for the current financial year.

By Employee – Deductions report sorted by employee number, surname, 
or department for the current month.

By Pay Date – Deductions report sorted by pay date for the current pay 
period, month, or for the current financial year.

Employees Report  
This report will list all of your employees, in the order you select.  It will 
display the employees’ name, surname, number, employment status, 
department and when they were last paid.

Number Order – report sorted by employee number.

Name Order – report sorted by employee surname.

Department and Number Order – report sorted by department and 
employee number.

Department and Name Order – report sorted by department and 
employee surname

Employee Details – report sorted by employee number, that lists your 
employees' personal details, their leave details, award details and contact 
details.
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Leave Report  
This section provides you with two reports for your leave tracking needs.

Leave Taken – report detailing who took leave, when they took it and the 
cost of the leave.  This report shows:

 The date of the pay.

 The employee's name and department.

 The type of leave taken.

 The number of hours leave taken.

 The dollar value of the leave taken and of any leave loading.

 The start and finish date of the leave.

Leave Accrued – report detailing how much leave is owing to each 
employee and the dollar value of the leave.  This report shows:

 The employee's name and department.

 The leave type.

 The hours the employee is entitled to and the hours accrued.

 The accrual period.

 The dollar value of the leave accrued and the dollar value of leave 
loading, if any, that has accrued.

Why don't my leave reports show any dates?
If the leave taken report does not show when the employee took leave, or 
when the leave finished, it is probably because you did not enter the start 
and finish dates when you were paying their leave. 
The other possibility is that you converted your company file from an early 
previous version of Quicken Payroll.  In some early versions, you were not 
able to enter the start and finish dates for leave.

Pay Rates Report  
This report will show you the pay rate(s), the date, the hours paid and how 
much was paid for that pay rate.
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Pay Slips Report  
The Pay Slips Report will provide you with a pay slip you can hand to your 
employees.  Depending on what you selected in Preferences, you will get 
1, 2 or 3 pay slips on a page.

The pay slip layout has changed for 2 or 3 per page layouts. The new 2 per 
page layout fits on A4 continuous paper. By default, Quicken Payroll prints 
pay slips using the new formats, which are the legal requirement. If you 
have old stationery, you will have to print 2 per page–Classic or 3 per page–
Classic from the Report List.

The following information will appear on pay slips:

 Your company name and ACN/Australian Business Number (ABN).

 Employee's name and number.

 Employee's award and classification.

 Employee's department.

 Pay period start and end dates.

 The pay date and the date paid.

 All pay details for this pay, including wages, commissions, allowances, 
deductions, sundries, superannuation and total of tax paid.

 Net amount paid to employee.

 How much leave (in hours) the employee has accrued. 

 The employee's YTD figures for all of the above items.

 A message, if you decide to place one on pay slips.

Pay slips can be printed in number, name, department and number, or 
department and name order.

Leave and Super Pay Slips – Pay slips in a format that shows Leave and 
Super details.

Add Message and Print – Selecting this option will allow you to add a 
message to the pay slips.  This message will appear on all pay slips. 
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PAYG Tax Report 
This report will show you a listing of how much PAYG (Pay As You Go) tax 
you have to pay.  The report will provide you with:

 The pay date of the pay being taxed.

 The employee's name, employee number and department.

 The gross amount of the employee's pay.

 The PAYG payable for the employee.

The PAYG Tax report can be printed for the current pay, current month, or 
the current financial year.

Payment Summaries  
There are five basic payment summary types

 Payment Summary – Individual Non-Business 

 ETP Payment Summary

 Payment Summary – Voluntary Agreement

 Payment Summary – Labour Hire and Other Specified Payments

 Payment Summary – Withholding where ABN not quoted

This section of reports covers the payment summaries and related reports, 
including electronic filing. 

Printing Payment Summaries
Payment Summaries can be printed either on plain paper or the stationery 
provided by the ATO. Your printing choice is selected in Printing Preferences 
(see page 171). Although they must be printed for all employees at the end 
of the year, they can be printed for any employees, at any time of year and 
for any period. Payment Summaries can also be electronically filed and in 
some cases, you may be required to file them electronically.

For details see Printing and submitting your Payment Summaries on page 102.
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Payment Summary – Individual Non-Business 
This payment summary is the most commonly used payment summary. 

Payment Summary Explanation
Payment Summaries consist of two parts

In addition to providing your employees with a Payment Summary, you 
must also provide a Payment Summary Explanation, which can be printed 
separately, or on the reverse side of the summary. The Payment Summary 
Explanation forms consists of the details that are printed on the back of the 
Payment Summary forms provided by the ATO. You must provide your 
employees with these details when you give them their Payment 
Summaries.

You can print the payment explanations either as a separate sheet, or on 
the back of your Payment Summaries after you have printed the front 
section. See page 104 for details.

ETP Payment Summaries
This summary prints automatically when you terminate an employee and 
the employee receives Eligible Termination Payment payments. The ETP 
Payment Summary can also be electronically filed.

Normally, the ETP Payment Summaries are printed when you terminate 
the employee through the Termination Wizard.   If for some reason the 
report didn't print at that time, or if you need to print the report again, you 
can print it through the Reports Window>Print ETP Payment Summary.

Payment Summary – Voluntary agreement
This summary is used when an employee enters a Voluntary Agreement to 
have tax withheld from payments. Tax will be withheld at the payee’s 
instalment rate as notified by the ATO or at a flat rate of 20 percent. 

The contractor can choose between having tax withheld under a voluntary 
agreement, or making their PAYG instalments on their own.
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Payment Summary – Labour Hire and Other Specified 
payments

Labour hire rules apply if you are a labour hire firm and you contract out 
a contractor to provide a specified kind of labour. In this case, you do not 
contract to perform the work—you merely contract to provide someone to 
work under the direction of your client.

Payment Summary – Withholding where ABN not quoted
Any business that supplies to another business and does not quote a valid 
Australian Business Number (ABN) is subject to having 48.5 percent of the 
payment withheld by the payer and sent to the ATO. The business will 
then be able to claim the amount withheld as a credit on their income tax 
at the end of the year. Use this payment summary to report those amounts. 

Payment Summary Deductions Report
Selecting this option will print a report for each employee.  This report lists 
all deductions the employee has received throughout the year and the 
total for each deduction.

Reconciliation Statement
At the end of each year, you must make sure that the total payments you 
have made equal the total of the amounts shown on the Payment 
Summaries you have issued for the year. This report compares the 
amounts paid to the ATO to the amounts showing on employee's payment 
summary and helps you to reconcile your PAYG amounts to ensure that 
payment summaries agree with the company accounts.

Return To Default
Selecting Return to Default will change the Payment Summary back to its 
default layout.  You should only use this option if you have modified the 
Payment Summary to the point that it no longer makes sense.
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ATO Approval Letter
This is a copy of the approval letter received from the ATO.  It confirms that 
the electronic Payment Summary information and EmpDupe file supplied 
by Quicken Payroll has been tested by the ATO and is correct.

ATO Plain Paper Approval 
This is a copy of the approval letter received from the ATO.  It confirms that 
the plain paper Payment Summaries print in an approved format.

Magnetic Media Information form
This is a copy of the form that must accompany your EmpDupe file to the 
ATO.  Make sure that all details have been filled out correctly.

Create EmpDupe File for ATO
Selecting this option will allow you to create the EmpDupe file.  This file 
contains the ATO copy of your Payment Summaries. You will also need to 
print out a Magnetic Media form, fill it in and send it to the ATO along with 
the EmpDupe file. 

You only need to send one EmpDupe file at the end of the financial year, 
instead of individual ones throughout the year.  More than one EmpDupe 
file cannot be placed on a floppy disk.

For details, see Filing your Payments Summaries electronically on page 105.

EmpDupe file

If you print your Payment 
Summaries on plain paper, 
you will be required to lodge 
the ATO copy electronically. 
To do this, you must create an 
EmpDupe file, which 
contains an electronic version 
of all of your Payment 
Summaries. 

G l o s s a r y T e r m
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Payroll Tax Report  
This report will show you how much payroll tax your company must pay.  
The report will provide you with:

 The total amount of payroll tax payable for your state.

 A listing of all the pays included in the payroll tax calculation.  This 
includes:

- The pay date.

- The gross amount of each pay.

- The amount of superannuation on each pay.

- The amount of any allowances that were excluded.

You can print the report for the month-to-date or year-to-date. Return To 
Default reverts the reports back to their default settings.   

What if my payroll tax report doesn't show any tax 
payable?

If there isn't any on your report, it is probably because:

 You don't have to pay any payroll tax, or 

 The payroll tax settings, such as your state, are incorrect.  You will need 
to check your preference settings and your company information. If 
the payroll tax payable is incorrect, it is probably because of these 
settings.
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Pays Report  
The Pays report provides all of the pay details for the current pay run: 

Pay date  Sundries

Employee number  Commissions or bonuses

Employee name  Gross

Hours worked in the pay period  Tax

Deductions in the pay period  Net

Allowances received in the pay period

You can print the report for the current pay, month-to-date, or year-to-
date. Return To Default reverts the reports back to their default settings.   

Sundries Report  
This report will show you a listing of sundries paid to your employees.  The 
report will provide you with:

The date the sundry was paid (for example, Pay Date).

The name of the sundry.

Whether the sundry was included in tax calculations.

The amount of the sundry and the total amount of sundries paid 
for the date(s) specified.

The Sundries report can be printed for the current pay period, the current 
month, or for the current financial year.
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Super Report  
The Super report will show you how much superannuation you have to 
pay to a particular superannuation fund and for which employees.

Quicken Payroll will automatically place any superannuation 
contributions for new employees into the New Employee column.  This is to 
ensure that the superannuation fund knows there is a new employee and 
can ensure the required information is sent to them.

To remove the employees from the New Employee column, export the 
superannuation file – even if you are not using the electronic lodgment 
feature. 

By Fund Name – Super report for the current pay period, current month, 
or current financial year.  Each superannuation fund will have its own 
listing of amounts payable.

By Employee – Super report for the current month in employee number 
order, surname order, or department order.  Each employee will have a 
listing of amounts payable and what accounts they should be paid to.

Why are my Employees Appearing In the Exception 
Column?

Quicken Payroll will automatically place any superannuation 
contributions for new employees into the Exception column.  This is to 
ensure that the superannuation fund knows there is a new employee and 
can ensure the required information is sent to them.

To remove the employees from the exception column, export the 
superannuation file—even if you are not using the electronic lodgment 
feature.
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WorkCover Report  
This report will show you how much WorkCover your company must pay.  
The report will provide you with:

 The date of each pay included in the WorkCover calculations (for 
example, Pay Date).

 The departments in your company.

 The names of your employees.

 The employees' gross wages.

 The amount of superannuation on each pay.

 The amount of WorkCover payable on that pay.

 The total amount of WorkCover that you have to pay (the WorkCover 
Pd column).

The report can be printed for the current pay period, the current month, 
or for the current financial year.

What if my report does not show any WorkCover payable?
If there is no WorkCover payable on your report, it is probably because:

1 None of your employees have a WorkCover rate applied to them.  
Assign WorkCover rates in the Employees record – Taxation tab. 

2 The WorkCover rate is 0%.  To fix this, assign different WorkCover rates 
in the employee record, or change the WorkCover rate.

3 You assigned a WorkCover rate to an employee after you processed 
their pay.
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The Online Menu

Web Sites  
The Online menu consists of links to useful web sites including:

State and Territory Government Web Sites

Business Web Sites
– Australian Tax Office
– WorkCover SA
– WorkCover QLD
– Register for an ABN

Update Quicken Payroll (see The Quicken Advantage Membership 
Program on page 333)

Order Pay slips (see Internet Update on page 309)

Quicken Websites
– Quicken.com.au
– Quicken software website
– Business Website
– Technical Support
– Quicken Advantage

You will need an ISP connection, Internet account and modem to access 
these websites.  Your Internet Service Provider's charges will apply.
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Internet Update  
The Internet Update menu option launches your web browser and opens 
the Quicken Payroll update page, where you can update Quicken Payroll. 
Some update files, such as tax scales, Payroll Tax scales or reports, will only 
be available if they have changed during the financial year.

To use this feature you must have a modem and Internet account with an 
Internet Service Provider.

You can also update PAYG and Payroll Tax Scales through the Tax Scales or 
Payroll Tax scales list, or using a file sent to you on floppy disk.

To update Quicken Payroll:
1 Dial into your ISP connection.

2 Choose Update Quicken Payroll from the Quicken Payroll Online 
menu. Your web browser is launched and the Quicken Update page is 
opened. The Quicken Payroll Internet Update window is displayed.

3 Click to select and install the updates you need.

Update Tax Scales by Disk  
If you don’t have an Internet connection, this feature will allow you to 
update the PAYG tax and Payroll Tax scales using a file sent to you on 
floppy disk. You can also update scales through the Tax Scales list (see page 
258) and the Payroll Tax Scales list (see page 245).

To update the tax scales from a floppy disk:

1 Click Update Tax Scales. on the Company Navigator.

2 Click Yes to confirm that you do wish to update the tax scales.

3 Under drives, select A:

4 On the left, select on QtaxNew.TPS.

5 Click OK.
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The Help Menu

Contents
Choosing Contents from the Help menu opens the Quicken Payroll Help 
contents window which gives you an overview of the entire contents of 
the help file.  

The Contents panel displays the following tabs that you can use to 
navigate through the help file:

 Contents – Click this tab to look through the table of contents of 
everything in Quicken Payroll Help. To open one of the book icons, 
double-click it.  Keep opening books until you get a topic you want to 
read.

 Index – Click this tab to look up a term in the index. Start typing the 
term you're looking for. 

 Find – Click this tab to search for each instance of a word or phrase.  
This kind of search is more thorough, but it may give you topics that 
aren't as relevant as those you find from the Index tab.

To find out about the window you're working in, the quickest way to get 
help is to press F1, or click the Help button on the toolbar.  This brings up 
a help topic related to the window you are currently viewing.

To print a Help topic
In the Help topic you want to print, click the Print button or the Options 
button and then click Print Topic.

You can also use your right mouse button to click inside the Help window 
and then click Print Topic.

Tips
You can print a group of related topics by clicking a book in the Help 
Contents and then clicking Print.

To print the Help in a pop-up window, use your right mouse button to click 
inside the pop-up window and then click Print Topic.
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Search For
This help menu option opens up the help Index tab. Click this tab to look 
up a term in the index.  Start typing the term you're looking for. Double-
click a term to open a topic related to it.

How to use Help
This help menu option opens up the Windows  How to use windows help file, 
which will guide you to make full use of Quicken Payroll Help.  Even if you 
have used help files before, this is worth reviewing for additional tips.

Reset all messages to show again
Some of the warning messages provided by Quicken Payroll have an 
option  Do not show this message again.  When selected, the message 
will not appear again.   If you want to have the warning messages appear 
again, then choose Reset all messages to show again from the help menu.

We recommend that you occasionally reset the messages. This will allow 
you to review the any warning messages again.

QCards
Q-Cards appear in a small yellow window in the Toolbar and provide 
details about completing the currently displayed window. Q-Cards can be 
turned on or off through the Help menu.

Reset window positions and sizes
As you use Quicken Payroll, you may change the sizes and positions of 
various windows.  To change the window positions and sizes back to their 
default positions, close all windows and the Navigator and then click on 
Reset window positions and sizes from the Help menu.
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Telephone Technical Support
Selecting this option displays the Quicken Payroll technical support phone 
numbers. See also Solving problems and getting product support on page 327.

Locate a trainer in your area
Selecting this option will take you to the Intuit Training and Support web 
page, with the most up-to-date list of accredited trainers available in your 
state.  You will need to an ISP connection, Internet account and modem to 
access this service.  Your Internet Service Provider's charges will apply.

About
The About window displays your Quicken Payroll version number, your 
customer number, your registration and multi-user registration number.

You can also display the System Information window from the About 
window. This displays a summary of your computer hardware, including 
information about your system's files, current memory use, printer and 
display setup and drives.  If you contact technical support, they may ask 
your for information about your system, most of which can be obtained 
from the System Information window.
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The View Menu
The View menu provides you with three view options so that you can 
choose the screen appearance that you are most comfortable with.

Open Window List
The Open Window List view option displays the Navigator and Open 
windows panel on the left that provides quick access to the Navigator and 
any currently open windows. This option is also used to re-open the 
Navigator after it has been closed.
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Multiple Windows
The Multiple Windows option closes the Navigator and displays all of the 
windows currently open. This is a useful option when you know the 
program well, or are more comfortable navigating using the Quicken 
Payroll menu and toolbar.
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One Window
 The One Window option closes the Navigator and displays one window 
at a time. You can select the window you want displayed from the 
Windows menu. This is a useful option when you know the program well, 
and need the additional screen space that this option provides.
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Chapter Contents
 Keeping your data safe can include setting up 
passwords to limit access to your company 
data, making regular backup copies of your 
data and maintaining and audit trail to track 
changes to transactions.
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Setting up users and passwords for your company
Some sections of your company's data may be more sensitive than others.  
Use the Quicken Payroll User List to make sure that each person has access 
to only those parts of Quicken Payroll you want him or her to use.  In this 
way, you maintain the security of sensitive areas in Quicken Payroll even 
when multiple users access the company file simultaneously.

The Users List displays a list of all people who have been given access to 
Quicken Payroll. You can set up passwords to prevent unauthorised access 
to your company file and limit particular activities within the file, on a user 
by user, list by list and function by function basis.  This gives you total 
flexibility to customise user access rights. 

If you are the only person in your office that uses Quicken Payroll and your 
computer is in a secure area, you may choose not to use passwords, 
however you should still consider using passwords to protect your data 
from unauthorised access.

The first time that you open the Users List, Quicken Payroll creates a user 
called “ADMIN”. This is the Quicken Payroll Administrator for the 
company file. The Quicken Payroll Administrator has unlimited access to 
all data in the company file and is the only person who can add additional 
users or has access to the User list. 

When you create a user—including the Quicken Payroll Administrator, 
Quicken Payroll prompts you for a login name when you open the 
company file. You can delete the Quicken Payroll Administrator, but only 
if you remove ALL users from the list.

For details on setting up users, see the Users List on page 260.

The Quicken Payroll password function provides a basic degree of 
protection for your data, but it is not a complete security system. 

For example, it will not prevent someone from deleting your company
file using Windows Explorer. If you need a higher degree of security,
keep your computer and backup disks in a secure area.

TipTo prevent other people from accessing your Quicken Payroll
company file, always close it when you are finished using it or if you
plan to be away from your workstation for an extended period of time.
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Backing up your company data
Your payroll data is valuable! No recovery technique can recover you from 
all possible kinds of file damage, or protect against theft or natural 
disasters. You might lose data if you delete the data file by mistake, if your 
hard drive fails (which is not uncommon), or if your computer is stolen or 
damaged. To prevent or minimise the risk of data loss, you should make 
regular backup copies of your Quicken Payroll company data. In the event 
of data loss, you will then be able to restore your data from a backup copy.

For detailed instructions on the Quicken Payroll Back up command, see 
Backup Files on page 158.

Recommended backup procedures
The purpose of backing up is to protect yourself from data corruption and 
from disk failure. Don't forget that both hard drives and floppy disks are 
prone to failure.  Therefore, if your computer has more than one hard 
drive, we suggest that you perform regular backups to both floppy disks 
and a drive other than the one where you keep your working data. 

We recommend that you follow these procedures for backing up your 
company and payroll data:

1 Each day, back up onto floppy disks to keep in the office. If your 
computer has more than one hard drive, also backup to the drive 
other than the one where you keep your working data.

Tip. The first time you do a daily backup, we suggest that you make 
several sets of backup floppy disks and label the sets “Quicken Payroll 
Backup Monday,” “Quicken Payroll Backup Tuesday,” etc.

2 At least once a month, make a backup copy to keep off your premises. 
This way, if you have a fire, or a break-in and lose your computer and 
disks, you still have one copy of your company data off-site. 

Tip. For your monthly backups, you may want to alternate between 
two sets of disks. If disaster strikes your office, you'll want to have a 
reliable record of your data to fall back on. Also, if one of the disks 
become damaged or fail you'll have another one to fall back on.

3 At the end of your financial year, make an archive copy of your data to 
keep off your premises.
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4 If you have Internet access, you should consider off-site back-up 
through the Internet.  To find one that suits your needs, just type 
“offsite backup” into your favourite Internet search engine. 

Notes
 If you have a lot of employees or make changes often, you should 

ensure that your backup procedures have a much shorter, more 
regular backup cycle.  You could even backup after each session with 
Quicken Payroll.

 Always use good quality name brand floppy disks and format them 
before you use them to ensure that they don't have any bad sectors.

Restoring your company data
You may need to restore your payroll data from your backup files for any 
one of a number of reasons. For example you may want to restore your 
data if:

 Your working data is damaged;

 Your hard disk has malfunctioned;

 You need to put the data on another computer; or

 You want revert your data to the state it was in at an earlier date.

You must restore the backup data by using the Quicken Payroll Restore 
command. For detailed instructions on the Restore command, see Restore 
Files on page 159.

To resolve some simple problems such as those resulting from a result of a 
power failure or a hard drive that has bad sectors on it, you can try 
rebuilding your company file. See Utilities – Rebuild Data Files on page 177 
for details.

Warning.

Do not attempt to use the Quicken Payroll v12 Restore procedure
to restore a company backup file created in a previous version.
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What if I get an error message when restoring a backup?  
When you receive an error message such as Error Reading From Drive A:,  it 
is usually because the floppy disk itself has become damaged or corrupted.  
Other related messages are “Internal Error on line 1749 and Internal Error on 
line 1650, both of which mean that some loss of information has occurred.

In this situation you have three choices:

1 Restore your company file from another backup disk.

2 Rename one of the automatic backup files.

3 Send your backup disk to Intuit for data recovery.  This option requires 
that you obtain a job number from technical support and that they 
have verified that it is a data recovery issue.

If you are running Quicken Payroll from a network drive, you may find 
that you receive error messages because you do not have write access to 
the network drive—you are unable to save any information to the Quicken 
Payroll folder.  If this is the case, contact your Network Administrator to 
arrange full access rights to the Quicken Payroll folder.

Restoring from an automatic backup  
Every time you exit Quicken Payroll, an automatic backup of your 
company file is created.

The automatic backup can be useful if you haven't backed up your 
company file to a floppy disk (or other medium) and the current company 
file is corrupt.  

The backup files are created with the extensions 001, 002, 003, 004, 005, 006, 
007, 008 and 009, in the QPRollv12/Backup folder. 

To use a backup file, you must delete your corrupted company file, change 
the backup file name to the name of the deleted company file and then 
copy the file to the Quicken Payroll data folder.  Detailed instructions are 
as follows:

1 Exit Quicken Payroll if it is running.

2 Using the Windows Explorer, locate the Quicken Payroll Data folder. 
The default data folder is C:\Program Files\QPRollv12\Data.
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3 Locate your company file. The company file name is your company 
name, up to 76 letters, with an extension of .QPW.  

4 Rename your corrupted company file by highlighting the file, right-
mouse clicking and then selecting Rename.  For example, you might 
rename it DamagedFile.QPW. 

5 Change to the Quicken Payroll Backup folder. (C:\Program 
Files\QPRollv12\Backup)

The automatic backup files are listed.  Note that the file names are your 
company name, with a 3 digit extension.  For example, a backup file 
for the sample company would be named Quick Computing Solutions 
Pty Ltd.001 to Quick Computing Solutions Pty Ltd.009

6 Locate the latest backup file for the original company file name from 
Step 3. The latest version is the version with the latest date in the 
Modified column—in order to ensure that you are renaming the latest 
backup check the time and date to the right of the file name. It may not 
be the file with the highest extension number.

7 Rename the backup file to your company file name—the file name that 
you deleted in Step 3.  For example, to restore the sample file, you 
would rename the file named Quick Computing Solutions Pty Ltd.009 
to SampleCo.QPW.  To rename a file:

Click the file or folder you want to rename, but do not open it.

On the File menu, click Rename.

Type the new name and then click Enter.

8 Copy the QPW file to the Quicken Payroll Data folder.  This is the 
Quicken Payroll Data folder from Step 2. The default data folder is 
C:\Program Files\QPRollv12\Data.

9 Once this is done, restart Quicken Payroll.

In this example, clicking 
on the Modified column 
to sort by date shows that 
the .009 version is the 
latest version. 
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Recovering a corrupt company file  
If your company file is corrupted, you may be able to recover most of the 
data, but in many cases, you will not be able to recover 100% of your data.

Even if you are able to recover your file, you will still need to review your 
data in detail, because some employees and/or pays may have been 
deleted if they were corrupt.  These employees and/or pays will need to be 
re-entered once you are certain that there are no more problems with your 
company file.

If you don't adhere to an adequate backup schedule and your company file 
becomes corrupt, it may be possible to recover it, in some cases the 
company file may not be recoverable at all.

For these reasons it is crucial that you backup your company file after each 
session!

Rebuild Data Files Utilities (File Menu)
This command has been included to help you resolve some simple 
problems within Quicken Payroll, such as those resulting from power 
failures, or a general protection fault (GPF).

This utility may fix your data file, but it may also make it worse, so please 
ensure you have a working backup of the company before running this 
utility. For detailed instructions, see Utilities – Rebuild Data Files on page 
177.

If the rebuild utility does not fix your company file you should contact 
Technical support about the Data Recovery Service.
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Data recovery service
Quicken Payroll offers a data recovery service that you can use if your 
company file become corrupted and you have no other backups. However, 
we must stress that this should be used as a last resort only—you should 
always have reliable backup copies of your company files.

Before remitting your company file, you will need to contact technical 
support and verify that your problem is in fact a data corruption problem. 

How does data corruption occur?  
Some common causes of data corruption are:

 A power surge or power spike.  This causes your company data records 
to become scrambled as they are written to the hard drive.  

We strongly recommend that you use an uninterrupted power supply 
(UPS), or power conditioner, to prevent power problems.  An 
inexpensive powerboard with a surge protector can give you a false 
sense of security and is only marginally better than nothing. A UPS not 
only protects your power supply from surges and spikes, but also 
protects you from power outages by providing power for a period 
long enough to safely shut down your computer.

 A General Protection Fault (GPF) that makes you reset or turn the 
computer off without being able to shut it down correctly.

 Turning off the computer before you have exited or shut down 
Windows.

 Running MS-DOS programs (such as games) in the background under 
Windows.  This is because some MS-DOS based programs do “illegal” 
file operations and can cause Windows to become confused as to 
where it is placing the file.

 A damaged or corrupted hard drive. 

 Data and/or program files that has been damaged by a virus. You 
should always have an up-to-date anti-virus program.

 A hard drive compressed with compression software.
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Tracking changes to your company data
Quicken Payroll keeps a record of all changes made to transactions. You 
can review the changes in the Audit Trail report.

This report provides you with a list of changes made to the company data 
file, who they were made by and when they were made.  It has the 
following details:

The date the change was made.

The time the change was made.

The name of the user who made the change.  This will only appear if 
the user logged in using a password.

The name of the employee the change was made to.

Details of what was changed.

What if my Audit Trail report is blank?
If your audit trail is blank it is because the date range you specified does 
not include any changes.
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Safeguarding last year’s data
To ensure that you have the required records on hand should they ever be 
requested, at the end of the year you may want to complete the following 
tasks to safeguard your data for the year.

 Create two backups labelled with the year-end date. Keep one on your 
business premises and one copy off-site. 

 Archive your employment records in clearly labelled boxes and files 
and store them in a secure location.

Year end Procedures
Quicken Payroll does not require you to do anything at the end of the 
financial year.  It automatically resets the employee YTD figures when you 
process the first pay in the new financial year.

If you have a large number of employees you may wish to archive the 
previous financial years pays and terminated staff to another file.  This will 
ensure that Quicken Payroll will operate as fast as possible. For details, see 
Archive Data on page 162.

When archiving information out of your file, be sure to keep multiple 
backup copies.  You will need them if the ATO decides to audit you.
326 CHAPTER 8 - Protecting your data



C H A P T E R  9

Solving 
problems and 
getting product 
support

How can I  get 
answers to my 

Quicken Payroll  
questions?

Saving yourself a phone 
call  328

Using Quicken Payroll’s 
documentation  328

Exploring problems  330

Obtaining technical 
support  331

How to contact us  334

Accredited Trainers  334

Getting answers to your 
PAYG & tax questions 335

Accredited Trainers  334

Chapter Contents
 If you are having problems using a particular 
form, if the program is not acting as you 
expected, or you have received an error 
message, you have several options.
 Research all of the available documentation (see page 328).

 Try the procedure again (see page 330). 

 Talk to an expert Quicken Payroll Product Support 
representative who can walk you through the solution (see 
page 331).

 To resolve some simple problems such as those resulting from 
a result of a power failure or a general protection fault (GPF), 
you can try rebuilding your company file (see page 177).

 Restore your company file from a recent backup (see page 320) 
or contact us about our data recovery service if a recent 
backup doesn’t exist (see page 324).
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Saving yourself a phone call
The information you need may be right at your fingertips. To get an 
accurate, immediate answer to a Quicken Payroll question, try one or all of 
these self-help approaches first:

 Using Quicken Payroll’s documentation on page 328.

 Exploring problems on page 330.

Using Quicken Payroll’s documentation
We encourage you to search the extensive Quicken Payroll help system. 
There are several ways to access the information in the help system, as 
explained below.

Referring to this user guide
Check the table of contents or the index of this manual for the topic you 
need. 

Quicken Payroll Help
To get help about the window you’re working in, press F1. To search for a 
particular subject, choose Search for Help On from the Help menu enter the 
subject.

Choose How to use help from the help menu to open the Windows How to 
use windows help file.  This assist will guide you to make full use of Quicken 
Payroll Help.  Even if you have used help files before, this is worth 
reviewing for additional tips.

For additional details, see The Help Menu on page 310.
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Field help with Q-Cards
Q-Cards are a handy tool that appear as a small yellow window in the 
Toolbar and guides you in completing the currently displayed window. 

How Do I? menus
How Do I? is a great way to quickly find out how to do something in 
Quicken Payroll.  Instead of searching though the user guide or the 
Quicken Payroll Help, you can quickly bring up the most relevant help 
topic simply by clicking on a topic displayed in the How Do I? list.

Click on the How Do I? icon on the Navigator to open a list of topics related 
to the currently displayed Navigator tab.

Frequently asked questions (FAQ’s)
To save you time, we answer frequently asked questions, as well as a few 
not so frequently asked questions in the Quicken Payroll help, this user 
guide and on our website.

FAQ’s in Quicken Payroll Help
Quicken Payroll help includes an extensive list of questions and answers to 
help you use the program and process your payroll. To access the list:

1 Click F1 and then click on the Contents tab. 

2 Click on Common Questions and Answers

FAQ’s on our website 
Choose Quicken.com from the Online  Quicken Web sites menu, to 
access the Quicken Website. Click on Software and then select Frequently 
Asked Questions from the Support menu. To get there directly, you can enter 
http://www.quicken.com.au/support/faqs.aspx into your internet 
browser.
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Exploring problems
If you are having problems getting Quicken Payroll to work the way you 
expect, you may be able use troubleshooting techniques. The key to 
troubleshooting is to try the most basic approaches first. Work down the 
list as far as you need to.

Note We recommend that you back up your data on a new, formatted 
disk before you start. See Backup Files on page 158 for details.

1 The first step should be to review the documentation, including the 
user guide and Quicken Payroll Help to find out if there is a reason 
that a feature isn’t working. 

For example, to export payroll data to QuickBooks, you must select  the 
Enable Update QuickBooks Files and select a QuickBooks file from the 
Data File in Preferences. These preferences are disabled until you have 
installed and registered QuickBooks (v7 or later version).

2 Try the procedure again.

Start at the beginning. Examine screens and any windows where you 
filled in fields to be sure you are asking the program for what you 
want. 

For example, if a report does not include the information you want, 
be sure you have entered the correct starting and ending dates for 
data to include, used the filter settings you want, or added the 
specific information to the report by customising it.

If a feature described in the user guide is not available, make sure that 
the feature is enabled in Preferences (see page 165). 

3 Try a related procedure.

For example, if you have a printing problem, check that the printer is 
working by trying to print something else. If you have trouble 
printing pay slips, try printing a report. If you can’t print from 
Quicken Payroll, try printing from another program. If nothing 
prints, you know the problem is related to the printer, not the 
software. Check the printer connections.

4 If something used to work, think about what has changed.
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For example, if you customised a pay slip report and the changes no 
longer appear, you may have selected the default pay slip from Pay 
Slips Report menu, instead of the customised report from the 
Memorised Report menu.

Also, preferences control many aspects of how Quicken Payroll 
works. If Quicken Payroll behaviour has changed from what you are 
accustomed to, it could be because a setting in the Preference 
window has changed. (From the File Menu, choose Preferences and 
then click on the related icon. See page 165 for details.)

If you cannot solve your problem, contact technical support with the 
information on any error messages that may have occurred and when and 
where the error took place. 

Obtaining technical support 
As a Quicken Payroll user, you are entitled to 24-Hour support, available 
for free via the technical support page at the Quicen website. Any further 
questions you may have may incur a fee, on a per question basis. 

You can obtain support by phone at 1300 360 641, or 24 hours a day, 365 
days a year via our website at http://www.quicken.com.au You will need 
an ISP connection and modem to access our Internet service. 

Before you call technical support  
When you speak to a technical support representative, you will get an 
answer to your problem faster if you are ready with certain types of 
information:

 Have your registration and customer ID numbers. You can obtain these 
numbers by choosing About from the Help menu. 

 Be at your computer with Quicken Payroll running.
The support representative can help you best is you’re ready to step 
through the sequence that lead to the problem. For example, if you 
encountered a problem preparing a pay, try to remember the windows 
you opened, which windows you still have open and the tasks you did 
prior to preparing the pay.
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 Know exactly what you did before the problem occurred and the exact 
wording of any error messages appearing on the screen.

 Know your system. In some cases, the following information is relevant 
to your problem:

 - Computer brand, hard drive size, video card and amount of RAM.

 - Windows version. 

 - Printer type, manufacturer and driver being used.

 - Network configuration, if one is being used.

You can obtain information about your computer system from the 
System Information window.  This can be run by selecting About from 
the Help menu and then clicking System Information. 

How do I find out what version of 
Quicken Payroll I am using?
If you are not sure which version of Quicken Payroll you are running, 
choose About from the Help menu. The About window will display the 
version you are running. 

Obtaining support 24 hours a day
24-Hour support is available, for free, via the technical support page at the 
Quicen website. 

The address for the website is http://www.quicken.com.au   You will need 
an ISP connection, internet account and modem to access this service. 
Services available are:

 Access to a full email user service.  Any problems emailed to us will be 
subject to a support charge.

 Access to support problems, solutions and utilities.

 Product information, specials, updates and new releases.

 Access to the Quicen support database.  This allows you to solve any 
problem you may have at any time.

 Order upgrades.
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The Quicken Advantage Membership Program
The Quicken Advantage Membership Program has been designed to save 
you time and provide you with what you need to make running your 
business so much easier. It offers you the following:

 Unlimited technical support 

 Priority technical support telephone number 

 Priority technical support fax number 

 Extended technical support hours 8:30am - 8pm Mon to Fri EST. 

 Free product upgrades that may become available during the term of 
your membership 

 Quarterly Advantage Newsletter—only available via email 

 Regular information / FAQ's—only available via email 

 Members only website - PIN protected 

 Special Training Offer—Receive 10% off classroom training

How to join Quicken Advantage 
To join Quicken Advantage online, choose Quicken Websites > Quicken 
Advantage from the Online menu and follow the instructions on the web 
page. Your application will be processed and then your membership will 
be confirmed in writing.

To be eligible to join Quicken Advantage you must have the latest version 
of the software. If you don't have the latest version of the software you can 
purchase an upgrade direct from Quicken by telephoning 1300 655 925 or 
by faxing 02 9577 5557. Quicken products are also available from all leading 
software retailers.
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How to contact us 

Accredited Trainers 

Accredited Trainers are qualified accountants, bookkeepers and computer 
consultants who have a thorough knowledge of the use and capabilities of 
Quicken Payroll.  We ensure that all trainers complete an accreditation 
program to ensure that they can effectively train you in the use of the latest 
versions of our programs.

To locate an Accredited Trainer near you, go to our website by selecting 
Locate a Trainer in your area from the Help menu.

For information 
about . . . Contact At this number or location During these hours

Problems with 
Quicken Payroll

Technical Support Phone: 1300 360 641
Fax: 1300 360 642

Monday to Friday
9am to 5pm EST

Website: www.quicken.com.au 24 hours a day
365 days a year

Software Upgrades Pre-Sales Phone: 1300 784 253
Fax: 02 9577 5555

Monday to Friday
9am to 5pm EST

Registering Registrations Phone: 1300 650 061
Or go to the Quicken website:
www.quicken.com.au 

Monday to Friday
9am to 5pm EST

Business Address Postal Address:
Locked Bag 15
PO Broadway 
NSW 2007

Business Address:
2nd Floor, Building B
Citywest Office Park
35 Saunders Street
Pyrmont NSW 2009
02 9577 5000

Monday to Friday
9am to 5pm EST
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Getting answers to your PAYG and tax questions
PAYG and related payroll issues can be complex and confusing, especially 
keeping up with changes. To keep up with all the rules and regulations, 
make sure that you have the most recent guides from the ATO. You can 
obtain these guides by contacting the ATO. If you have internet access, a 
good place to start is at the ATOassist website http://www.ato.gov.au

You can contact the ATO for direct answers to your payroll questions, in 
particular questions related to the new tax system in any of the following 
ways: 

 using the ATOassist website, through the Quicken Payroll online menu, 
or at http://www.ato.gov.au.

 accessing State or territory and WorkCover websites through the 
Quicken Payroll online menu.

 phoning the ATO business inquiries line on 13 2866.

 phoning the ATO Fringe Benefits Tax (FBT) line on 13 3328.

 phoning the ATO Superannuation Help line on 13 1020. 

 obtaining A Fax From Tax on 13 28 60.

 writing to the Australian Tax Office at PO Box 9935 in your capital city. 

Most importantly of all, you should also consult with your solicitor, 
accountant or other professional tax adviser.
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Index
If you don’t find the topic you are looking for here, 
try Quicken Payroll’s Help. Choose Search for 
Help On from the Help menu, type the keyword, 
and then press Enter.

A
ABN, 182
ABN not quoted, 111
About window, 312
Accidental Termination, 273
Accredited Trainers, 334
Accrual Details, 207, 221
Accrue Hours, 207
ACN number, 180, 182
Activities menu, 267–287

Export to EFT, 283
Export to QuickBooks, 279
Export to Quicken, 282
Import Timesheet data, 274
Prepare Pays, 267
Terminate Employee, 268

Activity Statement Details, 293
Adding

 See also Creating
Look under what you want to add

Advance employee to next level, 223
Advanced Filter, 136
Advanced section (award), 224
Align, 150
Align Fields, 150
Allowances

Add to employee record, 198
Adding to a pay, 61
Allowances List, 229
Allowances Report, 293
Based on hours worked, 62
Employee record - allowance details, 198
In an award, 224
Pay details window, 61
Tax exempt allowances, 229

Allowances and Deductions, 81
Annual Leave, 171
Annual leave loading, 207
Annual salary, 194

APCA number, 183
ARBN number, 182
Archive, 162
ATO electronic tax payments, 97
ATO Supplier number, 175
Audit Trail Report, 294
Australian Business Number, 182
Australian Tax Office

ATO Approval Letter, 303
ATO EFT list, 234
ATO Supplier number, 175
EFT payments, 97

Automatic backup, 321
Awards, 219–228

Advanced section, 224
Award payment details, 222
Award set up, 10
Classification, 222
Payments Detail Tab, 39
Standard details, 39, 220
Timesheet payments tab, 39, 225

B
Back pay

Calculating tax on back pay, 65
Backup, 158–160

Automatic Backup, 321
Backing up your company file, 158
Backup preferences, 175
Data recovery service, 324
Error message when restoring backup, 321
How does data corruption occur?, 324
Recommended backup procedures, 319
Restore from backup, 159

Bank
Account number, 205
Add details to employee record, 204
Banking Reports, 294
BSB number, 205
Split, 205

Bank Codes List, 237
BAS, 293
Basic Filtering, 130
Bonuses,  See Commissions and bonuses
Branch Number, 105
Breaks

Add to an award, 227
BSB, 205
Bundy clock, 274
Business Activity Summary, 109
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C
Calculator Function, 6
Calendar Function, 6
Cash Breakup Report, 295
Casual, 223
Casual Loading Percentage, 223
CDEP Funding, 120
Changing column order, 149
Check boxes, 3
Child Support, 115
Class

Assign to pay rate, 195
Class List, 238
Class Reports, 295

Classification
Allowances, 224
assign to employee, 192
Classification rates, 222
Definition, 222
in an award, 222

Colour Scheme, 168
Column order, 149
Column width, 149
Commissions and bonuses

Adding to a pay, 68
Enable Commission and bonus preference, 166
Pay details window, 68
Preparing a pay with, 87
Tax calculations, 69

Common payroll situations, 81
Community Development Employment Projects, 120
Company

Setup new company, 36
ACN number, 182
APCA number, 183
ARBN number, 182
Banking details, 183
Companies list, 180–185
Company details, 180
Company Information window, 157
Deleting a company file, 184
Employee record - company details, 191
Group number, 182
Insurer details, 184
Name, 181
Phone and fax numbers, 182
Set up a new company, 9

Company Wizard, 36

Compensation
See also Workers Compensation and WorkCover
Compensation Report, 296
Insurer details, 208
Prepare a pay with compensation, 84
Tracking claims and payments, 208
WorkCover rates, 200

Configuration wizard, 37
Contractors, 191

ABN not quoted, 111
Voluntary Agreement, 110

Contractors Labour Hire firms, 111
Conventions Used, 3
Corrupt File, 323
Cost tracking, 240
Court order, 119
Create

a new award, 10
a new company file, 9, 36
a new employee record, 12, 40
a new super fund, 202
Look under what you want to create

Custom Fields, 212
Customer Job

Assign to pay rate, 195
Customer Job List, 240

Customer Jobs Report, 296

D
Data corruption, 324
Data recovery service, 324
Dates, 123

Date casual, 193
Date part-time, 193
Date permanent, 193
Employee start date, 193
Termination date, 193

Deductions
Add to employee record, 196
Adding to a pay, 60
Deductions List, 242
Deductions Report, 297
Employee record - deduction details, 196
Pay details window, 60
Reducing balance, 196

Default paper size, 172
Definition, 108
Delete Icon, 152
Deleting

 Look under what you want to Delete
338 Index



Deleting an Item, 152
Departments

Department list, 244
Departments list, 244
Employee record, 192

Double clicking, 3
Drop-down List, 3

E
Edit Report Toolbar, 128
Edit Report Window, 128
Edit This Pay checkbox, 248
Editing

Look under what you want to edit
Editing a past pay, 248
Editing past pays, 168
EFT  See Electronic Funds Transfer (EFT)
Electronic Funds Transfer (EFT), 97

ATO EFT list, 234
EFT Options (Preferences), 176
Enabling EFT feature, 166
Making ATO payments electronically, 97
Paying wages by EFT, 96

Eligible Termination Payments, 271
EMPDUPE

Create file for ATO, 303
Definition, 303
On disk or printed, 176
Preferences, 176

Employee Negative, 202
Employee number, 191
Employee Optional, 203
Employee S.G.C,  See Superannuation Guarantee 

Charge

Employees
Adding a new employee, 187
Allowance details, 198
Company details, 191
Compensation claims and payments, 208
Custom Fields, 212
Dates, 193
Deductions details, 196
Deleting an employee record, 187
Editing a record, 187
Employee number, 191
Employees List, 186–218
Employees Report, 305
Employment Status, 223
Extra Tax Contribution or Rebate, 201
Finding an employee on the list, 187
Fringe Benefits, 211
History, 212–218
Including Photo in Employee record, 190
Leave details, 206
Leave loading details, 207
Normal hours, 194
Notes, 210
Pay Rates, 194
Personal details, 189
Selecting employees to pay, 51
Sorting the employees list, 186
Superannuation details, 202
Tax Scale, 200
Taxation details, 200
TFN number, 200
WorkCover rate, 200
Workers compensation insurer details, 208
Year-to-date details, 212–218

Employees Report, 297
Employer Negative, 202
Employer optional, 202
Employers Reconciliation Statement

Print Statement, 302
Employment status, 223
End of Year Process, 288
End of year process, 15
ETP, 271
Ex Tax

Allowance, 199
Expense reimbursements, 65
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Export
to EFT, 283
To other software programs, 283
to QuickBooks, 279
To Quicken, 282

Exporting data to other software programs, 283
Extra Tax Contribution or Rebate

Employee record, 201
Rebates and Family Tax Assistance, 117

F
Family Tax Assistance, 117
FBT, 211
FBT Rate, 169
File menu, 156–179

Archive Data, 162
Back up Files, 158
Company information, 157
Open existing company, 156
Preferences, 165
Rebuild Data Files, 177
Restore Files, 159

Files
Backing up, 158–160
Preferences, 175
See also Backup

Filtering, 136
Font Properties, 140
Forgotten password, 262
Fringe Benefits

Add to employee record, 211
FBT Rate, 169

G
Garnishee, 119
Getting started, 8
Grossed-up FBT Amount, 211
GST

Reporting, 293
Tracking GST on reimbursements, 65

H
HECS, 117
Help Menu, 310
Higher Education Contribution Scheme, 117
History, 212–218

Add to employee record, 212
Horticulture Industry, 113

Hourly Rate, 194
Hours

Add to pay, 58
Adding to a pay, 58
Normal Hours, 249
Pay details window, 58

How do I?, 289
How to Use Help, 311

I
IIF file, 279
Import

MYOB PowerPay, 277
Timesheet Data, 274

Injury, 208
Installation, 19–23

Network, 20
Network troubleshooting, 22
Standard (single user) installation, 19
System requirements, 18
Uninstall, 23

Installing on a network, 20
Instalment Activity Statement, 293
Internet registration, 25
Internet Update, 309
Invoice with ABN, 66, 216
Invoice without ABN, 66, 216

J
Job costing,  See Customer Job, 240

L
Labour Hire, 201
Labour hire, 111
Last Injury, 208
Last Update, 259
Leave

Accrual details, 207
Add details to employee record, 206
Annual leave loading, 207
Leave preferences, 171
Leave Report, 298
Payment in advance, 85
Prepare pay with leave, 85
Special leave, 206
Start Accruing After, 206

Leave and Super Pay slips, 299
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Leave Loading
Applying to an award, 221
Employee percentage, 207

Link to QuickBooks, 167
Lists, 180–266

Allowances, 229
ATO Electronic Funds Transfer, 234
Awards, 219–228
Classes, 238
Customer Jobs, 240
Departments, 244
Employees List, 186–218
Pay Rates, 249
Payroll Tax Scales, 245
Pays List, 247
Reminders, 252
Sundries, 256
Super Funds, 254
Users List, 260
WorkCover Rates, 263
Workers Compensation, 264

Lump sum descriptions, 272

M
Make your payroll payments, 14
Meal breaks

Add to an award, 227
Memorised reports, 124, 292
Menus

Activities menu, 267–287
File menu, 156–179
Help menu, 310
Lists menu, 180–266
Online menu, 308
Reports menu, 290–307
Views, 313

Modifying, Look under what you want to modify
Multiple awards, 77
Multiple pay rates, 77
Multiple windows, 314
Multiplier, 246, 259
Multi-user, 20

Registering, 26
Multi-user licence, 26
MYOB PowerPay Import, 277

N
Navigator, 288

Display options, 313
Re-open, 313

Network
Set up Quicken Payroll on a network, 20
Setup Network Data Path, 161
Troubleshooting, 22

Next-of-kin details
Add to employee record, 209

Non-Residents, 113
Normal hours, 194
Normal Hours pay rate, 249
Normal Pay window, 55
Notes

Add to employee record, 210

O
Object Properties, 141
One window, 315
Online Menu, 308
Open Window List, 313
Option buttons, 3
Ordinary Time Earnings, 43
Orientation, 133
OTE, 43

P
Part-time, 223
Passwords, 318

Setting up a password, 260
Past Pays, 168
Pay As You Go, 108
Pay dates, 90, 92
Pay Employee Using, 189
Pay periods, 55
Pay Rates

Employee record - pay rates, 194
Normal Hours, 249
Pay Rates List, 249
Pay Rates Report, 298

Pay Slips
Number printed per page, 172
Printing Pay Slips, 299

PAYG, 108
PAYG Tax Report, 300
Reporting, 293

Payment deadlines, 93
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Payment Summary, 108
ETP Payment Summaries, 301
Labour Hire and Other Specified payments, 302
Payment Summary Deduction Report, 302
Payment Summary Explanation, 104
Payment Summary reports, 300
Plain paper or ATO stationery, 104
Printing, 102
Printing Preference, 173
Printing the reverse side, 104
Voluntary agreement, 301
Withholding where ABN not quoted, 302

Payments
ATO EFT payments, 97
by Electronic Funds Transfer (EFT), 96
Manual payment options, 94
Overview, 14
payment deadlines, 93
Payroll payments, 93

Payroll payments, See Payments
Payroll preparation, See Prepare payroll
Payroll Process

See also Prepare payroll
See also Processing your payroll

Payroll Tax, 169
Payroll Tax Report, 304
Payroll Tax Scales, 245
Pays

Create new pay, 49
Edit or delete a pay, 247
Edit Past Pays, 168
Edit This Pay checkbox, 248
Editing a past pay, 248
Pays List, 247
Pays Report, 305
Pays Summary window, 49

Pays Summary window, 49
Permanent status, 223
Permissions, 261
Personal details, 189
Phone Numbers, 334
Photo - adding to employee record, 190
Plain paper

EMPDUE Plain Paper Approval, 303
Payment Summary preference, 173

Position, 192

Preferences, 165–176
Export, 174
Files, 175
General, 166
Leave, 171
Printing, 171
Superannuation, 170
Tax, 169

Prepare payroll, 48–88
See also Processing your payroll
Overview, 13
Pay Details

Allowances, 61
Commissions and bonuses, 68
Deductions, 60
Hours, 58
Sundries, 65
Superannuation, 70

Payroll preparation, 48
Pays summary window, 49
Prepare a pay with

Allowances and Deductions, 81
Commission or Bonus, 87
Leave, 85
Workers Compensation Payment, 84

Prepare Pays menu command, 267
Selecting employees to pay, 51
The Pays Summary window, 49

Print Magnetic Media Information form, 303
Printing, 171
Printing Start Position, 133
Problems with Quicken Payroll, 334
Processing your payroll

See also Prepare payroll
Overview, 8, 14
Pay dates, 92
Process Pays window, 89

Q
Q-Calc, 6
Q-Cards, 5, 311
Q-Date, 6
QIF file, 282
Quick Zoom, 7
QuickBooks, 279

Employee list, 279
Export data to QuickBooks, 279
Intuit Interchange Format, 279
Payroll data transferred, 279
Preferences, 167, 175
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Quicken
Quicken export, 282
Quicken Interchange Format, 282

Quicken Advantage Program, 333
Q-Zoom, 7

R
Rebates, 117
Rebuild Data Files, 177
Recommended System Requirements, 18
Reconciliation Statement, 302
Reducing balance, 196
Registration, ??–27

As a single user, 24
By fax, 25
By Internet, 25
By phone, 25
For a multi-user environment, 26
Registration phone number, 334

Registration by Phone, 25
Reimbursements, 65
Reinstate employee, 273
Reminders List, 252
Report dates, 123
Report List, 291
Report Properties, 131
Report Wizard, 127
Report Writer, 121–154

Adding a
Box, 147
Calculated Field, 144
Custom Field, 144
Data field, 143
Image, 146
Line, 148
Report using the Report Wizard, 127

Text Item, 146
Adding and changing fields or graphics, 140
Align Fields window, 150
Changing column order, 149
Changing column width, 149
Changing fonts, 140
Customising the look and contents of reports, 128
Edit Report window, 128
Edit Toolbar, 128
Filtering a report, 136
Object Properties window, 141
Print and page options, 131
Report Filter window, 137
Report Properties window, 131
Report Wizard, 127
Resizing an item, 151
Sorting a report, 139
Totals and subtotals, 131

Reportable FBT Amount, 211
Reporting PAYG and GST, 293
Reports, 290–307

See also Report Writer
Activity Statement Details, 293
Allowances report, 293
Audit Trail Report, 294
Banking reports, 294
Class reports, 295
Compensation report, 296
Customer Jobs, 296
Deductions report, 297
Employees Report, 305
Leave report, 298
Memorised reports, 124, 292
Pay Rates report, 298
Pay Slips report, 299
PAYG Tax report, 300
Payment Summary, 300
Payment Summary report, 302
Payroll Tax report, 304
Pays report, 305
Reconciliation Statement, 302
Report Dates, 123, 290
Reports List, 123, 291
Sundries report, 305
Super report, 306
WorkCover report, 307

Reports Menu
Memorised Reports, 124, 292
Report List, 291

Reports to, 192
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Reset all messages, 311
Reset window positions, 311
Reset window size, 311
Resize report field, 151
Restore files, 159
Restoring from an Automatic backup, 321
Restoring from backup, 321
Returning to Company, 273
Right clicking, 3

S
Salary, 194

Add to award, 222
Add to employee record, 194
Add to pay, 58

Salary Sacrifice, 202
Screen appearance, 313
Selecting employees to pay, 51
Set up awards, 10
Setting up

Awards, 38
Employees, 12
Your company, 9

Setup Network Data Path, 161
SFSS Repayment, 118, 201
SGC,  See Superannuation Guarantee Charge
Sick Leave, 171
Single user registration, 24
Software Upgrades, 334
Sorting a Report, 139
Special leave, 206
Spouse Contribution, 202
Spreadsheet entry

Spreadsheet Entry window, 78
Standard Installation, 19
Student Financial Supplement Scheme, 118, 201
Sundries

Adding to a pay, 65
Enable Sundries preference, 166
Invoice with ABN, 66, 216
Pay details window, 65
Sundries List, 256
Sundries Report, 305

Super Funds, 254

Superannuation, 254
Add details to employee record, 202
Adding to a pay, 70
employees in Exception column, 306
Export file format, 287
Member Account Number, 203
Ordinary Time Earnings, 43
Pay details window, 70
Preferences, 170
Report new employees to fund, 45
Salary sacrifice, 202
Setting up superannuation, 41
Super Report, 306
Superannuation export, 285
Superannuation Guarantee Contribution, 202

Exempt employees, 203
Superannuation type, 202

Supplier Number, 105, 176
System Information window, 312
System requirements, 18

T
Tax Exempt Allowance, 229
Tax Exempt Deduction, 242
Tax File Number, 112, 200
Tax Scale, 200
Taxation details, 200
Tax-free leave loading threshold, 207
Technical Support, 331
Terminate Employee, 268
Terminate employee

Eligible Termination Payments (ETP), 271
Reinstate Employee, 273
Termination wizard, 268

Termination date, 193
Termination Wizard, 268
Textures, 168
TFN number, 112, 200
Threshold, 246, 259
Time clock, 274
Timesheet

Multiple pay rates, 77
Timesheet awards, 225
Timesheet Entry window, 71
Unpaid breaks, 227

U
Uninstall Quicken Payroll, 23
Uninstalling, 23
344 Index



Unpaid break, 227
Unpaid Leave, 171
Update

Tax Scales by disk, 309
Update Quicken Payroll by Internet, 309

Upgrade Wizard, 32
Use Award Pay Rates, 194
Users

Setting up, 318
Utilities, 177
Utilities - Rebuild Data Files, 177

V
View Menu

Multiple Windows, 314
One Window, 315
Open Window List, 313

Viewing an employee’s pays, 187
Voluntary Agreement, 110

W
Wages

Add to award, 222
Add to employee record, 194
Add to pay, 58

Web Sites, 308
Windows, 313

Wizards
Company Wizard, 36
Configuration Wizard, 37
Defined, 36
Employee Wizard, 40
Reinstate employee, 273
Report Wizard, 127
Terminate employee, 268
Upgrade Wizard, 32

WorkCover
Compensation report, 296
Employee rate, 200
Tracking claims and payments, 114
WorkCover rates, 114
WorkCover Rates list, 263
WorkCover Report, 307

Workers Compensation
Add details to employee record, 208
Compensation and claims list, 264
Compensation report, 296
Insurer details, 208
Prepare a pay with compensation, 84
Tracking claims and payments, 114

X
eXcellent team that brought you Quicken Payroll, 5

Y
Year-end tasks, 15
Year-to-date details, 212–218
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